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Announcement 

 

The description of the manual may not cover all contents of the instrument, and our company is 

subject to change and to improve the performance, function, inner structure, appearance, accessory 

and package of the instrument without notice. If there is puzzle caused by inconsistency of manual 

and instrument, then you can contact with our company by the address on the cover. 
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Chapter 1  Out of Box Audit 

When you receive the instrument, some inspections are necessary, and the condition must be 

understood and available before installing the instrument. 

1.1 To Inspect the package 

Inspect the shipping container for damage after unpacking it. It is not recommended to power on the 

instrument in the case of a damaged container. 

If the contents in the container do not conform to the packing list, notify us or your dealer. 

1.2 Power connection 

1) Power-supplying voltage range: 100~120Vac or 198~242Vac. Being related with the power 

setup on the rear panel. 

2) Power-supplying frequency range: 47~63Hz. 

3) Power-supplying power range: less than 80VA. 

4) Power supplying input phase line L, zero line N, ground lead E should be as same as the power 

plug of the instrument. 

5) After careful design, the instrument can reduce the clutter jamming caused by AC power 

terminal input, however, it should be used under the environment with low-noise. Please install 

power filter if being unavoidable. 

——————————————————————————————————————— 

Warning: In order to prevent user and instrument from being hurt by leakage, it is necessary 

for user to guarantee the ground line of supply power being reliably grounded. 

——————————————————————————————————————— 

1.3 Fuse 

The instrument has installed fuse, so operators should use the installed fuse of our company. 

——————————————————————————————————————— 

Warning: Be sure that the location of fuse is consistent with power-supplying voltage range 

before charging. 

——————————————————————————————————————— 

1.4 Environment 

1) Please do not operate the instrument in the place that is vibrative, dusty, under direct sunlight 
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or where there is corrosive air. 

2) The normal working temperature is 5℃～40℃, relative humidity ≤75%, so the instrument 

should be used under above condition to guarantee the accuracy. 

3) There is heat abstractor on the rear panel to avoid the inner temperature rising. In order to keep 

good airiness, please don’t obstruct the left and right airiness holes to make the instrument 

maintain the accuracy. 

4) Although the instrument has been specially designed for reducing the noise caused by ac power, 

a place with low noise is still recommended. If this cannot be arranged, please make sure to use 

power filter for the instrument. 

5) Please store the instrument in the place where temperature is between -20℃ and 60℃, 

humidity is less than 85%RH. If the instrument will not be put in use for a time, please have it 

properly packed with its original box or a similar box for storing. 

6) The instrument, especially the test cable should be far from strong electro-magnetic field, to 

avoid the jamming on measurement. 

1.5 Use of Test Fixture 

Please use the accessory test fixture or cable, the test fixture made by user or from other 

company may cause the incorrect measurement result. The test fixture or cable should be kept 

clean, as well as the pin of DUT, thus to guarantee the good connection between DUT and fixture. 

Connect the fixture or cable to four test terminals Hcur, Hpot, Lcur, Lpot on the front panel. As for 

the DUT with shielding shell, connect shielding layer or ground “┴”. 

Note: When test fixture or cable has not being installed, the instrument will display an unstable test 

result. 

1.6 Warm-up 

1) To guarantee the accurate measurement, the warm-up time is no less than 15min. 

2) Please not turn on or off instrument frequently, in order to avoid the inner data fluster. 

1.7 Other features 

1) Power: consumption power≤80VA. 

2) Dimension (W*H*D): 400mm*132mm*385mm 

3) Weight: About 13kg. 

1.8 Safe Usage 

Please use the power button to switch the device on and off. It is prohibited to unplug the power 

cord or disconnect the power supply before the device is completely turned off, otherwise it will 

damage the device hardware and affect the service life of the device. 

It is recommended not to install other software in the device, which may affect the working status of 
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the device. 

If you want to use this device to connect to the Internet, it is recommended to install your own 

antivirus software. 
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Chapter 2  Introduction 

In this chapter, the basic operation features of TH2851 will be described. 

2.1 Introduction to front panel 

 

Function buttons 

The keys used to implement the different functions contain the following parts: 

1. CHANNEL/TRACE：switch to curve sweep function and switch channels and curves 

Sweep: Switch the instrument interface to the sweep interface, and the button signal light is on. 

Channel Prev : When the instrument function is trace sweep, activate to the previous channel. When 

this key is pressed, the active channel will change from the current channel to the channel with the 

channel number smaller than the current one. Only when the channel is activated, its parameters can 

be modified. Therefore, use this key to activate the channel before changing the channel setting. 

Channel Next : When the instrument function is trace sweep, activate to the next channel. When this 

key is pressed, the active channel changes from the current channel to the channel with a larger 

channel number than the current one. 

Trace Prev : When the instrument function is trace sweep, activate to the previous trace. When this 

key is pressed, the active trace will change from the current trace to a trace whose trace number is 

smaller than the current one. Only when the trace is activated, its parameters can be modified. 

Therefore, use this key to activate the trace before changing the trace settings. 

Trace Next : When the instrument function is trace sweep, activate to the next trace. When this key 

is pressed, the active trace changes from the current trace to the trace with a larger trace number 

than the current one. 

Channel Max:When the instrument function is trace sweep, the display window of the selected 
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channel will be switched between maximum display and normal display. When set to normal display, 

all set channels (whether activated or not) are displayed separately on the screen; when set to 

maximize display, the display window of the active channel occupies the entire display area, and the 

inactive channel is no longer displayed, the measurement of the inactive channel will still be 

performed. 

Trace Max: When the instrument function is trace sweep, the display state of the active trace is 

switched between maximum display and normal display. When set to normal display, the traces with 

settings (whether activated or not) will be displayed in the channel display window; when set to 

maximum display, only the activated traces will be displayed in the channel window, and other 

districts and counties will no longer be displayed. Measurements that do not display a trace will still 

be performed. 

2. STIMULUS : parameter setting of the trace stimulus source 

Sweep Setup: When the instrument function is trace sweep, open the sweep setup menu in the menu 

bar, you can set the signal source parameters, sweep time, number of trace points, etc. 

Sweep Type: When the instrument function is trace sweep, open the sweep mode setting menu in 

the menu bar to change the sweep mode of the current channel. 

Start: When the instrument function is trace sweep, open the sweep range menu in the menu bar, 

and place the cursor in the sweep start value input area to set the start value of the sweep range. 

Stop: When the instrument function is trace sweep, open the sweep range menu in the menu bar, and 

place the cursor in the sweep end value input area to set the end value of the sweep range. 

Center: When the instrument function is trace sweep, open the sweep range menu in the menu bar, 

and place the cursor in the sweep center value input area to set the center value of the sweep range. 

Span: When the instrument function is trace sweep, open the sweep range menu in the menu bar, 

and place the cursor in the span input area to set the sweep range. 

3. MKR/ANALYSIS : Marker and Trace Analysis 

Marker: When the function of the instrument is trace sweep, open the marker setting menu in the 

menu bar, you can set the marker such as the switch of the marker and the position of the marker 

can be changed by inputting the value of the stimulus value. You can place 10 markers on each 

curve. 

Marker Search: When the instrument function is trace sweep, open the marker search menu in the 

menu bar, and the operation menu can move the marker to a specific point on the trace (maximum 

point, minimum value point, extreme value point and specific test value point) . 

Marker Function: Open the marker function menu in the menu bar, and the operation menu can set 

the sweep range, switch statistical data display, etc. according to the marker position. 

Analysis: When the function of the instrument is trace sweep, open the trace analysis menu in the 

menu bar and the operation menu can perform the sorting settings in the scanning, as well as the 

analysis and simulation of the equivalent circuit. 

4. RESPONSE : used to set the response for the instrument measurement data 
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Meas: When the instrument function is trace sweep, open the measurement setting menu in the 

menu bar, and the operation menu can set the measurement parameters of each trace, and switch the 

display of offset monitoring. 

Format: When the instrument function is trace sweep, open the ordinate format menu in the menu 

bar, and the operation menu can change the ordinate type of each trace. 

Scale: When the instrument function is trace sweep, open the coordinate axis setting menu in the 

menu bar, and the operation menu can set the vertical coordinate distribution and scaling (including 

reference position, coordinate division, etc.) of each trace. 

Display: When the instrument function is trace sweep, open the display setting menu in the menu 

bar, you can specify the display mode of channels and traces, set the number of traces, set the value 

memory, etc. 

Avg: When the function of the instrument is trace sweep, open the measurement speed menu in the 

menu bar, and you can set the trace sweep speed, the number of sliding averages, and the switch. 

Cal: When the instrument function is trace sweep, open the user calibration interface in the menu 

bar, and user calibration can be performed. 

5. LCR METER : switch the instrument function to the bridge function, and the corresponding 

function keys 

LCR: Switch the instrument interface to the point measurement interface, and the button signal light 

is on. 

Meas: When the instrument function is point measurement, open the measurement setting menu in 

the menu bar, and you can modify the measurement frequency, range, trigger mode, signal source 

and other parameters. 

Display: When the instrument function is point measurement or list sweep, open the measurement 

parameter setting menu in the menu bar, and you can set all the current measurement parameters. 

Point/ List : Switch between point measurement interface and list sweep interface on the screen. 

Cal : switch to the user calibration interface, user calibration can be performed. 

DC Bias : The switch that loads the bias voltage, and the signal light will be on and off according to 

the switch state. 

6. ENTYR : Keys related to data entry 

0 , 1 , 2 …. 9 : Numeric keys, used to input corresponding numbers. 

+ / - : Modify the sign of the input value. 

T / p , G/n , M / μ , k / m , x1 : Order of magnitude keys, used to input the corresponding order of 

magnitude unit. When the order of magnitude key is pressed, one of the two order-of-magnitude 

units in the key name is automatically selected according to the entered parameter. The x1 key does 

not enter any units. 

Esc: Cancel, which is used to cancel operations in time-consuming operations such as calibration, 
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and to cancel the input and restore the previous value during numerical input. 

B S ← : Backspace key, used to backspace while typing. 

Help: Call out the help document, which can be used to unlock the screen and front panel when they 

are locked. 

7. INSTR STATE : the setting button of the instrument state function 

Save/Recall: Open the save and load menu in the menu bar (bridge and sweep are different menus), 

you can save and load measurement parameter settings and measurement results. 

System : Open the system settings menu in the menu bar, you can perform various system settings. 

Preset : After the key is pressed and confirmed, the instrument will return to the initial state. 

8. TRIGGER : Trigger related settings of the instrument 

Trigger Mode : Open the trigger setting menu and set the trigger mode. 

Hold : Set the current measurement mode to hold state. 

Trigger : Make a trigger. 

9. JUDGEMENT : Display of sorting results, non-operation keys 

Pass : When the sorting is passed, the signal light is on. 

Fail : When the sorting fails, the signal light is on. 

10. Direction keys and dial: used to move the input cursor and adjust the input value. 

Scroll wheel: When inputting numerical value, increase or decrease the input numerical value with a 

smaller division value. 

Up and down keys: When entering numerical values, increase or decrease the entered numerical 

value with a larger division value. 

Left and right keys: Move the input cursor left and right when entering numerical values. 

Switch button 

This button is used to switch the instrument on and off. The button light illuminates when the 

instrument is turned on. 

Touch screen 

TH2851 is equipped with a 10.1 -inch touch screen for displaying numerical values, traces, division 

values, setting values, keys, and other measurement-related information. You can operate the keys 

on the screen by clicking with your finger. To learn more about touch screens, see the "Display 

Areas" section. 

Warning: Do not use sharp objects (such as toothpicks, pen tips, screwdrivers, etc.) to press on 

the touch screen surface. Pressing the screen with a sharp object may damage the screen or 

cause dead spots on the screen.  
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Note: The ratio of effective dots on the touch screen should be greater than 99.998 %, and the 

dead dots less than 0.002 % are not considered screen damage.  

Test end 

The four-terminal test terminal is used to connect the four-terminal test fixture or test cable to 

measure the DUT. 

Current excitation high side ( Hcur ); 

Voltage sampling high-end ( Hpot ); 

Voltage sampling low end ( Lpot ); 

Current excitation low side ( Lcur ). 

USB interface 

USB interface can be used to connect USB devices, such as mouse, keyboard, storage device, etc. 

2.2 Introduction to rear panel 

Figure 2-2 shows the rear panel of TH2851. 

 

Figure 2-2 Rear panel 

1. Serial label: Indicate the production date, manufacturer, instrument number and other 

information; 

2. Handler interface: Handler signal input and output; 

3. U SB Device interface: U SB communication interface to realize communication with 

other devices; 

4. Ground terminal: connected to the chassis, used to protect or shield the ground connection; 
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5. RS232 serial interface: serial communication interface, realize communication with other 

equipment; 

6. Power socket: used to supply AC power to the device; 

7. Fuse holder: used to install fuse, protect the instrument, can switch 1 10V/220V ; 

8. G PIB interface: G PIB interface realizes communication with other devices; 

9. Main board interface: The general interface of the computer main board, including USB 

port, video output port (the screen can be put on other video output devices), audio input 

and output port, LAN port (network interface, realize the communication and control of 

network system ). 

2.3 Screen Area 

2.3.1 Screen interface display 

TH2851 includes a variety of measurement interface displays and setting interface displays. The 

main function interfaces are shown in the following table: 

Display type Function 

Measurement 

interface 

Point measurement 

interface 

The parameters of the measured point 

and the measurement results are 

displayed in the interface 

List measurement 

interface 

All measurement points and their 

measurement results are displayed in 

a table on the interface 

Sweep measurement 

interface 

The curve drawn by the measurement 

points and their measurement results 

is displayed in the coordinate axes of 

the interface 

Set interface 

User Calibration 

Interface 

All user calibration point settings and 

calibration values are displayed in a 

table in the interface 

Accessory 

Calibration Interface 

Step prompts for user fixture 

calibration are displayed in the 

interface 

Point comparator 

setting interface 

In the interface, the setting value of 

point measurement and comparator is 

displayed 

List setting interface 

All the points to be measured and 

their setting parameters are displayed 

in the table of the interface, and all 

points are arranged in order in the 
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table. 

List quick edit 

interface 

Quick setup of measuring points for 

list sweep 

List comparator 

setting interface 

The setting value of list sweep 

comparator is displayed in the 

interface 

Sweep comparator 

setting interface 

The trace sweep comparator 

parameter settings are displayed in 

the table of the interface 

Sweep segment 

setting interface 

The settings of the trace sweep 

segment are displayed in the table of 

the interface 

2.3.2 Point measurement display interface 

Press the LCR button on the front panel, the point measurement interface will be displayed on the 

screen, as shown in the figure below: 

 

Channel number 

The highlighted channel is the currently active channel. There can be 8 channels in the point 

measurement mode at the same time, and each channel can set different measurement conditions 

(frequency, level, bias, etc.) and measurement parameters. Channels can be switched by clicking the 

channel number button. 

Measurement conditions 

The measurement conditions of the current channel are displayed in the area, including 

measurement frequency, measurement time, OSC level, AC range, DC bias, and average count. 

These variables can be changed in the Measurement Setup menu. Clicking a control in this area, the 

menu area will open the "Measurement Settings" menu and automatically navigate to the clicked 
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variable. 

AC and DC monitor 

It displays the currently measured AC/DC current and voltage monitoring values. The monitor mode 

can be changed in the "Measurement Settings" menu; click on this area, the menu area will open the 

"Measurement Settings" menu. 

Menu name 

It displays the name of the current menu, displayed at the top of the menu. 

Menu 

It displays the currently opened menu. The menu contains different types of buttons: normal buttons, 

editable content buttons, selection buttons, etc. An arrow on the right side of the button means that 

pressing the button will open a sub-menu; a black square on the left side of the button means the 

button is currently selected. 

Time display 

It displays the current system date and time. 

Device status 

Various current measurement states are displayed. As shown in the table below: 

Display Definition 

Open (shown in blue) User open calibration is turned on 

Short (shown in blue) User short calibration is turned on 

Load (shown in blue) User load calibration is turned on 

Phase (shown in blue) User phase calibration is turned on 

Bias (shown in red) Bias voltage is turned on 

Lock (shown in red) Front panel and screen operations are 

locked 

Pass (shown in green) Comparator is passed 

Fail (shown in red) Comparator is failed 

Acce (shown in blue) User accessory calibration is turned on 

Meas (shown in blue) The current trigger mode is internal trigger 

(continuous measurement) 

Manual (shown in 

blue) 

The current trigger mode is manual trigger 

External (shown in 

blue) 

The current trigger mode is external 

trigger 

Bus (shown in blue) The current trigger mode is bus trigger 

Measurement parameters and results 

It displays the current measurement parameters and measurement results. TH2851 supports 

simultaneous display of up to 4 measurement parameters. Click this area to modify measurement 

parameters and display settings for measurement results (such as reference values, math operations, 

significant digits, etc.). 
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2.3.3 List measurement display interface 

The list measurement display interface is shown in the following figure: 

 

Channel number 

The highlighted channel is the currently active channel. There can be 8 channels in the list mode at 

the same time, and each channel can set different environmental variables (frequency, level, bias, 

etc.) and measurement parameters. Channels can be switched by clicking the channel number 

button. 

Measured point serial number 

The serial number of the measured point is displayed, which can be modified in the list setting page. 

Measurement conditions 

It displays the measurement conditions of the measured point, including: measurement frequency, 

average count, OSC level, AC range, and DC bias. These parameters can be modified in the list 

settings page. 

Measurement parameters and measurement results 

The current measurement parameters and measurement results of the measured point are displayed 

in sequence. The parameters to be measured can be changed in the measurement parameters menu. 

2.3.4 Sweep measurement display interface 

Press the Sweep button, and the sweep measurement interface will be displayed on the screen. The 

main part of the interface is the channel window, as shown in the following figure: 
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Moving average state 

This status is only displayed when moving average is turned on. The display format is n/m, where m 

is the set number of moving averages, and n is the moving average count. The moving average 

switch and counts can be changed in the measurement speed menu. 

Channel number 

The serial number of the channel displayed in the current window. The active window can be 

switched by pressing Channel Prev and Channel Next buttons, and you can switch to the channel 

directly by clicking the channel window. 

DC monitor  

When the DC monitor is turned on, the current measured DC level and the current monitor value are 

displayed. 

Equivalent circuit simulation results 

The selected equivalent circuit model and simulated resistance, capacitance, and inductance values 

are shown. This graph is displayed on the channel window when the equivalent circuit result display 

is turned on. 

Ordinate label 

The tick distribution of the ordinate axis of the coordinate system is displayed. When the measured 

trace exists in the coordinate system, this area will display the set ordinate scale label of the 

currently active trace. The ordinate reference value (highlighted) can be changed in the Axis 

Settings menu. At the same time, you can also set the ordinate value of the selected marker as the 

reference value in the marker function menu. The ordinate scale distribution, ordinate reference 

value, etc. can also be manually changed or automatically set in the axis setting menu. 

Marker 

The marker is used to read measurements on the trace. Up to 10 markers can be displayed on a trace. 

The shape of marker 1 in the figure represents the activated marker, and the shape of marker 2 is the 

inactive marker. The active marker can be toggled through the marker settings menu or by clicking 

on the marker value field. At the same time, you can also modify the position of the marker in the 
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marker setting menu, and drag the screen with your finger in the coordinate system to directly drag 

the position of the activated marker. 

Marker value 

It displays the abscissa values of all current markers and the degrees of measurement values on each 

trace. The ">" symbol before the marker serial number indicates that the marker is the currently 

activated cursor. Clicking on this area will switch the active marker to the next marker. 

Marker Statistics Parameters 

It displays statistics (range, average, standard deviation, peak-to-peak) for all points of the current 

trace between marker 1 and marker 2. The display can be turned on or off in the marker function 

menu. When the display is turned on, if marker 1 and marker 2 are not turned on, marker 1 and 

marker 2 are automatically turned on. 

Measurement parameters 

It displays the measurement parameters of the current trace. Measurement parameters can be 

changed in the measurement setup menu. 

Signal source voltage/DC bias/non-sweep frequency 

The signal source voltage, DC bias and frequency of the sweep are displayed, which will be 

displayed differently in different sweep modes, as shown in the following table: 

Sweep mode Display type 

Sweep frequency Signal source voltage and bias voltage (bias 

voltage on) 

Sweep signal source 

level 

Non-sweep frequency and bias voltage (bias 

voltage on) 

Sweep bias voltage Non-sweep frequency and signal source 

voltage 

Ordinate scaling value 

It displays the current ordinate scaling value of each trace. When the vertical axis of the trace is the 

linear axis, the display format is "Scale/Reference"; when the vertical axis of the trace is the 

logarithmic axis, the display format is "Top/ Bottom "; 

Span 

It displays the sweep range of the current channel. 

Trace number 

It indicates the trace name and trace number (eg Tr1) in the current channel. The trace name is 

consistent with the color of the trace itself. The triangle symbol before the name indicates that the 

trace is the active trace, and the settings in the current channel coordinate system are based on the 

active trace. The activated traces can be switched via the Trace Next and Trace Prev buttons on the 

front panel, or by clicking on the trace number area in the screen. 

Trace state 

The possible states for each trace are shown in the following table: 
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Classification Status (enclosed in [ ] ) Meaning 

When the trace math operation is 

set to OFF , it will be 

distinguished according to the 

different display states of the trace 

and the stored trace. 

no state Trace display is on, the stored trace display 

is off 

M Trace display is off, the stored trace display 

is on 

D &M Trace display on, the stored trace display on 

off Trace display is off, the stored trace display 

is off 

When the trace display is on and 

the math operation of the trace is 

not OFF,  it is distinguished 

according to the math operation of 

the trace. When the stored trace 

display is on, it is the state inside 

( ) 

D +M ( D+M&M ) Math operations: Calculate data + store data 

D- M ( D - M&M ) Math operations: Calculate Data - store data 

D* M ( D * M&M ) Math operations: Calculate data * store data 

D/ M ( D/M&M ) Math operations: Calculate data / store data 

2.3.5 User Calibration Interface 

The user calibration page displays the calibration settings made by the user, and the user can 

perform specific calibration operations and view calibration data. The specific interface is shown in 

the following figure: 

 

Calibration point list 

It displays the status of all user calibration points and the calibration data that has been performed. 

TH2851 provides a total of 20 user calibration points; each point has an independent switch and 

frequency settings. At the same time, the list also displays the load reference value, open circuit 

calibration value, short circuit calibration value and load calibration value of the calibration point. 

Click the row of the calibration point to open the corresponding calibration point setting menu. 

Calibration point setup 

The selected calibration point can be set. Settings include switching, measurement frequency, and 
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load reference. Among them, if the calibration point is turned off, then in the measurement, the 

calibration point will not work. The load reference parameter will depend on the load type setting. 

Point calibration 

Point calibration can be performed on the currently selected calibration point, including open clear, 

short cleari, and load calibration. These calibration data will only be used in the measurement if the 

calibration point is turned on. 

2.3.6 Accessory Calibration Interface 

The main function is to guide the user to perform accessory calibration, as shown in the following 

figure: 

 

Calibration steps 

The overall progress of the calibration is displayed. Unfinished steps are light gray, completed steps 

are dark gray, and currently active steps are light yellow. You can navigate to a completed step by 

pressing the button in the menu bar or click the step label, and re-calibrate the step (except for some 

special steps). 

Calibration Guide 

Operational guidance for the current calibration step. Follow the instructions to complete the fixture 

calibration. 

2.3.7 Point measurement and comparatpor setting interface 

The point measurement and comparator interface shows the conditions for point measurement and 

comparator, as shown in the following figure: 
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Set serial number 

The comparator page also has 8 setting pages, and 8 different comparator settings can be performed 

at the same time. The comparator setting page corresponds to the channel of the point test, that is, 

the comparator setting with serial number 1 will be applied to the channel 1 of the point test, and so 

on. 

Good BIN Setup 

It is used to set good BINs and bad BINs. As shown in the figure, it is set to ~ BIN3, that is, 

BIN1-BIN3 are good BINs, and B IN4-BIN10 are bad BINs. 

Channel state 

Comparator state (channel switch, etc.) can be set and displayed. When the BIN is OFF, it is 

considered that the BIN does not exist during sorting. There are a total of 10 sorting BINs, good 

BINs are displayed in green, and bad BINs are displayed in red. 

Comparator setup 

It is used to set compataror state. There are 4 compataror states for comparator at the same time, and 

each state has independent switches, comparator parameters, operation types, reference values, etc. 

When the compataror state is turned off, the corresponding state settings and comparator conditions 

cannot be set. In the compataror table menu, there will be more serial number settings for the points 

to be sorted. 

Comparator conditions 

Comparator settings for each BIN can be made. The BIN comparator conditions correspond to 4 

comparator settings, and the comparator qualified interval, upper limit and lower limit can be set. If 

the test value is within the qualified range, the sorting is passed, otherwise it is failed. 
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2.3.8 List setting interface 

 

Desktop tab 

Switch to the current setting page. You can switch to the stimulus setting interface and the 

comparator setting interface. 

Points to be measured 

It displays all the points to be measured and their measurement parameters in the current channel. 

Click the row of the point to be measured (except the first column), the menu bar will open the 

setting menu corresponding to the point to be measured, and click the first column to return to the 

root menu. 

Point parameter setting 

The measurement parameters of the current point can be changed. 

2.3.9 List quick edit interface 

The list quick edit page can quickly set the measurement points. 



 19 

 

Quick settings area 

Quickly set measurement point parameters. 

Setup is complete 

Confirm the setting of the stimulus measurement point, save the set data, exit the current interface 

and return to the stimulus setting interface. 

2.3.10 List comparator setting interface 

Please refer to the point measurement comparator setting interface. 

2.3.11 Sweep comparator setting interface 

Comparator condition settings for sweep test. Before entering this page, first of all, it is necessary to 

save the current trace to the storage data as the reference data for comparator. The sweep comparator 

setting page is shown as below: 
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Ccomparator condition list 

The comparator conditions that have been set are displayed. Different comparator conditions are 

sorted according to frequency, and the frequency range does not exceed the sweep frequency range. 

Click the frequency criteria (except the first column) to open the comparator settings menu; click 

the first column to return to the root menu. 

Comparator condition setting 

Set the selected comparator conditions. You can set the comparator type; begin stimulus and end 

stimulus, upper limit and lower limit. Among them, the setting of the comparator upper and lower 

limits is related to the selected comparator type. When the comparator type is numeric, to set the 

numerical value; when the sorting type is percentage, to set the percentage. 

2.3.12 Sweep segment setting interface 

This screen shows the settings for the sweep frequency segment. This setting only takes effect when 

the sweep mode is set to segmented sweep. The sweep segment interface is shown in the following 

figure: 
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Segment table 

All segmentation settings are displayed. All segments are sorted by frequency, and the start 

frequency of the next segment is not lower than the end frequency of the previous segment, and not 

higher than the end frequency of the same segment. Except for frequency and number of points, the 

display of other parameters needs to turn on the corresponding switches in the root menu. Click the 

segment condition (except the first column) to open the corresponding segment setting menu; click 

the first column to return to the root menu. 

Segment setting 

The selected segment can be set, including frequency (the format includes start/stop and 

central/span, which can be switched in the root menu), number of points, level, bias, etc. Among 

them, except the frequency and the number of points, other parameters can only be set by turning on 

the corresponding switch in the root menu. 

Points 

It shows the point statistics for the current segment setting. The total number of points must not be 

less than 2, and at least one point is required under each segment setting. 

Measurement example 

This section will guide you through a measurement example to understand the basic operation of the 

TH2851. If you are a new user of TH2851, this part can help you get familiar with TH2851 quickly. 

2.4 Measurement examples 

This section will guide you through the basic operation of the TH2851 with a single measurement 

example. If you are new to the TH2851, this section will help you to quickly become familiar with 

TH2851. 
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2.4.1 Equipment requirements 

In order to be able to complete all the steps of this example, you need to prepare the following 

measurement equipment. 

TH2851; 

TH26005C fixture; 

100 ohm resistor; 

Standard open and short test pieces 

Crystal resonators. 

2.4.2 Measurement preparation 

Complete the preparation of the TH2851 for measurement by following the steps below. This 

ensures that the TH2851 is properly installed and set up. 

2.4.2.1 Connection fixture TH26005C 

Connect the fixture TH26005C to the TH2851: 

1. Align the 4 test ends of the TH26005C with the test ends on the TH2851, and gently insert the 

fixture until the two test ends are fully fitted; 

2. Turn the rotating operating lever on the test end of the TH26005C fixture clockwise to ensure the 

stability of the fixture during measurement; 

3. When removing the clamp, perform the above steps in reverse order. 

2.4.2.2 Turn on the power 

TH2851 can be activated by pressing the switch button. After startup, the program of TH2851 will 

start automatically, and check whether various files are completed during startup. After everything is 

ready, the device first enters the point measurement interface. 

Note: please do not shut down the program by directly cutting off the power supply, which may 

cause irreversible damage to the electronic components of the TH2851. 

2.4.2.3 Initialize the instrument 

Preset initialization restores the device to the factory settings, which can reset the previous 

measurement conditions and parameter settings to avoid the subsequent measurement being affected 

by the previous measurement. The initialization function can be set to restore to factory settings or 

user settings (user setting files are required), and the system defaults to factory settings. This setting 
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can be changed in the system settings.  

Press Preset on the front panel and click OK on the screen to restore the device to factory settings. 

2.4.3 User measurement calibration 

Perform user calibration before measurement. On the point measurement page, click Cal in the 

upper right corner of the front panel to enter the user calibration page. 

 

2.4.3.1 User full frequency open clear 

1. Click Open on the user calibration menu to enter the open calibration menu; 

2. Install the standard open measuring piece on the TH26005C fixture, and click All frequency clear; 

3. After the full frequency clear is completed, the data will be saved and the user open calibration 

will be turned on. Click Return toreturn to the user calibration menu. 

2.4.3.2 User full frequency short clear 

1. Click Short on the user calibration menu to enter the short calibration menu; 

2. Install the standard short measuring piece on the TH26005C fixture, and click to All frequency 

clear; 

3. After the full frequency clear is completed, the data will be saved, and the user short calibration 

will be turned on. Click Return toreturn to the user calibration menu. 
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2.4.3.3 User Phase Calibration 

1. Click Phase Cal on the user calibration menu to enter the Phase Calibration menu; 

2.Install the standard open measuring piece on the TH26005C fixture, click Start Phase Cal; 

3.After the calibration is completed, the user phase calibration will be turned on. Click Return to 

return to the user calibration menu. 

2.4.3.4 User Accessory Calibration 

1.Click Accessory Cal on the user calibration menu to enter the accessory calibration menu; 

2.Click the button to select the file location to be saved after calibration. If there is a fixture 

calibration file in the selected location, the file will be overwritten after the calibration is completed 

(if there is an * in the name of the file location button, it means an existing calibration file); 

3.Click Start Accessory Cal to enter the accessory calibration page, and complete the calibration 

process according to the guidance on the page; 

4.After calibration is complete, user accessory calibration will be turned on. Click Return to return 

to the user calibration menu. 

Note : Because the accessory calibration includes open-short clear and phase calibration, when the 

user accessory calibration is turned on, the user's open calibration, short calibration, and phase 

calibration will be automatically closed; correspondingly, the user's open calibration, short 

calibration or phase calibration is turned on, the user accessory calibration will be turned off. 

2.4.4 Point measurement example 

This part demonstrates the point measurement function of TH2851, connect the 100Ω resistor to the 

accessory, and press LCR on the front panel to enter the point measurement page. 
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2.4.4.1 Set measurement conditions (frequency/average count/signal source voltage, etc.) 

According to user needs, set different measurement conditions, follow the steps below: 

1. Press Meas in the upper right corner of the front panel to enter the measurement setting menu; 

2. Select Frequency in the measurement setting menu, and press 1 > M /μ on the front panel to set 

the measurement frequency to 1 MHz ; 

3. Select Avg Count in the measurement setting menu, and press 5 on the front panel to set the 

measurement average count to 5; 

4. Select OSC Level in the measurement setting menu, enter the measurement level menu, set the 

test voltage, and then press return; 

5. Press DC Bias on the front panel to turn on the bias voltage switch; 

6. Press LCR on the front panel to return to the point measurement menu. 

2.4.4.2 Set measurement parameters 

Set the measurement parameters required by the user and display them on the measurement 

interface. Follow these steps: 

1.Click the parameter name on the screen to enter the test parameter setting interface; 

2.Select and press the parameters to be displayed on the measurement interface; 

3.Press LCR on the front panel to return to the point measurement menu . 

2.4.5 List measurement example 

This section demonstrates the list measurement function of the TH2851. On the point measurement 

page, press Point / List on the front panel to enter the list measurement interface. 

2.4.5.1 List Measurement point setting 

Set the points to be measured. Follow these steps: 



 26 

 

1. Click Stim Table on the List Root on the screen to enter the stimulus setting interface; 

2. Click Quick Edit on the stimulus setting menu on the screen to open the quick edit 

interface; 

3. Set the interpolation mode to linear interpolation, the start frequency to 100 kHz, the stop 

frequency to 1 MHz, and the number of points to 10, click OK to quickly set 10 

measurement points; 

4. Click the row of each measurement point on the screen to enter the measurement point 

setting menu, you can set the measurement conditions of each point individually, and click 

Return to return to the measurement setting menu; 

5. Click Exit to return to the list measurement interface. 

2.4.5.2 Set measurement parameters 

Set the list measurement parameters and display them in the measurement page. Follow these steps: 

1. Click Point Meas on List Root on the screen to enter the measurement parameter menu; 

2. Click the parameter button that needs to be changed to enter the parameter setting menu; 

3. Select and click the measurement parameter to be set to return to List Root. 
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2.4.5.3 Set the measurement speed 

Set the measurement speed of the liat measurement according to the user's requirements for 

measurement speed and accuracy. Follow these steps: 

1. Click Meas Time on the List Root on the screen to enter the measurement speed menu; 

2. Select and click the desired measurement speed. 

2.4.6 Sweep measurement example 

This part shows the trace sweep measurement function of TH2851. Connect the crystal resonator to 

the fixture, press Sweep on the front panel to enter the trace sweep measurement interface. 

2.4.6.1 Set |Z|-Theta as measurement parameter 

Set the measurement parameters as follows: 

1. Click Measurement of the Sweep Root on the screen to enter the measurement setting 

menu, then click Tr1 & Tr2 to enter the parameter setting menu; 

2. Make sure that the selected item fo Tr1 & Tr2 is |Z|- θz (the default state is selected), so 

that trace 1 reflects the absolute value of the resistance value, and trace 2 reflects the 

phase. 

2.4.6.2 Set the center and span 

1. Press Center on the front panel to open the sweep range menu and automatically lock at 

Center ; 



 28 

2. Enter the canter frequency of 8MHz , and press 8 > M /μ on the front panel in sequence ; 

3. Press Span on the front panel, the sweep range menu is now automatically locked in the 

Span ; 

4. Enter the value range of 30 kHz, and press the 3 > 0 > k / m keys on the front panel in 

sequence. 

2.4.6.3 Set sweep speed 

1. Press Avg on the front panel to enter the measurement speed menu; 

2. Click Meas Time, then select and tap 3 as measurement Speed. 

2.4.6.4 Set the ordinate of the |Z| curve to the logarithmic distribution 

1. Select trace 1 as the active curve (the measurement parameter of trace 1 is |Z| ); 

2. Press Format on the front panel to enter the ordinate format menu; 

3. Click the Vertical axis type and select logarithmic axis. 

2.4.6.5 Display traces in different coordinate systems 

1. Press Display on the front panel to enter the display setting menu; 

2. Press Allocate Traces to enter the trace assignment setting menu, select and click the 

coordinate system distribution button in the menu. 
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2.4.6.6 Axis auto scaling 

Press Scale on the front panel to enter the coordinate axis setting menu, and press Auto Scale All for 

all traces. 

2.4.6.7 Analysis of measurement results 

Perform equivalent circuit analysis on the trace to find the resonance point of the circuit, and follow 

the steps below: 

 

1. Press Analysis on the front panel to enter the trace analysis menu, and then press the 

Equivalent Circuit to enter the equivalent circuit menu; 

2. Click on the screen to Select Circuit , select and click the Model E button; 

3. Press the Calculate to perform an equivalent analysis on the trace, and the analog values of 

resistance, inductance and capacitance are displayed on the menu; 

4. Turn on the Display button in the equivalent circuit menu, and the equivalent circuit model 

and simulation results will be displayed on the screen; 

5. Press Marker Search on the front panel to enter the marker search menu; 

6. Keep Tr1 as the active curve, press Min, the program will automatically open Tr1 and 

locate the minimum value of |Z| ; 

7. Click the toggle Tacking button to the on state. When the marker tracking is on, the 

program will automatically position the currently selected marker to the selected position 

after each sweep cycle. After one sweep period, Tr1 will be automatically positioned to the 

minimum value of the |Z| trace; 
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Chapter 3  User Calibration 

3.1 Overview  

User calibration needs to be performed by the user before starting the measurement, which can 

eliminate measurement errors caused by fixtures, test pieces, etc. 

 

 

Press Cal on the front panel to enter into the user calibration interface. After entering, the main area 

on the left side of the interface is a list of calibration points. TH2851 provides 20 calibration points, 

whose switch, frequency, reference, etc. can be individually set; the menu area on the right side of 

the interface is the user calibration menu, which can perform all frequency calibration and its switch 

operation. 

3.2 All frequency user calibration setup 

3.2.1 Choose a measuring accessory 

According to the currently selected measurement accessory, set the measurement accessory data in 

the user calibration interface. TH2851 provides several measuring accessories for selection; the 

default selection is 0 m. If the user uses a custom accessory to measure, or the accessory used is not 

in the selectable accessory options, it is recommended to set the measurement accessory to 0 m and 

perform accessory calibration. 

Set up the measuring accessory as follows: 

1. Click Accessory button in the user calibration menu to enter the measurement accessory 

menu; 
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2. Select and click the button corresponding to the selected measuring accessory. 

3.2.2 User open calibration 

3.2.2.1 Toggle open calibration switch 

When the open-circuit calibration in the user calibration is turned off, the user-calibrated 

open-circuit calibration during the measurement process will be calculated using the default data of 

the TH2851 (the user accessory calibration is not turned on). Only the open circuit data of the 

calibration point is used. 

Set the switch state of user open circuit calibration according to the following steps: 

1. Click the Open button in the user calibration menu to enter the open circuit calibration 

menu; 

2. Select and click the ON or OFF button in the Open Calibration menu to set the open state 

of Open Calibration. 

3.2.2.2 All frequency clear for open circuit calibration 

All frequency open-circuit calibration is to perform all frequency open-circuit calibration again. 

After completion, the user’s open-circuit calibration will automatically switch to the open state. The 

zero-clearing data will record and overwrite the original all frequency open-circuit calibration data. 

If necessary, please pay attention to backup and save the original data. 

Perform open-circuit all frequency clear according to the following steps: 

1. Click the Open button in the user calibration menu to enter the open circuit calibration 

menu; 

2. Connect the user's open-circuit standard test piece to the measuring accessory; 

3. Click All frequency clear to start clearing, and wait for the clearing to complete. During 

this process, press ESC on the front panel to interrupt the operation. 

3.2.2.3 List frequency clear for open circuit calibration 

List frequency clear is to perform a one-time open-circuit calibration of the calibration points whose 

status is open in the current calibration point list, and the calibration results will be recorded and 

automatically written into the calibration point list. If no calibration point is currently open, it will 

simply end. 

Perform open-circuit list frequency clear according to the following steps: 

1. Click the Open button in the user calibration menu to enter the open circuit calibration 

menu; 
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2. Connect the user's open-circuit standard test piece to the measuring accessory; 

3. Click the List frequency clear to start clearing, and wait for the clearing to complete. 

3.2.3 User short calibration 

3.2.3.1 Toggle short calibration switch 

When the short-circuit calibration in the user calibration is turned off, the short-circuit calibration of 

the user-calibration in the measurement process will be calculated using the default data of the 

TH2851 (the user accessory calibration is not turned on). After the short-circuit calibration is turned 

on, the user's all frequency short calibration data and the short-circuit data for the calibration point is 

only used. 

Set the switch state of user short-circuit calibration according to the following steps: 

1. Click the Short button in the user calibration menu to enter the short-circuit calibration 

menu; 

2. Select and click the ON or OFF button in the Short Calibration menu to set the on-state of 

the Short Calibration. 

3.2.3.2 All frequency clear for short circuit calibration 

All frequency clear is to perform all frequency short circuit calibration again. After the user short 

circuit calibration is completed, it will automatically switch to the open state. The zero-clearing data 

will record and overwrite the original all frequency short circuit calibration data. If necessary, please 

pay attention to backup and save the original data. 

Perform short-circuit all frequency clear according to the following steps: 

1. Click the Short button in the user calibration menu to enter the short-circuit calibration 

menu; 

2. Connect the user's short-circuit standard test piece to the measuring accessory; 

3. Click All frequency clear to start clearing, and wait for the clearing to complete. During 

this process, press ESC on the front panel to interrupt the operation. 

3.2.3.3 List frequency clear for short circuit calibration 

List frequency clear is to perform a one-time short-circuit calibration of the calibration points whose 

status is open in the current calibration point list, and the calibration results will be recorded and 

automatically written into the calibration point list. If no calibration point is currently open, it will 

simply end. 

Perform short-circuit list frequency clear according to the following steps: 
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1. Click the Short button in the user calibration menu to enter the short-circuit calibration 

menu; 

2. Connect the user's short-circuit standard test piece to the measuring accessory; 

3. Click the List frequency clear to start clearing, and wait for the clearing to complete. 

3.2.4 User load calibration 

3.2.4.1 Toggle load calibration switch 

When the load calibration in the user calibration is turned off, the user-calibrated load calibration 

during the measurement process will be skipped. After the load calibration is turned on, the user's all 

frequency load calibration data and the user's calibration point load data will be used. 

Set the switch state of user load calibration according to the following steps: 

1. Click Load button in the user calibration menu to enter the load calibration menu; 

2. Select and click the ON or OFFbutton in the Load Calibration menu to set the Load 

Calibration on state. 

3.2.4.2 All frequency load calibration 

All frequency clear is to re-calibrate the all frequency load. After completion, the user load 

calibration will automatically switch to the open state, and the calibration data will be recorded and 

overwritten with the original all frequency load calibration data. If necessary, please pay attention to 

backup and save the original data. For all frequency load calibration, please use the components of 

the following model and install them on the measurement fixture: 

 

Perform load circuit all frequency clear according to the following steps: 

1. Click Load button in the user calibration menu to enter the load calibration menu; 

2. It is recommended to use a stable resistor or capacitor, the size of which is similar to the size 

of the DUT, and the impedance value is known and similar to the DUT;  

3. Set the value of load resistance, load inductor and load capacitance on the load calibration 

menu ; 

4. Click All frequency load to calibrate and wait for the calibration to complete. During this 

process, press ESC on the front panel to interrupt the operation. 
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3.2.4.3 List frequency load 

List frequency load is to perform a one-time load calibration on the calibration point in the current 

calibration point list whose status is open, and the calibration result will be recorded and 

automatically written into the calibration point list. If no calibration point is currently open, it will 

simply end. 

Perform the list frequency load as follows: 

1. Click Load button in the user calibration menu to enter the load calibration menu; 

2. Click the List frequency load to start the calibration and wait for the calibration to 

complete. 

3.2.4.4 Load parameter setting 

1. Click Load button in the user calibration menu to enter the load parameter menu; 

2. Click the button corresponding to the desired load parameter combination. 

3.2.5 Phase calibration 

The phase calibration data is related to the measurement accessory, and when the measurement 

accessory is set, the phase calibration is turned off. After resetting the measurement accessory, if 

you need to turn on the phase calibration, it is recommended to perform the all frequency phase 

calibration again. In the Phase Cal button of the user calibration menu, the current phase calibration 

switch status and the date of the current all frequency phase calibration data will be displayed. 

3.2.5.1 Toggle phase calibration switch state 

When user phase calibration is turned off, the phase calibration during measurement will use the 

system phase calibration data. If you need to use user phase calibration data, turn phase calibration 

on. 

Switch the user phase calibration state according to the following steps: 

1． Click Phase Cal button in the user calibration menu to enter the phase parameter menu; 

2.  Click the Phase Cal State to switch the phase calibration switch state. 

3.2.5.2 All frequency phase calibration 

All-frequency phase calibration is to perform all-frequency phase calibration again. After 

completion, the user phase calibration will automatically switch to the open state, and the calibration 

data will be recorded and overwritten with the original user phase calibration data. If necessary, 

please pay attention to backup and save the original data. 
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Perform all frequency phase calibration as follows: 

1. Click Phase Cal button in the user calibration menu to enter the phase parameter menu; 

2. Connect the user's open-circuit standard test piece to the measuring accessory; 

3. Click All Frequency Phase Calibration to start the calibration, wait for the calibration to 

complete, press ESC on the front panel during this process to interrupt the operation. 

3.2.6 Accessory Calibration 

Accessory calibration can be used to calibrate user-defined measurement accessories, which include 

open calibration, short calibration, and phase calibration. If the measurement outcome selected by 

the user is "0m", when the accessory calibration is turned on, the user-calibrated open calibration, 

short calibration, load calibration, and phase calibration will be automatically turned off (accessory 

calibration will also be automatically turned off when the above calibration switches are turned on). 

Accessory Cal button in the user calibration menu will display the name of the currently selected 

accessory and the state of the accessory calibration switch. 

3.2.6.1 Toggle Accessory Calibration Switch Status 

1. Click the Accessory Cal button in the user calibration menu to enter the accessory 

calibration menu; 

2. Select the accessory to be loaded and click its corresponding button to select it; 

3. Click the Accessory Cal State button to switch the accessory calibration switch state. 

Note: The name of the accessory button with the * symbol indicates that the accessory currently has 

a calibration file. Clicking the button will automatically load the file (if there is an error in the file, it 

will prompt and cancel the loading). Only when the selected accessory has a corresponding 

calibration file and accessory calibration can be opened only when it is loaded correctly. If there is 

no corresponding file or the loading is wrong, please click Start Accessory Cal to generate the 

calibration file. 

3.2.6.2 Generate Accessory Calibration File 

1. Click the Accessory Cal button in the user calibration menu to enter the accessory 

calibration menu; 

2. Select the accessory to be loaded and click its corresponding button to select it; 

3. Click Start Accessory Cal to enter the accessory calibration interface, follow the prompts 

to complete the calibration process and generate a calibration file. 

Note: After completing the above steps, the calibration file corresponding to the accessory selected 

in step 2 will be overwritten. If necessary, make a backup in advance. 
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3.3 User calibration point settings 

3.3.1 Toggle calibration point switch state 

1. Click the calibration point to be modified in the list to enter the calibration point setting 

menu; 

2. Click the Switch button to switch the ON/OFF state of the calibration point. Only when the 

calibration point is on, the calibration data of the calibration point will take effect during 

measurement. 

3.3.2 Set the frequency of the calibration point 

1. Click the calibration point to be modified in the list to enter the calibration point setting 

menu; 

2. Click the Measurement Frequency button and enter the frequency of the calibration point. 

Note: During the measurement process, the TH2851 will search for the frequencies of all open 

calibration points. When the searched frequency is consistent with the current measurement 

frequency, the measurement data of this calibration point will be used in the user calibration process. 

3.3.3 Set the load reference for the calibration point 

1. Click the calibration point to be modified in the list to enter the calibration point setting 

menu; 

2. Click the Ref button and enter the reference value. Only when the reference values in both 

Ref buttons are set, the set value will be written to the measuring point list and recorded. 

Note: The parameters corresponding to the reference values need to be set in the Load parameters in 

the user calibration menu. 

3.3.4 Open clear of calibration point 

1. Click the calibration point to be modified in the list to enter the calibration point setting 

menu; 

2. Connect the user's open-circuit standard test piece to the measuring accessory; 

3. Click the Open Cear to complete the open clear of the calibration point, and write the 

calculation result into the calibration point list and record it. 

Note: Only when the user open calibration is turned on, the calibration point is turned on, and the 

frequency of the calibration point is the current measurement frequency, the open clear data of this 

point will be called during the measurement. 
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3.3.5 Short clear of calibration point 

1. Click the calibration point to be modified in the list to enter the calibration point setting 

menu; 

2. Connect the user's short-circuit standard test piece to the measuring accessory; 

3. Click the Short Clear to complete the short clear of the calibration point, and write the 

calculation result into the calibration point list and record it. 

Note: Only when the user short-circuit calibration is turned on, the calibration point is turned on, 

and the frequency of the calibration point is the current measurement frequency, the short clear data 

of this point will be called during the measurement. 

3.3.6 Load calibration at calibration point 

1. Click the calibration point to be modified in the list to enter the calibration point setting 

menu; 

2. Connect the user's standard test piece to the measuring accessory; 

3. Click Load Cal to complete the load calibration of the calibration point, and write the 

calculation result to the calibration point list and record it. 

Note: Only when the user load calibration is turned on, the calibration point is turned on, and the 

calibration point frequency is the current measurement frequency, the load calibration data of this 

point will be called in the measurement. 
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Chapter 4  Point Measurement 

This section describes operations to set the measurement conditions in the point measurement mode, 

such as frequency, average count, etc. 

Press Preset button on the front panel first to restore the instrument to the factory setting, and then 

confirm the complete status recovery. 

4.1 Channel 

The point measurement interface of TH2851 displays eight channels, and every channel can set 

different measurement conditions and parameters. During the measurement process, different 

parameters can be set in different channels to complete different measurement requirements. Click 

the channel buttons on the left side of the interface to switch channel. 

 

4.2 Frequency 

Operation steps below for setting the measurement frequency: 

1. Two ways to set Frequency: one is to click Frequency on the screen, and another is to click 

Meas Setup on Point Root menu and then click Frequency. 

2. Enter the frequency to be modified, for example, enter 1kHz, press 1 and k/m at the front panel 

in turn, the measurement frequency will be changed to 1kHz. 

3. The frequency can also be adjusted by using the up and down arrows and scroll wheel on the 

front panel. 

Channel 

buttons 

Current 

channel 
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4.3 Meas Time 

Operation steps below for setting the measurement rate: 

1. Two ways to set Meas Time: one is to click Meas Time on the screen to enter Meas Time 

menu, and another is to click Meas Setup on Point Root menu and then click Meas Time to 

enter Meas Time menu. 

2. Select needed number level on Meas Time menu. 

3. Generally, the slower the measurement rate, the more accurate the measurement. 
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4.4 Avg Count 

Operation steps below for setting the measurement average: 

1. Two ways to set Avg Count: one is to click Avg Count on the screen, and another is to click 

Meas Setup on Point Root menu and then click Avg Count. 

2. Enter the average count to be modified, for example, enter 1, and press the 1 and x1 buttons in 

sequence at the front panel to modify the average count to 1. 

3. The average count can also be adjusted by using the up and down arrows and scroll wheel on 

the front panel. 

 

4.5 OSC Level 

Operation steps below for setting the measurement level: 

1. Two ways to set OSC Level: one is to click OSC Level on the screen, and another is to click 

Meas Setup on Point Root menu and then click OSC Level enter OSC Level menu. 

2. The source mode (OSC Unit) can be voltage or current, switched on OSC Level menu. The 

way to modify level value is to click Voltage Level or Current Level and set the needed 

voltage or current value.When the source mode is switched, the corresponding value will be 

automatically applied and displayed on Point Root interface. 

3. Two operations to modify level value on the front panel: one is to press the digital buttons, and 

another is to press the directional buttons and turn the knob. 

------------------------------------------------------------------------------------------------------------------------ 

NOTE: When source internal resistance (Internal Resistance) is 100Ω, Voltage Level range is 

5mV-2V, and Current Level range is 50μA-20mA. It is worth noting that Voltage Level can be 

greater than 1V, and Current Level can be greater than 10mA, only when Frequency isn’t higher 

than 1MHz. But when Frequency is higher than 1MHz, the source level will be automatically 

adjusted to the maximum allowable value. 

------------------------------------------------------------------------------------------------------------------------ 
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Operation steps below to set ALC  

 Click ALC on OSC menu to enter ALC menu. 

 Click ALC Control to switch ALC state. 

 Click Max Iteration to input the needed iteration value whose range is 2-10. 

 Click Target % to input the needed accuracy whose range is 0.05-10. 

 

4.6 DC Bias 

Operation steps below for setting the DC bias: 

1. Two ways to set DC Bias: one is to click DC Bias on the screen to enter DC Bias menu, and 

another is to click Meas Setup on Point Root menu and then click DC Bias enter DC Bias 

menu. 
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2. Operation steps below to set the corresponding parameters: 

 Click DC Bias State on DC Bias menu or press DC Bias button on the front panel to 

switch state. 

 Click Meas Range on DC Bias menu to select the needed range. 

 Click DC Bias Mode on DC Bias menu to switch mode that is Voltage or Current. If 

bias mode is Voltage, click Voltage Level to modify level value, else click Current Level. 

When the bias mode is switched, the corresponding value will be automatically applied 

and displayed on Point Root interface. 

 Click Constant Mode on DC Bias menu to switch constant voltage state. 

 Click Max/Min Limit Voltage on DC Bias menu to set max/min voltage value. 

3. Two operations to modify the level value or max/min voltage value of constant voltage on the 

front panel: one is to press the digital buttons, and another is to press the directional buttons 

and turn the knob. 

------------------------------------------------------------------------------------------------------------------------ 

NOTE: The measurement range (Meas Range) and bias voltage (Voltage Level)/current (Current 

Level) will apply to the measurement only when the bias state (DC Bias State) is on. If the bias 

state is off, the measurement range is the default 1mA, and the bias voltage/current is 0. 

------------------------------------------------------------------------------------------------------------------------ 

4.7 AC Range 

Operation steps below for setting the AC range: 

1. Two ways to set ACRange: one is to click ACRange on the screen to enter ACRange menu, 

and another is to click Meas Setup on Point Root menu and then click ACRange enter 

ACRange menu. 

2. On ACRange menu, if range is set to automatic, the automatic range judgment is made during 

the measurement, and the true range will display in the AC range area. Else select needed range 

value. 
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4.8 Trigger 

4.8.1 Trigger Mode 

Operation steps below for setting the trigger mode: 

1. Two ways to select Trigger Mode: one is to press Trigger Mode button on the front panel to 

enter Trigger Mode menu, and another is to click Meas Setup on Point Root menu and then 

click Trigger Mode enter Trigger Mode menu. 

2. There are four trigger modes below to select. 
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Trigger Source Function 

Internal 

Use a consecutive signal generated by the firmware as a trigger source. 

Triggers are sent immediately following the completion of each 

measurement. 

External Use the external trigger input terminal (Handler) as a trigger source. 

Manual Press Trigger to make a trigger. 

Bus A trigger is generated through GPIB/LAN/USB. 

4.8.2 Trigger Delay 

Operation steps below for setting the trigger delay: 

1. One way to select Trigger Delay is to click Meas Setup on Point Root menu and then click 

Trigger Delay. 

2. Two operations to modify delay time value on the front panel: one is to press the digital buttons, 

and another is to press the directional buttons and turn the knob. 

4.9 Result 

4.9.1 Parameter 

In a point measurement, the screen can display up to 4 parameters at same time. 

Operation steps below for setting the measurement parameters: 

1. Two ways to select measurement parameters: one is to click Parameter1~4 to enter Display 

menu, and another is to click Display on Point Root menu and then click Parameter1~4 to 

enter corresponding Parameter menu. 

 

2. There are twenty-four parameters below to select. 
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Name Description 

|Z| Absolute impedance 

|Y| Absolute admittance 

θz (rad) Impedance phase (rad) 

θy (rad) Admittance phase (rad) 

θz (deg) Impedance phase (deg) 

θy (deg) Admittance phase (deg) 

Rs Equivalent series resistance 

Rp Equivalent parallel resistance 

Ls Equivalent series inductance 

Lp Equivalent parallel inductance 

Cs Equivalent series capacitance 

Cp Equivalent parallel capacitance 

R Equivalent series resistance 

G Equivalent parallel conductance 

X Equivalent series reactance 

B Equivalent parallel susceptance 

Q Q value (Quality factor) 

D Dissipation factor 

εr’ 
Relative permittivity real part （ need 

permittivity module） 

εr’’ 
Relative permittivity imaginary part（need 

permittivity module） 

|εr| 
Relative permittivity（need permittivity 

module） 

μ’ 
Relative troidalcore real part （ need 

troidalcore module） 

μ’’ 
Relative troidalcore imaginary part（need 

troidalcore module） 

tan δ Phase（need troidalcore module） 
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4.9.2 Math Mode 

There are three modes below to display measurement results that are Deviation, %Deviation and 

OFF. 

Mode Description 

OFF Measurement value 

Deviation Measurement value-Reference value 

%Deviation （Measurement value-Reference value）*100%/Reference value 

 

Operation steps below for setting the math mode: 

1. Two ways to select the math mode of different parameter: one is to click different Math to 

enter corresponding Parameter menu, and another is to click Display on Point Root menu 

and then click Parameter1~4 to enter corresponding Parameter menu. 

2. On Parameter Set menu, click Math Mode to enter Math menu and select the needed math 

mode. 
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4.9.3 Reference 

Operation steps below for setting the reference: 

1. Two ways to select the reference of different parameters: one is to click different Ref to enter 

corresponding Parameter menu, and another is to click Display on Point Root menu and then 

click Parameter1~4 to enter corresponding Parameter menu. 

2. On Parameter menu, click Reference to modify reference value or click Data→Reference 

that means set current measurement result to reference value. 

3. Two operations to modify reference value on the front panel: one is to press the digital buttons, 

and another is to press the directional buttons and turn the knob. 
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4.10 Comparator 

 

Comparator: this module is used to sort the measurement results. 

Click Comparator on Point Root menu to enter Comparator menu, then click Edit Comptr 

Table to enter Comparator Table interface. 

 

 

Related features of BIN setting as shown below: 

1. The interface can be set up to 9 BINs and 4 conditions for the measurement results. And only 

when the BIN meets all current conditions, it can be counted as qualified. 

2. Each BIN or Condition has own switch. 

3. All BINs are sorted from BIN1 to BIN9 to perform sorting calculation. 
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4. There are two modes of BIN, one is Good Bin that means qualified judgment, and another is 

Bad Bin that means unqualified judgment. 

5. If the measurement result doesn’t belong to any BIN, it will be sorted to NG. 

4.10.1 Condition1~4 

4.10.1.1 Parameter 

Parameter of Condition1~4: they are used to perform the sorting judgment and are independent of 

point measurement parameters used to display measurement results. 

Operation steps below for setting the parameter: 

1. Click Parameter cell to pop up the selection window. 

2. Select and click the needed parameter. 

 

4.10.1.2 Math Mode and Reference 

Math Mode of Condition1~4: they are used to select the format of Upper and Lower. 

Reference of Condition1~4: set Upper an Lower according to them. 

Operation steps below for setting the math mode and reference: 

1. Click Mode cell to pop up the selection window. 

2. Select and click the needed math mode. 

3. Click Reference cell to set the value. 

4. Two operations to modify reference value on the front panel: one is to press the digital buttons, 

and another is to press the directional buttons and turn the knob. 
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Math Mode Description 

OFF Upper and Lower of each BIN are absolute values. When this mode is selected, the 

reference value can not be set. 

% Upper and Lower of each BIN are the difference between the upper/lower limits 

and the .reference 

Deviation Upper and Lower of each BIN are the percentage of the ratio that is the upper/lower 

limits to the reference. 

%Dev Upper and Lower of each BIN are the percentage of the ratio that is the difference 

(between the upper/lower limits and the .reference) to the reference. 

 

 

4.10.2 BIN 

4.10.2.1 Upper and Lower 

Operation steps below for setting the upper and lower limits: 

1. Click Upper and Lower cell to set the value.(BIN state is ON) 

2. Two operations to modify limit value on the front panel: one is to press the digital buttons, and 

another is to press the directional buttons and turn the knob. 
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4.10.2.2 In/Out 

Operation steps below for setting the acceptable range: 

1. Click In/Out cell to pop up the selection window as shown above. 

2. Select and click the needed mode. 

 

In/Out Mode Description 

All 

This mode defines that the qualified range is independent of the upper and lower 

limits of BIN, that is, no matter what the measurement result is, it is considered as 

qualified 

In 
This mode defines that the qualified range is between the upper limit and lower 

limit of BIN.(greater than the lower limit and less than the upper limit) 

Out 

This mode defines that the qualified range is outside the upper and lower limits of 

BIN.(greater than or equal to the upper limit or less than or equal to the lower 

limit) 

4.10.2.3 Copy, Paste and Clear 

These operations are only for upper/lower limits and In/Out mode as shown below. 

Operation steps below to Copy, Paste and Clear BIN settings: 

1. Click BIN1~9 name cell to check the BIN whose settings need to be copied. 

2. Click Copy BIN on Comparator Table menu on the right to copy. 

3. Click BIN1~9 name cell to check the BIN whose settings need to paste. 

4. Click Paste BIN on Comparator Table menu on the right to paste. 

5. Click BIN1~9 name cell to check the BIN whose settings need to be cleared. 
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6. Click Clear BIN on Comparator Table menu on the right to clear. 

 

4.10.2.4 Good/Bad Bin 

In the upper left corner of Comparator Table interface, click Good Bins to set the number of good 

and bad Bins as shown above. 

For example, if Good Bins is ~BIN3, that means BIN1 to BIN3 are good Bins and BIN4 to BIN9 

are bad Bins. 

4.10.2.5 Result 

Operation steps below for setting the sorting results (when sorting settings complete): 

1. On Comparator menu, click Comparator State to made state on to display sorting results on 

the point measurement interface. If state is OFF, sorting results are hidden. 

2. On Comparator menu, click BIN Count to made state on to display the count on the point 

measurement interface. 

3. On Comparator menu, click Clear Bin Count to clear the count on the point measurement 

interface.  
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------------------------------------------------------------------------------------------------------------------------ 

NOTE: Latest in the result column displays the last time sorting result. If the sorting result fails to 

meet any BIN, Latest displays Out. If the measurement result is Overload, Latest displays Invalid. 

If the sorting result belongs to the good Bin, Latest displays the blue BIN name. If the sorting result 

belongs to the bad Bin, Latest displays the red BIN name. 

---------------------------------------------------------------------------------------------------------------------- 
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Chapter 5  List Measurement 

This section describes operations to set the measurement conditions in the list measurement mode, 

such as frequency, average count, etc. 

Press Preset button on the front panel first to restore the instrument to factory setting, and then 

confirm the complete status recovery. 

5.1 Channel 

The list interface of TH2851 displays eight channels, and every channel can set different 

measurement conditions and parameters. During the measurement process, different parameters can 

be set in different channels to complete different measurement requirements. Toggling channel can 

be operated by clicking channel buttons on the left side of the screen. 

 

5.2  Measurement Point 

Click List Meas on Point Root menu enter to List Root interface. 

Click Stim Table on List Root menu to enter Stimulus Table interface. 

Channel 

buttons 

Current 

channel 
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5.2.1 Add Row 

In the initial state, each channel has only one measurement point, the frequency is 1kHz,the average 

is 1, the OSC level is 500mV, and the AC range is automatic. 

Operation steps below for add measurement points: 

1. One way is to click Add Row to add a new row at the bottom, then click Add Row button 

several times to add several rows. 

 

2. Another way is to click Quick Edit on Stimulus menu to enter setting interface, then set Num 

of Points to the needed value to add rows. 
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5.2.2 Copy, Paste and Delete Row 

Operation steps below for copy, paste and deletes measurement points: 

1. Check any cell of a row and then click Copy Row on Stimulus Table menu. 

2. Click Paste Row on Stimulus Table menu to add the copied row at the bottom. 

3. Check any cell of a row and then click Delete Row on Stimulus Table menu to delete this row. 
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5.2.3 Measurement Settings 

5.2.3.1 Frequency 

Operation steps below to modify the frequency of measurement points: 

1. Click Frequency cell that need to modify the value to enter the corresponding point menu. 

2. Two operations to modify the value on the front panel: one is to press the digital buttons, and 

another is to press the directional buttons and turn the knob. 

 

5.2.3.2 Average 

Operation steps below to modify the average of measurement points: 

1. Click Average cell that need to modify the value to enter the corresponding point menu. 

2. Two operations to modify the value on the front panel: one is to press the digital buttons, and 

another is to press the directional buttons and turn the knob. 
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5.2.3.3 OSC Level 

Operation steps below to modify the level of measurement points: 

1. Click OSC Level cell that need to modify the value to enter the corresponding point menu. 

2. Two operations to modify the value on the front panel: one is to press the digital buttons, and 

another is to press the directional buttons and turn the knob. 

 

3. The specific setting requirements are the same as those in 4.5. 
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5.2.3.4 ACRange 

Operation steps below to modify the AC range of measurement points: 

1. Click ACRange cell on the screen to enter ACRange menu,. 

2. On ACRange menu, if range is set to automatic, the automatic range judgment is made during 

the measurement, and the true range will display in the AC range area. Else select needed range 

value. 

 

5.2.3.5 DC Bias 

Operation steps below to modify the bias level of measurement points: 

1. Click DC Bias cell that need to modify the value to enter the corresponding point menu. 

2. Two operations to modify the value on the front panel: one is to press the digital buttons, and 

another is to press the directional buttons and turn the knob. 
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5.2.3.6 List Meas Time 

Operation steps below to modify the rate of measurement points: 

1. Click List Meas Time on List Root menu to enter Meas Time menu. 

2. Select needed number on Meas Time menu. 
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5.3 Trigger 

5.3.1 Trigger Mode 

Operation steps below to modify trigger mode: 

1. Click Trigger on List Root menu to enter Trigger Mode menu. 

2. Select needed mode on Trigger Mode menu. 

 

5.3.2 List Type 

Operation steps below to modify list type: 

1. Click List Type on List Root menu to enter List Type menu. 

2. Select needed mode on List Type menu. 
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Type Description 

Sequence When triggered, measure the remaining measurement points from the current 

measurement point to the end of the list. If the selected measurement point is at 

the end of the list when triggered, it will start from the first point. 

Step At each trigger, measure the currently selected measurement point, and then 

select the next point. 

5.3.3 Point Delay 

Operation steps below to modify the delay time of measurement points: 

1. Click Point Delay cell that need to modify the value to enter the corresponding point menu. 

2. Two operations to modify the value on the front panel: one is to press the digital buttons, and 

another is to press the directional buttons and turn the knob. 

 

5.4 Result 

5.4.1 Parameter 

Operation steps below to set the parameters of measurement points: 

1. Click Display on List Root menu to enter Display menu. 

2. Click Parameter1~4 to modify the parameters. 

3. See 4.10.1 for specific parameter selection. 

--------------------------------------------------------------------------------------------------------------------- 

NOTE: If the parameter is set to None, the column of the parameter will be hidden in the list. 

----------------------------------------------------------------------------------------------------------------------   
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5.4.2 Comparator 

Click Comparator at the top of Stimulus Table interface to enter Comparator Table 

interface. 

 

 

Related features of BIN setting as shown below: 

1. The interface can be set up to 15 BIN and 4 conditions for the measurement results. And only 

when the BIN meets all current conditions, it can be counted as qualified. 

2. Each BIN or Condition has own switch. 

3. Each BIN corresponds to a measurement point in the list measurement, BIN1 corresponds to 

point 1, BIN2 corresponds to point 2, and so on. 



 65 

4. If the measurement result does not belong to any BIN, it will be sorted to NG. 

5. Only when the sorting results of all BIN whose states are on are qualified, the final sorting 

result is qualified, otherwise, the final result will be sorted to NG. 

6. The list sorting settings are similar to point measurement sorting, please refer to 4.9 and 

4.10. 
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Chapter 6  Trace Sweep Measurement 

This chapter describes how to use the trace measurement mode for the sweep measurement and 

analysis, etc. 

6.1 Setting Measurement Conditions 

This section describes how to set up the measurement conditions in Sweep mode. 

6.1.1 Initialization 

The TH2851 has three initial modes, as shown in the following table: 

Initialization 

mode 

Description 

Preset 

Press Preset on the front panel, a confirmation dialog box will appear on the 

screen (you can close it in the settings), press OK button and execute it. 

Preset can be used to restore to factory settings or to restore to user settings 

(UserPres file is required), which can be confirmed and changed in the 

System Settings > Misc Setup > Preset Setup menu. 

Preset can also be implemented with the command :SYST:PRES 

*RST External input *RST command 

Factory Settings TH2851 Restore to Factory Settings 

6.1.2 Setting Channels and Traces 

6.1.2.1 Overview of Channels and Traces 

The TH2851 allows multiple channels to be set up simultaneously to perform different measurement 

at different stimulus states. 

Multiple traces (measurement parameters) can be displayed in each channel, and each channel is 

independent and not correlated with each other. In other words, you have to set the measurement 

conditions as well as the measurement parameters, etc. for each measured channel. 

When you set up channels/traces, only the currently active channels/traces are applied. You can set 

only the active channels/traces to be displayed on the screen. 

The following table lists the setting parameters by the TH2851, along with the scope of each 

variable (analyzer, channel, or trace) and the operating keys: 
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Parameters 
Scope of action 

Setup keys 
Analyzer Channel Traces 

Stimulus Setting 

Sweep Range  √  
Start, Stop, 

Center, Span 

OSC Level, CW Frequency  √  
Sweep Setup > 

OSC Level 

Sweep Time, Point Delay  √  

Sweep Setup > 

Sweep Time, 

Point Delay 

Number of Points  √  
Sweep Setup > 

Points 

Segmented Display  √  

Sweep Setup > 

Segmented 

Display 

DC Bias  √  
Sweep Setup > 

DC Bias 

Trigger Settings 

Trigger Mode  √  

Trigger Mode> 

Hold / Single / 

Continuous 

Trigger Source, Trigger 

Event, Trigger Scope 
√   

Trigger Mode > 

Trigger Source / 

Trigger Event / 

Trigger Scope 

Trigger √   
Trigger Mode > 

Restart/Trigger 

Response Settings 

Measurement Parameter   √ Meas 

Data Mode   √ Format 

Scale   √ Scale 

Memory Trace and Data 

Math 
  √ 

Display > 

Display / 

Data→Mem / 

Data Math 

Averaging  √  

Avg > Averaging 

Restart / Average 

Factor / 

Averaging 

Averaging Trigger √   
Avg > Average 

trigger 

Marker   √ 

Marker / Marker 

Search / Marker 

Function 
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Analysis 

Equivalent circuit   √ 

Analysis > 

Equivalent 

Circuit 

Limit Line   √ 
Analysis > Limit 

Test 

Save and Recall √   Save/Recall 

System 

System √   System 

Preset √   Preset 

 

The TH2851 sweep mode provides 4 channels with up to 4 traces per channel and a maximum of 

1601 measurement points. 

6.1.2.2 Setting Channel Display (Channel Layout) 

The measurement results for each channel are presented in its separate window (channel window), 

and only one channel's trace can be displayed in each window. This means that the layout of 

channels depends on the number of channels currently displayed on screen. 

Note: The measurement results for each channel are independent of the currently displayed channel 

(channels that are not displayed can also be tested). 

Set the layout of channels according to the following steps: 

1. Press Display on the front panel to open the Display menu, followed by Allocate Channels 

to open the Allocate menu. 

2. Press the appropriate softkey to select the window layout. 

6.1.2.3 Changing Active Channel 

Only the active channels can change its setting parameters directly. The window frame of the active 

channel is displayed brighter than the other channels. If you need to change the parameters of a 

channel, you must activate the channel first. 

The active channels can be switched via keys on the front panel: 

Key Function 

Channel Next Change the active channel to the next channel with a larger channel 

number  

Channel Prev Change the active channel to the previous channel with a smaller 

channel number 
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6.1.2.4 Setting Trace Display 

You can define the display of traces by setting the number of traces (the upper limit of displayed 

trace numbers). For example, if you set the number of traces to 3, traces 1,2,3 are displayed in the 

channel. 

Set the number of traces according to the following steps: 

1. Switch to the desired channel via the Channel Next (or Channel Prev) key on the front 

panel. 

2. Press Display on the front panel to open the Display menu. 

3. Press Num of Traces to select the number of traces. 

Traces are displayed in the channel according to the number of traces and the trace layout, and the 

layout of the trace is the same as the layout of the channel. If the number of traces is less than the 

number of traces in the layout, nothing is displayed in the remaining area; if the number of traces is 

more than the number of display areas in the distribution, more than one trace may appear in the 

existing display area. As shown in the figure below, if the number of traces is 4 and the number of 

display areas for trace distribution is 3, traces 1 and 2 will be displayed in the first display area, 

trace 3 in area 2, and trace 4 in area 3. 

 

Set the distribution of the trace according to the following steps: 

1. Switch to the channel to be set via the Channel Next (or Channel Prev) button. 

2. Press Display on the front panel to open the Display menu. 

3. Press Allocate Traces to select the trace allocation mode to be modified. 
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6.1.2.5 Channel and Trace Layout 

 

6.1.2.6 Changing Active Trace 

The active trace is the only one whose parameters can be changed. On the screen, the active trace 

name (e.g., Tr1) is highlighted and labeled with a triangle on the left. Before changing the 

parameters specific to a trace, you must first activate the trace. 

The active traces can be switched via the front panel keys: 

Key Name Function 

Trace Next The active trace changes from the current trace to the next trace with the larger trace 

number. 

Trace Prev The active trace changes from the current trace to the previous trace with the smaller 

trace number. 

6.1.3 Sweep Parameters Settings 

6.1.3.1 Selecting Sweep Type 

Follow the steps below to select the sweep type: 

1. Press Sweep Type on the front panel to enter the Sweep Type menu. 
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2. Press the corresponding button to select the sweep type: Lin Freq / Log Freq / OSC Level / 

DC Bias / Log DC Bias / Segment. 

When the sweep type is OSC level or DC bias, it can be modified to voltage or current level. The 

DC bias will only work if the bias state in the sweep type is turned on, otherwise it will always be 

the default value. 

Note: When the internal resistance of the analyzer is set to 100Ω in the system, the upper limit of 

the OSC level will change. The input range of voltage becomes: 5mV-2V, and the input range of 

current becomes: 50μA-20mA. It should be noted that the voltage can be set to greater than 1V and 

the current can be set to greater than 10mA only when the measurement frequency is not higher than 

1MHz. 

The sweep type is set for all traces in the entire channel, so there is no need to change the active 

trace. 

6.1.3.2 Setting Sweep Range 

The sweep range can be set either start/stop values or center/span values. The sweep range is set for 

all traces in the entire channel, so there is no need to change the active trace. 

Set the sweep range with start/stop values: 

1. Press Start on the front panel to enter the Stimulus menu and input the start value. 

2. Press Stop on the front panel to input the stop value. 

The start value should not be greater than the stop value. If the input start value is greater than the 

stop value, the stop value will be automatically set to match the start value. If a decreasing 

frequency measurement is required, you can set the frequency to increase and then set the direction 

to reverse. 

Set the sweep range with center/span values: 

1. Press Center on the front panel to enter the Stimulus menu and input the center value. 

2. Press Span on the front panel to input the span value. 

Set the sweep range with the marker: 

1. Press Marker Function on the front panel to enter the Marker Function menu. 

2. Press the corresponding setting softkey to set the sweep range, and the specific functions 

are shown in the table below. 

Softkey Function 

Marker→Start Set the start value to the stimulus value of the active marker on the currently active 

trace. 

Marker → Stop Set the stop value to the stimulus value of the active marker on the currently active 

trace. 

Marker→Center Set the center value to the stimulus value of the active marker on the currently active 
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trace. 

 

 

Softkey Function 

Marker Zoom Scale the sweep range according to the zoom aperture and places the stimulus value of 

the currently selected marker at the center value of the sweep range. This function 

focuses the sweep range around the marker and measures and plots the trace within that 

range. 

Zoom Aperture 
Set the zooming aperture used when the Marker Zoom is executed as a percentage. The 

value can range from 0.01% to 100%, and the default value of power-on and preset state 

is 10%. 

6.1.3.3 Setting Number of Points 

1. Press Sweep Setup on the front panel to access the Sweep Setup button. 

2. In the input box of the Points button, input the number of points. 

Note: The range of points is from 2 to 1601. If the number of points entered is greater than the 

current number of points, the default point will be added at the right stop of the trace; if the number 

of points entered is less than the current points, the extra points will be deleted in order from right to 

left. 

6.1.3.4 Setting Sweep Direction 

1. Press Sweep Setup on the front panel to access the Sweep Setup button. 

2. Press Direction to switch the sweep direction. 

Note: The sweep direction allows you to select the direction of the sweep. By default, the sweep 

direction is forward, scanning from left to right; when set to reverse, scanning from right to left. 

6.1.3.5 Setting Time Delay for Measurement 

The measurement delay can be set and used for a period before the sweep or actual measurement 

starts after the measurement signal is given. This function is important when the parameters of the 

DUT need a certain time to stabilize after the measurement signal is received. Another effect of this 

function is to observe the changes in the impedance of the DUT over a period of time. 

The delay for each measurement point consists of two parts, set as shown in the following equation 

where the sweep time is not a proxy for the time required for the entire sweep process. 

Point Wait Time = Point Delay + (Sweep Time / Number of Points) 

This feature helps reduce the effects of changes in the condition of the stimulus when measuring the 

slow response devices. This function is useful even if the span of the stimulus is 0. 
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When the trigger mode is at On Sweep: 

 

 

When the trigger mode is at On Point: 

 

 

Modify the point delay and sweep time by following the steps below: 

1. Press Sweep Setup on the front panel to enter the Sweep Setup menu and input the point 

delay value to be modified in the input box of the Point Delay button. 

2. In the Sweep Time button’s input box, input the sweep time value that needs to be 

modified. 

The time delay can be set before the start of the sweep cycle. This delay is quite important in 

controlling the impact to the DUTs when starting the new sweep (In general, the stimulus conditions 

like frequency and OSC level change significantly when a sweep is completed to return to the first 

measurement point). 
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Sweep delay modification method: press Sweep Setup on the front panel to enter the Sweep Setup 

menu and input the delay value that needs to be modified in the input box of the Sweep Delay 

button. 

6.1.3.6 Setting Sweep Time 

1. Press Avg on the front panel to enter the Average menu. 

2. Press Meas Time and select the desired measurement speed value. The options are 

1/2/3/4/5, with 1 being the fastest speed and 5 being the most precise. 

Note: Choosing a larger measurement speed will result in higher measurement accuracy but also 

require a longer measurement time. 

6.1.3.7 Setting Sweep Averaging (Averaging) 

The sweep averaging is averaged over each of multiple consecutive sweep cycles. The measurement 

result (vector value) of each measurement point is influenced by a certain weight (related to the 

average factor set by the user) with the measurement value of the same point in the completed 

sweep cycle. The formula for the sweep averaging is shown below: 

 

An: The average result (vector value) at the current measurement point when the sweep count is 

n. 

Sn: The actual measurement value (vector value) at the current measurement point when the 

sweep count is n. 

F: Averaging factor, user setting required. 

Set the average according to the following steps: 

1. Press Avg on the front panel to enter the Average menu. 

2. Press Ave Factor and input the desired value for the averaging factor value which can be 

set from 1 to 999. If set to 1, it is equivalent to turning off the averaging. 

3. Press Averaging to toggle the ON/OFF status of the averaging. 

Note: When the averaging is on, the value of the averaging is displayed on the bottom right corner 

of the status bar. The averaging starts once it’s turned on or by pressing Averaging Restart. When the 

averaging starts, the averaging on the status bar will be displayed as the initial value of 0, increasing 

by 1 after each sweep is completed, and the value will remain unchanged when the averaging and 

the averaging factor are equal. 
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6.1.3.8 Making Averaging Measurement with Single Trigger 

When the average trigger is turned on, if the averaging is turned on, a sweep equal to the number of 

times by the averaging factor will be performed when the user performs a single trigger mode. 

Averaging Trigger Function 

ON Single-trigger mode sweeps until the number of sweep cycles equals the average 

number of slides 

OFF Single-trigger mode sweeps for one sweep cycle only 

Turn on the averaging trigger and perform a single trigger pattern as follows: 

1. Press Avg on the front panel to open the Average menu. 

2. Press Avg Trigger button to turn it on. 

3. Press Trigger Mode on the front panel to enter the Trigger menu. 

4. Press Single to perform one trigger. 

6.1.3.9 Setting Averaging for Each Measurement Point 

Single-point averaging is the averaging of measured values for each measurement point based on 

the number of single-point averages (factors) set by the user. The TH2851 measures the same 

measurement point repeatedly until the averaging factor is reached, and then averages all the 

measurements as the measurement result for that measurement point, and then starts measuring the 

next measurement point. The point averaging algorithm is displayed below: 

 

M: Point averaging measurement (vector value) at the measurement point. 

F: Point averaging factor (can be set by the user). 

Sn: The measured value (vector value) of the current measurement point. 

Set up the point averaging according to the following steps: 

1. Press Avg on the front panel to enter the Average menu. 

2. Press Point Avg Factor and set up the desired value, which can be set from 1 to 999, and if 

set to 1, is equivalent to point averaging off. 

3. Press Point Avg to toggle the ON/OFF status of the point averaging. 

6.1.3.10 Setting Trace Smooth 

Smooth is a secondary processing to the data of the measurement trace, and when it is turned on, it 

will correct the measurement data in real time to make the trace display smoother. Modifying the 
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frequency, measurement parameters, etc. will automatically turn off the trace smoothing. 

Set up trace smoothing as follows. 

1. Press Avg on the front panel to enter the Average menu. 

2. Press Smooth to toggle the ON/OFF status of the smooth. 

6.1.4 Setting Signal Source 

6.1.4.1 Modifying Fixed Frequency at OSC / DC Bias Sweep 

When the sweep stimulus is not a frequency, modify the fixed frequency according to the following 

steps. 

1． Press Sweep Setup on the front panel to enter the Sweep Setup menu. 

2． Press CW Frequency to input a fixed frequency value. 

Note: When the internal resistance of the instrument's signal source is set to 100Ω in the system, the 

range of the fixed frequency will interact with the settable range of OSC if the sweep mode is Level 

mode. When the voltage is set to greater than 1V/current is set to greater than 10mA, the maximum 

allowable setting of fixed frequency is 1MHz; when the fixed frequency has been set to greater than 

1MHz, the upper limit of sweep voltage/current is 1V/10mA. 

6.1.4.2 Setting Unit for OSC Level 

1. Press Sweep Setup on the front panel to enter the Sweep Setup menu, followed by OSC 

Level to enter the OSC Level menu. 

2. Press OSC Unit to change the source mode to Voltage/Current. 

Note: The source mode set in the above step can be used to set the OSC level to the sweep stimulus 

value or to the sweep stimulus value at a fixed measurement level of a non-measurement level. The 

OSC level acts on all traces in the whole channel, so there is no need to change the active trace. 

6.1.4.3 Setting Oscillator Level 

1. Press Sweep Setup on the front panel to enter the Sweep Setup menu, followed by OSC 

Level to enter the OSC Level menu. 

2. Depending on the source mode, the button Voltage Level and Current Level will be 

available and unavailable respectively. For example, if the source mode is Voltage, the 

button Voltage Level will be available, and then select and enter the voltage value. 

Note: When the internal resistance of the instrument's signal source is set to 100Ω in the system, the 

upper limit of the OSC level changes. The voltage input range becomes: 5mV-2V, and the current 

input range becomes: 50μA-20mA. It should be noted that the voltage can be set to greater than 1V 
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and the current can be set to greater than 10mA only when the frequency (or the fixed frequency is 

in 6.1.4.1 when the sweep type is DC bias) is not higher than 1MHz; when the frequency is set to 

greater than 1MHz, the source level that has been set is automatically adjusted to the maximum 

allowed. 

6.1.4.4 Controlling Oscillator Level (ALC) 

1. Press Sweep Setup on the front panel to enter the Sweep Setup menu, followed by OSC 

Level to enter the OSC Level menu. 

2. Press ALC to enter the ALC menu and press ALC Control to change the ALC state. 

3. Press Max Iteration and input the desired maximum iteration value, ranging from 2 to 10. 

4. Press Target % and input the desired value, 0.05 to 10. 

6.1.4.5 Setting DC Bias Unit 

Set the DC bias according to the following steps: 

1. Press Sweep Setup on the front panel to enter the Sweep Setup menu, followed by DC 

Bias to enter the DC Bias menu. 

2. Press DC Bias Mode to switch the DC bias mode to Voltage/Current. 

Note: The bias mode set in this step can be used to set the DC bias to the sweep stimulus value or to 

the sweep stimulus value at a fixed measurement level of a non-measurement level. The DC bias is 

applied to all traces in the whole channel, so there is no need to switch the active trace. 

6.1.4.6 Setting DC Bias Value 

1. Press Sweep Setup on the front panel to enter the Sweep Setup menu, followed by DC 

Bias to enter the DC Bias menu. 

2. Depending on the bias mode, the button Voltage Level and Current Level are available and 

unavailable, respectively. For example, if the bias mode is Voltage Level, the button 

Voltage Level will be available, and then press the Voltage Level and input the desired 

voltage value. 

6.1.4.7 Setting DC Bias Measurement Range 

Set the DC bias measurement range before turning on the DC bias. The DC bias measurement range 

is used to optimize the DC circuit transmitted to the impedance measurement loop. This setting 

affects the accuracy of the impedance measurement, regardless of whether the DC bias is On or Off 

and what mode it is. In general, setting the DC bias measurement range as small as possible can give 

the maximum measurement accuracy. It is recommended that the DC bias measurement range is set 
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to 1mA for the first measurement after the DC bias setting is applied. 

When the DC bias is not turned on, 1mA will be the default setting and always work in the 

measurement. 

Set the DC bias measurement range according to the following steps: 

1. Press Sweep Setup on the front panel to enter the Sweep Setup menu, followed by DC 

Bias to enter the DC Bias menu. 

2. Press Meas Range to enter the Meas Range menu and select the desired range value: 

1mA/10mA/100mA. 

6.1.5 Setting Trigger 

6.1.5.1 Overview 

When the TH2851 detects a trigger signal given by the user, it performs a sweep or point 

measurement in the channel depending on the trigger signal mode and events and other attributes. 

The measurement process for each channel does not depend on whether that channel is displayed, 

and each channel can still be measured even if it is not displayed (appropriate settings are required). 

6.1.5.2 Selecting Trigger Source 

The trigger source integrates the signal that starts the measurement process. Press Trigger Mode on 

the front panel and subsequently press Trigger Source. The optional trigger sources and their 

descriptions are shown in the following table: 

Trigger source Function 

Internal A firmware-integrated continuous signal is used as the trigger source, and each 

measurement cycle is triggered immediately after the completion. 

External Use external trigger (Handler) as trigger source. 

Manual Trigger once when pressing the Trigger on the front panel. 

Bus A trigger is performed by commands received via GPIB/LAN/USB 

6.1.5.3 Selecting Trigger Event 

Press Trigger Mode on the front panel and subsequently switch by pressing Trigger Event. The 

available trigger events and their descriptions are shown in the following table: 

Trigger Event Function 

On Sweep Measure all measurement points in the whole cycle after each trigger. 

On Point Measure a single measurement point after each trigger. 

Note: When the trigger source is internal trigger, the point trigger does not work. 
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6.1.5.4 Controlling Trigger 

The user can set individual trigger modes for each channel, which allows the user to control the 

operation of each channel after receiving the trigger signal. 

1. Switch to the desired channel via Channel Next (or Channel Prev) on the front panel. 

2. Press Trigger Mode on the front panel to enter the Trigger menu and select the trigger 

mode. The selectable trigger mode buttons and their descriptions are shown in the 

following table: 

Trigger Softkey Function 

Hold Set the active channel to hold and stop sweeping immediately after pressing, 

any subsequent measurement will not be triggered. 

Single Set the active channel to single, switch to hold and stop measurement 

immediately after a measurement cycle. 

Continuous Set the active channel to continuous, the measurement signal is always 

triggered after the measurement cycle. 

Hold All Set all channels to hold. 

Continuous Disp CH Set all currently displayed channels to continuous. 

6.1.5.5 Setting Trigger Scope 

The trigger scope defines the range of channels that can be triggered currently. For example, if the 

trigger mode of all 4 channels is continuous mode and the trigger scope is set to the active channel, 

only the currently active channel can be triggered. 

Press Trigger Mode on the front panel to enter the Trigger menu and switch by pressing Trigger 

Scope. The selectable trigger scopes and their descriptions are shown in the following table: 

Trigger mode Function 

All Channel All channels are triggered in sequence. 

Active Channel Trigger only for the currently active channel. 

6.1.6 Measurement of Multiple Sweep Ranges with Different Conditions in 

a Single Action (Segment Sweep) 

To perform a segment sweep, the user needs to define at least two frequency ranges, called segments. 

Each segment can be set with different number of points, OSC level, DC bias, measurement time, 

sweep time, sweep delay time, etc. All segments are swept sequentially in the same sweep 

operation. 

Performing segment sweep allows the user to skip frequency ranges that do not need to be swept, 

while allowing different conditions to be measured for specific frequency ranges. For example, the 

number of points in some segments can be set as large as possible to obtain more accurate results, 
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while setting as few points as possible in some segments that do not require accurate results. By 

doing so, you can optimize the measurement time without having to perform a complete operation 

in a specific frequency range for the same measurement conditions. 

To set up a segment, you need to enter Sweep Segment Setup screen and follow the steps below: 

1. Press Sweep Setup on the front panel to enter the Sweep Setup menu. 

2. Press Edit Segment Table to enter the segment table. 

3. Press the following buttons to change the setting mode of the frequency range for each 

segment and the setting switches for each other measurement condition. 

Set button Function 

Freq Mode Toggle the setting mode of the frequency range (Start/Stop or Center/Span) 

List OSC Level Switch the OSC level setting for each segment, and only when it is turned on, the 

segment settings list shows the Source Mode and OSC Level 

List Bias Switch the OSC level setting for each segment, and only when it is turned on, the 

segment settings list shows the Bias mode and DC Bias 

List Meas Time Switch the OSC level setting for each segment, and only when it is turned on, the 

segment settings list shows the Meas Time 

List Average Switch the OSC level setting for each segment, and only when it is turned on, the 

segment settings list shows the Point Avg 

List Segment State Switch the OSC level setting for each segment, and only when it is turned on, the 

segment settings list shows the Segment Time 

List Segment Delay Switch the OSC level setting for each segment, and only when it is turned on, the 

segment settings list shows the Segment Delay 

 

Apply the segment sweep list you have created by setting the sweep mode as follows: 

1. Return to the sweep measurement interface and press Sweep Type on the front panel to 

enter the Sweep Type menu. 

2. Press Segment button to apply the segment settings to the measurement. 

After setting to segment sweep, you can set the methods of displaying segment traces as follows: 

1. Press Sweep Setup on the front panel to enter the Sweep Setup menu. 

2. Press Segment Display to switch the display mode: Order Base/Freq Base. 

6.2 Setting Display Format of Measurement Result 

This chapter describes how to set up the TH2851 to display the measurement results in a way that 

best suits the user. 
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6.2.1 Selecting Measurement Parameters 

6.2.1.1 Simultaneous Selection of Measurement Parameters for Traces 1 and 2 

1. Press Meas on the front panel to enter the Measurement menu. 

2. Press Trace 1&2 to enter the measurement parameter selection menu. 

3. Select and press the button corresponding to the measurement parameter to be set. The 

buttons corresponding to the combinations of measurement parameters that can be selected 

are shown in the following table: 

Available Options 
Button 

Trace 1 Trace 2 

Absolute impedance value Impedance phase (angle) |Z|-θz (deg) 

Equivalent circuit resistance Equivalent circuit reactance R-X 

Equivalent circuit series 

inductance 

Equivalent circuit series resistance Ls-Rs 

Equivalent circuit series 

inductance 

Q factor (Quality factor) Ls-Q 

Equivalent circuit series 

capacitance 

Equivalent circuit series resistance Cs-Rs 

Equivalent circuit series 

capacitance 

Q factor (Quality factor) Cs-Q 

Equivalent circuit series 

capacitance 

Dissipation factor Cs-D 

Absolute admittance Admittance phase (angle) |Y|-θy (deg) 

Equivalent circuit conductance Equivalent circuit susceptance G-B 

Equivalent circuit parallel 

inductance 

Equivalent circuit conductance Lp-G 

Equivalent circuit parallel 

inductance 

Equivalent circuit parallel 

resistance 

Lp-Rp 

Equivalent circuit parallel 

inductance 

Q factor (Quality factor) Lp-Q 

Equivalent circuit parallel 

capacitance 

Equivalent circuit conductance Cp-G 

Equivalent circuit parallel 

capacitance 

Equivalent circuit parallel 

resistance 

Cp-Rp 

Equivalent circuit parallel 

capacitance 

Q factor (Quality factor) Cp-Q 

Equivalent circuit parallel 

capacitance 

Dissipation factor Cp-D 

Absolute impedance value Equivalent circuit series 

inductance 

|Z|-Ls 
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Absolute impedance value Equivalent circuit series 

capacitance 

|Z|-Cs 

Absolute impedance value Equivalent circuit parallel 

inductance 

|Z|-Lp 

Absolute impedance value Equivalent circuit parallel 

capacitance 

|Z|-Cp 

Absolute impedance value Equivalent circuit series resistance |Z|-Rs 

Absolute impedance value Q factor (Quality factor) |Z|-Q 

Absolute impedance value Dissipation factor |Z|-D 

Magnetic permeability real part Magnetic permeability imaginary 

part 

μr'-μr'' (requires magnetic 

permeability module support) 

Impedance (plural form)  Admittance (plural form)  Z-Y 

Note: Each trace in the TH2851 has an independent vertical coordinate format, scaling data, 

memory trace, etc. Each trace is distinguished by measurement parameters. Selecting two 

measurement parameters at the same time makes it easier to detect the DUT through different angles 

by switching between different parameter combinations, thus making it easier to determine the type 

of the DUT. 

6.2.1.2 Setting Measurement Parameters for Individual Trace 

Set the measurement parameters for the individual traces according to the following steps: 

1. Press Meas on the front panel to enter the Measurement menu. 

2. Press Trace 1, Trace 2, Trace 3 and Trace 4 to enter the parameter setting menu of the 

corresponding trace. By default, the trace is 2. If you need to set Trace 3 and Trace 4, you 

need to set the number of traces first. 

3. Select and press the button corresponding to the parameter to be set. 

6.2.2 Setting Format of Y-Axis 

The vertical coordinates corresponding to each trace can be set as linear or logarithmic axes 

according to the actual measurement, as follows: 

1. Press Format on the front panel to access the Format menu. 

2. Press Y-Axis to enter the Y-Axis menu and press the button of the axis type you need to 

set. 

Note: If you select the logarithmic axis, the points in the trace whose vertical coordinate is less than 

0 will automatically change the vertical coordinate to 1x10
-18

. 
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6.2.3 Scaling Trace 

6.2.3.1 Auto Scaling Trace 

1. Activate the trace that needs to be scaled by Trace Prev and Trace Next. 

2. Press Scale on the front panel to enter Scale menu and press Auto Scale to scale the active 

trace so that all measurement points of the active trace are visible in the coordinate system 

and the overall characteristics of the trace can be observed. 

3. Press Auto Scale All to scale all current traces. 

6.2.3.2 Manual Scale Settings 

When the vertical coordinate is linear, the user can set the scaling of the trace by first setting the 

position of the reference value, then setting the reference value, and then you can set the scale value 

of each division. Operate according to the following steps: 

1. Activate the trace that needs to be scaled by Trace Prev and Trace Next. 

2. Press Scale on the front panel to enter the Scale menu, press Reference Position, input the 

position of the reference value scale relative to the bottom of the vertical coordinate, in the 

current state, the number of areas is 10, so the value can be set in the range of 0-10, the 

default is 5, that is, in the middle of the vertical coordinate, note that the reference value 

scale is a scale parallel to the horizontal coordinate, and its label text color is consistent 

with the corresponding trace. 

3. Press Reference Y Value and input the desired vertical coordinate reference value, which is 

displayed on the vertical axis in the same color as the current trace. 

4. Alternatively, if there is a selected marker displayed in the coordinate system, you can 

press Marker Function to open the Marker Function menu and press Marker → Reference 

to use the selected marker value as the reference Y value. 

5. Press Scale/Div and input the scale value for each division. 

When the axis is logarithmic, you can set the scaling of the trace by setting the maximum and 

minimum values of the vertical coordinates. Proceed according to the following steps: 

1. Activate the trace that needs to be scaled by Trace Prev and Trace Next. 

2. Press Scale on the front panel to enter the Scale menu, press Log-Y Top and input the 

upper limit value of the vertical coordinate that needs to be set. 

3. Press Log-Y Bottom and enter the lower limit value of the vertical coordinate you need to 

set. 
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6.2.4 Comparison and Calculation of Trace 

The traces in the TH2851 all contain two different trace types: data and memory. Data traces are 

always consistent with the measurement data of the current DUT, and memory traces acquire data 

from a certain point in time. The following table lists the two trace types and functions: 

Trace Types Function 

Data Trace Displays the current measurement data and calculation results (updated according to the 

sweep cycle) 

Memory Trace Stores and displays previously saved measured values (acquired when pressing Display> 

Data→Mem) 

This feature increases the flexibility of the user’s measurements, for example, Data traces and 

memory traces can be displayed and compared with each other on the same screen simultaneously 

or to display the results of data traces and memory traces calculated from each other. 

6.2.4.1 Distinguishing between Data Trace and Memory Trace by Comparison and 

Calculation 

1. Activate the trace that needs to be operated by Trace Prev and Trace Next. 

2. Press Display on the front panel to enter the Display menu. 

3. Press Display to select Data (only the data trace is displayed in the current coordinate 

system). 

4. Start testing the DUT and then display the results. 

5. At the moment, the user can stop (hold) the measurement trace by pressing the Hold 

button on the front panel, which ensures that the data trace can be accurately reproduced 

when the data is later stored into the memory trace. 

6. Press Data →Memory and store measurement data into the memory trace. 

7. The TH2851 provides a number of button options to control how the trace is displayed. 

Press Display, the optional buttons and corresponding display functions are shown below: 

Softkeys Function 

Data Displays data traces on the screen only 

Mem Displays the memory trace on the screen only 

Data & Mem Displays the data trace and memory trace on the screen simultaneously for easy 

comparison 

OFF None of the traces are displayed 

 

8. At this point, you can start the measurement of the DUT to observe the two traces, or if 

you stopped the measurement before, you now need to restart it in the trigger menu.  
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Note: When the Data→Mem button is pressed, the memory trace will acquire the data on the 

current screen. The memory trace always acquires the measurement result, even if the current screen 

shows the result after the calculation. The Data→Mem button only works on the currently active 

trace. If you need to operate on other traces, you need to activate the trace first. 

6.2.4.2 Setting Offset Operation 

The user can set the mathematical offset with respect to the measured data, and the result of the 

operation is displayed through the data trace. The operation is performed according to the following 

steps: 

1. Press Display > Data→Mem to store the measurement data. 

2. Press Data Math Offset and input the desired offset value (0 in the default state). 

3. Press Data Math and select the operation corresponding to one of the following buttons: 

Buttons Function 

OFF Turns off math operations 

Data + Mem Adds the measured data to the memory data and stores in data trace 

Data - Mem Subtracts the measured data from the memory data and stores in data trace 

Data * Mem Multiplys the measured data with the memory data and stores in data trace 

Data / Mem Divides the measured data by the memory data and stores result in data trace 

 

4. Press Display and select the format of the trace display on the screen. 

5. Start the measurement. 

6.2.5 Monitoring Source Signal Level 

6.2.5.1 Monitoring of AC Measurement Signal Level 

In most cases, the actual AC voltage applied to the DUT will deviate from the setting value because 

the loss occurs between each measurement terminal and the DUT. The TH2851 provides a function 

that allows the user to monitor the actual source signal of AC voltage and current applied to the 

DUT, called "signal level monitor". 

Set up level signal monitoring according to the following steps. 

1. Press Meas to display the Measurement menu. 

2. Press OSC Monitor Trace and set it to On, when the number of traces in the channel is set 

to 4, the measurement parameter of trace 3 is set to Vac, the measurement parameter of 

trace 4 is set to Iac, and traces 3 and 4 are the AC level monitoring traces. 

3. Press OSC Monitor Trace and set it to Off, the number of traces in the channel is set to 2, 

trace 3 and 4 are not displayed. 
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6.2.5.2 Monitoring DC Bias Level 

In most cases, the actual DC bias applied to the DUT will deviate from the set value due to losses 

between each measurement terminal and the DUT, and the TH2851 provides a function that allows 

the user to monitor the actual DC bias voltage and current applied to the DUT. This feature is called 

the “DC bias level monitor.” 

The user can monitor the voltage and current values of the DC bias, which are refreshed before each 

sweep cycle and displayed in the upper right corner of the screen, labeled DCV and DCI. 

Turn on the DC monitoring according to the following steps: 

1. Press Meas to display the Measurement menu. 

2. Press DC Monitor Setup > DC Monitor to toggle the ON/OFF status for DC bias 

monitoring. 

6.2.6 Setting Form Display 

6.2.6.1 Maximizing the display of specific channels/traces 

When there are multiple channels, you can maximize the display of a specific channel on the screen; 

when there are multiple traces in the channel, you can also maximize the display of a specific trace 

in the channel form. 

Switch the maximized display state of the channel according to the following steps: 

1. Press Channel Next (or Channel Prev) to switch to the channel that needs to be set up. 

2. Press Channel Max to maximize the channel form. 

3. Press Channel Max again to restore the channel form to its original size. 

Switch the maximum display state of the trace according to the following steps: 

1. Press Channel Next (or Channel Prev) to switch to the channel where the trace to be set is 

located. 

2. Press Trace Next (or Trace Prev) to switch to the trace that needs to be set. 

3. Press Trace Max to maximize the trace within the channel window. 

4. Press Trace Max again to restore the trace to its original size. 

6.2.6.2 Turning Off Graticule Label Display 

You can expand the display of the coordinate system by turning off the label display of the vertical 

coordinates. Follow the steps below. 
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1. Press Channel Next (or Channel Prev) to switch to the channel that needs to be set up. 

2. Press Display on the front panel to enter the Display menu. 

3. Press Graticule Label to toggle the ON/OFF status of the Graticule Label. 

6.3 Analysis and Processing of Measurement Data 

6.3.1 Analyzing Data by Marker 

6.3.1.1 About Marker Function 

The marker has the following uses: 

1. Reading the value of the measurement result (as an absolute value or a relative value to the 

reference point). 

2. Finding a specific point on a trace (marker search). 

3. Analyzing trace measurement results and calculating statistical data. 

4. Using the value of the marker to modify the stimulus as well as the scale. 

The TH2851 can display 10 markers on each trace, including the reference marker. Each marker has 

a stimulus value (the value corresponding to the X-axis of the coordinate system) and a response 

value (the value corresponding to the Y-axis of the coordinate system). 

6.3.1.2 Reading Marker Value on the Trace 

The user can read the marker value displayed on the trace, and the response value of the marker is 

always in the same format as the Y-axis. When the sweep range is set to 0, the stimulus value of the 

marker is displayed as the serial number of the current measurement point. When the Marker 

Function > Discrete is turned off, the marker can be moved between measurement points by 

interpolation. 

Open the marker on the trace according to the following steps: 

1. Press Channel Next (or Channel Prev) and Trace Next (or Trace Prev) to activate the 

channel and trace on which a marker is used. 

2. Press Marker to enter the Marker menu, press the marker button that needs to be opened to 

open the marker. The Marker button can be used to open or activate the marker. 

Move the marker according to the following steps: 

1. Press the button corresponding to the marker that needs to be moved and enter the new 

stimulus value. This enables you to move the position of the marker in the trace. 

2. When the marker is active, the marker can be moved by sliding your finger across the 
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screen. 

Close the marker according to the following steps: 

1． Press Marker to enter the Marker menu. 

2． Press Clear Markers, and then press the button corresponding to the marker that needs to 

be closed. 

6.3.1.3 Reading Relative Value with Respect to Reference Point 

The user can transform the marker value into a relative value with respect to the reference point. 

Set the reference marker according to the following steps: 

1. Press Marker to enter the Marker menu and press Ref Marker to open the reference 

marker. 

2. Move the reference marker to the position that needs to be set as a reference point. 

3. Activate the desired marker and move it to the desired position, the reading of the marker 

at this point is the value relative to the reference marker. 

Note: Pressing Marker → Ref Marker can automatically open the reference marker and moves it to 

the currently active marker position. 

6.3.1.4 Reading Interpolation between Actual Measurement Points/Measurement Points 

Depending on the setting of the measurement points in the marker function, the points that can be 

positioned by the marker on the trace will differ, as shown in the following table: 

Settings Description 

Turn ON discrete 

function 

The marker can only be positioned to the actual measurement point. A marker 

stimulus setting value is automatically positioned to the nearest measurement point if 

it is between measurement points. The marker that sets between measurement points 

with the discrete function OFF is automatically positioned to the nearest measurement 

point when this function is turned on. 

Turn OFF discrete 

function 

The marker positioning can be not limited to the actual measurement point but can be 

positioned between the measurement points and obtain the response value at that 

location by interpolation. 

 

Set the discrete mode according to the following steps: 

1. Press Channel Next (or Channel Prev) to switch to the channel that needs to be set up. 

2. Press Marker Function to enter the Marker Function menu. 

3. Press Discrete to toggle the mode switch. 
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6.3.1.5 Setting up Marker Couple between traces 

The marker can be set to move on all traces in the channel at the same time or on each trace 

individually. 

Settings Description 

Marker Couple ON The marker of the same number on all traces is set up and moved at the same time in 

the channel. 

Marker Couple OFF The marker on each trace is set up as well as moved individually. 

 

Change the marker couple switch according to the following steps: 

1. Press Channel Next (or Channel Prev) to switch to the channel that needs to be set up. 

2. Press Marker Function to enter the Marker Function menu. 

3. Press Couple and toggle the mode switch. 

6.3.2 Searching Specific Measurement Point on a Trace 

6.3.2.1 Overview 

The user can search for a specific measurement point that meets the user's criteria by using the 

Marker Search function. Marker Search allows the user to search for measurement points with the 

following criteria: 

Maximum value 

Minimum value 

Peak: contains positive peak (extreme values), negative peak (minimal values), the nearest peak to 

the left of the marker, and the nearest peak to the right of the marker. 

Multiple Peak 

Target: including the nearest target value to the marker, the nearest target value to the left of the 

marker, and the nearest target value to the right of the marker. 

Multiple Target 

6.3.2.2 Setting Search Range 

The Marker Search function allows the user to use part of the sweep range as search range (Partial 

Search function). 

Switch the Partial Search function ON and OFF according to the following steps: 

1. Press Channel Next (or Channel Prev) to switch to the channel that needs to be set up. 
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2. Press Marker Search to enter the Marker Search menu and press Search Range to enter the 

Search Range menu. 

3. Press Search Range State to toggle the ON/OFF status of the Search Range. 

Set the search range according to the following steps: 

1. Press Channel Next (or Channel Prev) to switch to the channel that needs to be set up. 

2. Press Marker Search to enter the Marker Search menu and press Search Range to enter the 

Search Range menu. 

3. Press Search Range to turn on the Search Range function. 

4. Press Start to enter the lower limit value of the search range. 

5. Press Stop to enter the upper limit value of the search range. 

6.3.2.3 Auto-Complete Search (Marker Tracking) 

The Marker Tracking feature automatically performs a search at the stop of each sweep cycle, even 

if the associated marker search button is not pressed. This feature allows the user to easily observe 

the measurement results, such as the maximum value of a trace. 

Switch the marker tracking function on/off according to the following steps: 

1. Press Channel Next (or Channel Prev) and Trace Next (or Trace Prev) to activate the 

channel and trace that need to be set up. 

2. Press Marker Search to access the Marker Search menu. 

3. Press Tracking to toggle the ON/OFF status of the tracking. 

6.3.2.4 Searching for Maximum and Minimum Values 

The user can search for the maximum and minimum value points on the measurement trace and 

move the marker to that point. 

Search for the maximum or minimum value point according to the following steps: 

1. Press Channel Next (or Channel Prev) and Trace Next (or Trace Prev) to activate the 

channel and trace that require the use of the marker. 

2. Activate the marker that needs to be used for searching for. 

3. Press Marker Search to access the Marker Search menu. 

4. Press Max or Min to complete the search. 
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6.3.2.5 Searching for Peak 

The Search Peak function allows the user to search for the peaks on a trace. 

Peaks are measurement points on the trace where the measured value is greater or less than two 

adjacent points on the left and right. Depending on the quantitative relationship between the 

measured value and the adjacent measurement points, the peaks can be classified into the following 

two categories: 

Positive That is, the maximal value, the measured value is greater than the adjacent measurement 

points on the left and right 

Negative That is, the minimal value, the measured value is less than the adjacent measurement 

points on the left and right 

 

The peak excursion is defined as the minimum difference (absolute value) between the measured 

value at the peak point and the measured value at the adjacent measurement point. 

There are three ways to find the peaks as follows: 

 

Search peaks Move the marker to the closest point that matches the search criteria 

Search left Move the marker to the closest point on the left that matches the search criteria 

Search right Move the marker to the closest point on the right that matches the search criteria 

 

Set up according to the following steps: 

1. Press Channel Next (or Channel Prev) and Trace Next (or Trace Prev) to activate the 

channel and trace that require the use of the marker. 

2. Activate the marker that needs to be used for searching for. 

3. Press Marker Search to enter the Marker Search menu and press Peak to enter the Peak 

menu. 

4. Press Peak Excursion to enter the desired peak excursion, a value that defines the 

minimum value of the difference between the peak point and the measured value of the 

adjacent measurement point. 

5. Press Peak Polarity and select the type of peak to search for (Both, Positive, Negative). 

6. Press the corresponding search button (Search Peak, Search Left, Search Right) to perform 

a peak search. 

6.3.2.6 Searching for Multiple Peaks 

Searching for multiple peaks allows the user to search for multiple peaks on a trace. The peak points 

and peak excursion are set in the same way as Search Peaks. When the TH2851 finds a peak point 

that meets the criteria, it automatically moves the marker to that point. Depending on the number of 
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peak points, markers 1-9 are sequentially arranged from the starting frequency order. Note that the 

reference point marker is not affected. 

Search for the multiple peaks according to the following steps: 

1. Press Channel Next (or Channel Prev) and Trace Next (or Trace Prev) to activate the 

channel and trace that require the use of the marker. 

2. Press Marker Search to enter the Marker Search menu and press Multiple Peaks to enter 

the Multiple Peaks menu. 

3. Press Peak Excursion to enter the desired peak excursion, a value that defines the 

minimum value of the difference between the peak point and the measured value of the 

adjacent measurement point. 

4. Press Peak Polarity and select the type of peak to search for (Both, Positive, Negative). 

5. Press Search Multi Peak to complete the multiple peaks search. 

6.3.2.7 Searching for Target Value 

The Search Target Value is a function that searches for the measurement point on the trace where the 

measurement value matches the target value and the trends of data change (Positive, Negative, 

Both), while moving the marker to that point. 

The target value point is the measurement point on the trace where the measured value is equal to 

the set target value. Depending on the trends of data change at the measurement point, it can be 

classified into two types: 

Target Transition Type 

(Positive) 

The data of the measurement point is greater than the data of the adjacent 

measurement point on the left 

Target Transition Type 

(Negative) 

The data of the measurement point is smaller than the data of the adjacent 

measurement point on the left 

 

TH2851 provides the following three ways to search for the target value: 

Search Target The marker moves to the measurement point where the nearest measured value is 

equal to the target value 

Search Left The marker moves to the measurement point on the left where the closest 

measurement value is equal to the target value 

Search Right The marker moves to the measurement point on the right where the closest 

measurement value is equal to the target value 

 

Find the target value according to the following steps. 

1. Press Channel Next (or Channel Prev) and Trace Next (or Trace Prev) to activate the 

channel and trace that require the use of the marker. 

2. Activate the marker that needs to be used for searching for. 
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3. Press Marker Search to enter the Marker Search menu and press Target to enter the Target 

menu. 

4. Press Target Value and input the target value that needs to be set up. 

5. Press Target Transition and select the target transition that needs to be set up. 

6. Press the corresponding search button (Search Target, Search Left, Search Right) to 

perform a target value search. 

6.3.2.8 Searching for Multiple Target Values 

Searching for Multiple Target Values allows the user to search for multiple target values on the trace. 

The target value point and target value are set to match the search target value. When the TH2851 

finds a target value point that meets the criteria, it automatically moves the marker to that point. 

Depending on the number of target points, markers 1-9 are sequentially arranged from the starting 

frequency order. Note that the reference point marker is not affected. 

Perform a multiple target value search according to the following steps. 

1. Press Channel Next (or Channel Prev) and Trace Next (or Trace Prev) to activate the 

channel and trace that require the use of the marker. 

2. Press Marker Search to enter the Marker Search menu and press Multi Target to enter the 

Multi Target menu. 

3. Press Target and input the target value that needs to be set up. 

4. Press Target Transition and select the target transition that needs to be set up. 

5. Press Search Multi Target to complete the search for multiple target values. 

6.3.3 Analyzing Equivalent Circuit and Simulate Frequency Characteristics 

6.3.3.1 Equivalent Circuit Analysis based on Measurement Results 

Perform the equivalent circuit analysis operation according to the following steps: 

1. To perform trace sweep with frequency as the stimulus value. 

2. Press Analysis > Equivalent Circuit > Select Circuit. 

3. Select the equivalent circuit model according to the following table: 

Equivalent Circuit Model Frequency Characteristics Example of DUT 
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A 

 

 

Inductor with high loss 

B 

 

 

Inductor, resistor 

C 

 

 

High value resistor 

D 

 

 

Capacitor 

E 

 

 

Resonator 

F 

 

 

Inductor with equivalent series 

resistance 

G 

 

 

Capacitor 

In the frequency characteristic plot in the above table, the measurement parameters are all |Z|-θz 

(deg), the sweep type is logarithmic sweep, the vertical coordinate of |Z| is the logarithmic axis, and 

the vertical coordinate of θz (deg) is the linear axis 

4. Press Calculate to perform equivalent circuit analysis calculation and the calculated 

parameters R1, C1, L1, R0, C0 are displayed in the corresponding input box. 

6.3.3.2 Simulating Frequency Characteristics based on Equivalent Circuit Parameters 

The frequency characteristics are simulated according to the following steps: 
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1. To perform trace sweep with frequency as the stimulus value. 

2. Press Analysis > Equivalent Circuit > Select Circuit. 

3. Select the equivalent circuit model. 

4. Press R1, C1, L1, R0, C0 to select and input the equivalent circuit parameters that need to 

be modified. 

Equivalent 

Circuit 

parameters 

Description 

R1 Resistance R1 in the equivalent circuit 

C1 Capacitance C1 in the equivalent 

circuit 

L1 Inductance L1 in the equivalent circuit 

C0 Capacitance C0 in the equivalent 

circuit model E 

R0 Capacitance R0 in the equivalent 

circuit model F, G  

 

5. Press Stimulate to toggle it to ON and complete the simulation of the frequency 

characteristics. 

6. Press Display to toggle it to ON, and the current equivalent circuit model and the values of 

the equivalent circuit parameters are displayed on the bottom left corner. 

7. Press Export to save the equivalent circuit parameters and model. 

6.3.4 Crystal Oscillator Analysis 

You can measure and analyze the performance of crystals such as piezoceramics, and obtain 

important parameters such as resonant frequency, anti-resonant frequency, and quality factor of the 

crystal after measurement and calculation. 

6.3.4.1 Opening Crystal Oscillator Analysis 

Set the crystal oscillator analysis switch state according to the following steps: 

1. To perform trace sweep with frequency as the stimulus value. 

2. Press Analysis > OSC Analysis. 

3. Press State to toggle the ON/OFF status. 

Crystal oscillator analysis is a frequency-based trace analysis and calculation, so this function can 

only be turned on when the sweep type is frequency mode (both linear and logarithmic frequencies 

are possible). 
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When the crystal oscillator analysis function is turned on, the instrument performs a measurement at 

a frequency of 1 kHz after each trace sweep cycle, and then analyzes and calculates each parameter 

based on the measurement results, which are displayed in the menu on the right. 

 

6.3.4.2 Setting Quality Factor Calculation Formula 

According to the actual situation, choose the formula for the quality factor Qm: 

1. To perform trace sweep with frequency as the stimulus value. 

2. Press Analysis > OSC Analysis > Q Equation. 

3. Select the corresponding formula button and press it to set up 

6.3.5 Trace Statistical Data 

The user can obtain statistical data on the trace, including range, mean, standard deviation, and 

peak-to-peak values. The statistics are defined as shown below, only for the trace between marker 1 

and 2, markers 1 and 2 are turned on automatically. 
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Statistical data 

element 

Description 

Range (span) Span between marker 1 and 2 

Mean value 

(mean)   
n is the number of measurement points between markers 1 and 2, and xi is the 

measurement value at the i-th measurement point 

Standard deviation 

(s.dev)   
n is the number of measurement points between markers 1 and 2, xi is the measurement 

value at the i-th measurement point, and mean is the average value 

Peak-to-peak (p-p) The difference between the maximum and minimum values between marker 1 and 

marker 2 

 

Switch the display of the statistics according to the following steps: 

1. Press Channel Next (or Channel Prev) and Trace Next (or Trace Prev) to activate the 

channel and trace that require the use of the marker. 

2. Press Marker Function to enter the Marker Function menu and press Statistics to switch to 

ON. 

3. Markers 1 and 2 are automatically turned on, move to the appropriate position, and the 

statistics are displayed on the upper left of the coordinate system. 
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6.3.6 Trace Limit Line 

The trace limit line feature allows the user to set a pass range for each trace and determine if the 

measurement results pass or fail. 

The user can add limit lines to certain intervals in the sweep range, which contain the upper and 

lower limits of the passing value. The measured value of the measurement point contained in the 

limit line must be between the upper and lower limits to be considered a pass point, and vice versa. 

If there is a fail point in the trace, the trace is judged to be a failure (Fail). 

6.3.6.1 Setting Limit Line 

Setting the limit line first needs to set a standard trace as a reference value, the upper and lower 

limits of the limit line is set up based on the setting of the reference trace, according to the following 

steps: 

1. To perform a measurement with a standard test piece to obtain a standard trace. 

2. Press Channel Next (or Channel Prev) and Trace Next (or Trace Prev) to activate the trace 

on which the limit test is used. 

3. Press Analysis > Limit Test to enter the Limit Test menu. 

4. Press Data→Reference to set the active trace as the reference value. 

After setting up the reference value, the button Edit Limit Line become available, press to enter the 

list limit test interface, and set up the limit line 

. 

1. Press Add to add a new limit line. 

2. Press the row where the limit line is located to enter the Limit Test menu. 
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3. Set the parameters in the limit line according to the following table: 

Limit Line Set 

Parameters 

Description 

Limit Type The types of upper and lower limits of the qualifying values in the limit line are selected as 

follows: 

ABS: the upper and lower limits are definite values. 

Dev: the upper and lower limits are the differences from the set reference trace. 

%: the upper and lower limits are percentages relative to the set reference trace. 

% Dev: the upper and lower limits are percentages of the difference with respect to the set 

reference trace. 

Begin Stimulus Starting value of the stimulus value on the limit line 

End Stimulus Ending value of the stimulus value on the limit line 

Upper Limit Upper limit of qualified measurements on the limit line, data type depends on the limit line 

type 

Lower Limit Lower limit of qualified measurements on the limit line, data type depends on the limit line 

type 

 

4. After setting up, you can export the set data to a file/import existing data from a file by 

using the Export/Import button. 

6.3.6.2 Proceeding Limit Line of Measurement Trace 

1. Press Analysis > Limit Test to enter the Limit Test menu. 

2. Press Limit Line to toggles it ON, and the limit line is displayed in the coordinate system. 

3. Press Limit Line to toggle it ON and start to perform the limit line of the current 

measurement trace. 

4. The limit line results are displayed at the position of the trace state above the coordinate 

system. 
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6.3.7 Trace Trails Comparison 

The trace trails comparison is for continuous measurement of many different DUT, all traces are 

displayed in the same coordinate system, and the trace trails under different measurement conditions 

can be compared. At the same time, different frequency points can be set up and the measured 

values of all traces at that frequency point can be calculated. 

 
 

Trace trails measurement steps: 

1. Press Parameter 1 and Parameter 2 to set the parameters that need to be measured, noting 

that modifying the measurement parameters can clear the measured traces and data. 

2. Press Log X and set the horizontal coordinate to logarithmic or linear axis, noting that 

modifying the axis can clear the measured trace and data. 

3. Set the start and stop frequencies, noting that setting the frequency can clear the measured 
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traces and data. 

4. Press Measure Once can perform a sweep and press Cancel Once can cancel the previous 

measurement trace. 

5. After completing the measurement, replace the DUT and press Measure Once again for the 

next measurement. 

6. Repeat steps 5 and 6 until the measurement is complete, up to 10 measurements (20 traces in 

total). 

7. Press Get Screen to save the current measurement image. 

 

Press Data tab at the top to switch to the data table and set the frequency point at which the data 

needs to be read, as follows: 

1. Press Add Line to add a new row to the trails table. 

2. Select the line and then, in the Frequency button, modify the frequency that needs to be read. 

3. Repeat steps 1 and 2 to complete the frequency setting. 

4. Press Calculate can calculate the measurement data for the corresponding frequency point 

based on the previously measured trace and display it on the data table. 

5. Press Export Data to export the measurement data from the data table to the hard disk. 

6.3.8 Marker Limit 

It is to set the reference value and upper and lower limits of marker limit for the marker in the trace 

scanning to judge whether its measurement value is within the set qualified range. 
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As shown is the interface of Marker Limit setting, which contains the limit parameters of maker 1-9 

on the 4 traces of the current channel (the reference marker cannot be sorted). 

Set the marker limit parameters according to the following steps: 

1. Press Channel Next (or Channel Prev) button to activate the channel for marker limit; 

2. Press Analysis > Marker Limit to enter the marker limit interface; 

3. Click the marker that needs to set the limit parameters, and set the parameters according to 

the following table: 

Parameter Description 

State The switch for this marker limit 

Type The type of the upper and lower limits with the following type options: 

Absolute value: the upper and lower limits are defined values; 

Deviation value: the upper and lower limits are differences from a set reference value; 

%: the upper and lower limits are percentages relative to a set reference value; 

% deviation: the upper and lower limits are a percentage of the difference with respect to a 

set reference value; 

Reference Reference value for qualified marker limit 

Upper Upper limit of qualified measurements on the limit line, data type depends on the limit line 

type 

Lower Lower limit of qualified measurements on the limit line, data type depends on the limit line 

type 

4. Return to the trace interface after the setting is completed, activate the marker that needs to be 

sorted, measure and complete limit, and query the limit result through the command; 

5. Limit setting interface can import and export limit results. 
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Chapter 7  Save and Recall 

7.1 Point Measurement 

7.1.1 Save 

Operation steps below to save point measurement settings: 

1. When in the point measurement interface, press Save/Recall on the front panel to enter 

Save/Recall menu, then click Save State to enter Save State menu. 

2. Select and click needed state to save settings. 

 

 

3. The specific key meanings are as follows: 

Key Description 

State 01~08 Save the setting status in the file corresponding to the serial number. 

Autorec 

Save the setting status in the auto save file. 

When Start From Setup of system setting is set to Auto, TH2851 will 

automatically save the device status on a regular basis. The saved file name 

is SaveData\PointAutorec.sta, and the automatically saved file will be 

overwritten.When the auto saved file can be detected during startup, it will 

be loaded. 

UserPres 

Save the setting status in the user saved file. 

The user saved file can be used to start loading or initialization. It needs to 

be changed in the system settings. 

File Customize the save location and file name. 
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------------------------------------------------------------------------------------------------------------------------ 

NOTE: If the key name is marked with "*", it means that there is a saved file in the save field. Click 

this button to prompt whether to overwrite the existing file, and click OK to save and overwrite it. 

------------------------------------------------------------------------------------------------------------------------ 

7.1.2 Recall 

Operation steps below to load point measurement settings: 

1. When in the point measurement interface, press Save/Recall on the front panel to enter 

Save/Recall menu, then click Recall State to enter Recall State menu. 

2. Select and click needed state to load settings. 

 

3. If a saved file exists in State01~08/Autorec/UserPres, the corresponding key will be available, 

and click the key to load the saved file. 

4. If you need to load a saved file with any name at any location in the hard disk, click Recall 

State, select the needed file to load in the pop-up window, and press open to load it. 

7.1.3 Screen Capture 

Operation steps below to save screenshot: 

1. When in the needed interface, press Save/Recall on the front panel to enter Save/Recall menu, 

then click Dump Screen Image to pop up window. 

2. Locate the location to be saved in the navigation window, enter an appropriate file name, and 

save the picture. 

3. This function can also be achieved by click Dump Screen Image on System menu. 
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7.2  List Measurement 

Operation steps below to save list settings: 

1. When in the point/list measurement interface, press Save/Recall on the front panel to enter 

Save/Recall menu, then click Export List Data to pop up save window. 

2. Locate the location to be saved in the navigation window, enter an appropriate file name, and 

save the file. 

 

3. The default file format for export is .csv. 

4. The saved file format as shown below: 
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7.3 Comparator 

7.3.1 Save 

Operation steps below to save sorting settings: 

1. When in Comparator Table interface, press All Tables on Comparator Table menu to enter 

All Tables menu, then click Export All to pop up save window. 
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2. Locate the location to be saved in the navigation window, enter an appropriate file name, and 

save the file. 

3. The default file format for export is .pbi. 

7.3.2 Load 

Operation steps below to save list settings: 

1. When in the comparator setting interface, press All Tables on Comparator Table menu to 

enter All Tables menu, then click Import All to pop up save window. 

2. Select needed file in the navigation window, and press open to load the file. 

7.4 Sweep 

Click Sweep on Point Root menu to enter Sweep Root menu,then click Save/Recall on Sweep 

Root menu or press Save/Recall button on the front panel to enter Save/Recall menu. 

 

 

7.4.1 State 

Save the relevant data in a file and reload it later. 

The save mode is as follows: 

Save Type Description 

State Only Only save settings of Sweep 

State & Trace Save settings and measurement data 
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The save data mode is as follow: 

Channel/Trace Description 

Display Only Only save relevant data currently displayed 

All Save relevant data of all channels and traces 

7.4.1.1 Save 

The pairs of Save Type and Channel/Trace are as follow: 

1. Save Type is State Only and Channel/Trace is Display Only. That means saving only the 

settings of the currently displayed channels and traces. 

2. Save Type is State Only and Channel/Trace is all. That means saving only the settings of all 

channels and traces. 

3. Save Type is State & Trace and Channel/Trace is Display Only. That means saving the 

settings and measurement data of the currently displayed channels and traces. 

4. Save Type is State & Trace and Channel/Trace is all. That means saving the settings and 

measurement data of all channels and traces. 

 

Operation steps below to save state: 

1. When in the sweep interface, press Save/Recall on the front panel to enter Save/Recall menu, 

then click Save State to enter Save State menu. 

2. Select and click needed state to save settings. 

3. The specific saving method is the same as that of point measurement (See 7.1.1 for 

details). 

7.4.1.2 Load 

The specific loading method is the same as that of point measurement (See 7.1.2 for details). 

7.4.2 Channel 

TH2851 allows the user to save/load the setting status of a channel separately. This function allows 

the user to save the state of the activated channel to one of the four positions (A-D) separately, and 

then load the stored settings after activating the other channel. This function is very convenient for 

copying status between channels. It should be noted that, unlike the state of saving the whole trace 

sweep, this function saves the data in the memory as a temporary file, so once the power is off or the 

program is closed, the stored data will be lost. 

7.4.2.1 Save 

Operation steps below to save channel settings: 

1. When in the sweep interface, press Channel Next or Channel Prev on the front panel to 

switch to the channel to be saved. 
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2. Press Save/Recall on the front panel to enter Save/Recall menu, then click Save Channel to 

enter Save Channel menu. 

3. Select and click needed key to save settings. 

------------------------------------------------------------------------------------------------------------------------ 

NOTE: If the key name is marked with "*", it means that there is a saved file in the save field. Click 

this button to prompt whether to overwrite the existing file, and click OK to save and overwrite it. 

------------------------------------------------------------------------------------------------------------------------ 

7.4.2.2 Load 

Operation steps below to load channel settings: 

1. When in the sweep interface, press Channel Next or Channel Prev on the front panel to 

switch to the channel to be loaded. 

2. Press Save/Recall on the front panel to enter Save/Recall menu, then click Recall Channel to 

enter Recall Channel menu. 

3. Select and click needed key to load settings. 

7.4.2.3 Clear 

Operation steps below to clear channel settings: 

1. When in the sweep interface, press Save/Recall on the front panel to enter Save/Recall menu, 

then click Save Channel to enter Save Channel menu. 

2. Click Clear States to clear all channel save files. 

7.4.3 Trace Data 

Operation steps below to save trace data: 

1. When in the sweep interface, press Channel Next or Channel Prev on the front panel to 

switch to the channel to be saved. 

2. Press Save/Recall on the front panel to enter Save/Recall menu, then click Save Trace Data 

to enter Save Trace Data menu. 

3. Click Scope to select the scope of trace to save: 

Scope Description 

Single Save only the currently active trace 

Channel Save all traces in the currently active channel 

Displayed Save all visible traces in all visible channels 

 

4. After selecting the scope, click Save Trace Data on Save Trace Data menu to pop up save 

window. 

5. Locate the location to be saved in the navigation window, enter an appropriate file name, and 

save the file. 
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Chapter 8  System Setup 

8.1 System Calibration 

System calibration is the various calibrations performed on the TH2851 before the device leaves the 

factory, and system calibration directly affects the measurement accuracy of the TH2851. A 

password is required to enter the system calibration interface, and in principle, users are prohibited 

from entering this interface. 

8.2 Language Settings 

TH2851 can set different language environment according to user requirements. After setting the 

language, the software interface is displayed in the set language text. Currently, TH2851 supports 

Chinese and English settings. 

Set the software language according to the following steps: 

1. Press System on the front panel to enter the System menu. 

2. Press Language Set to enter the Language Set menu and press the button corresponding to 

the language you need to set to complete the setting. 

8.3 System Test 

The system test is a functional test of some of the TH2851's hardware in software, and the test 

results are displayed on the screen. 



 111 

8.3.1 Front Panel Test 

 
 

The front panel test is a test of the TH2851 front panel keys. The front panel keys are displayed 

graphically in this interface. When the test is performed, if the key function is normal after pressing 

the key, a green tick √ will be displayed on the upper right corner of the corresponding key graphic 

in this interface, indicating that the test is passed. At the same time, after entering this interface, the 

keys with background lights on the front can light up and turn off the background lights 

intermittently. 

Perform the front panel test according to the following steps: 

1. Press System on the front panel to enter the System menu. 

2. Press Test > Front Panel Test to perform the front panel test. 

8.3.2 Handler Test 

The Handler test is a test of the TH2851's Handler function. 
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The Handler corresponding to the gray/green indicator in the interface can switch between high and 

low levels. When the indicator is switched from gray to green by Pressing on it, the corresponding 

Handler can issue a command to set the level to high; when the indicator is switched from green to 

gray by Pressing on it, the corresponding Handler can issue a command to set the level to low. 

Pressing the Start Test button can automatically cycle through all Handlers in order. 

Enter the Handler test according to the following steps: 

1. Press System on the front panel to enter the System menu. 

2. Press Test > Handler Test to perform the Handler test. 

8.4 Preset 

You can restore the setting state of the TH2851 to its initial state. Depending on the options in the 

initialization settings, the instrument can be restored to the factory state or to a user-saved state. 

Follow the steps below: 

1. Press System on the front panel to enter the System menu. 

2. Press Preset to start the preset operation. 

8.5 System Information and Software Updates 

The system information page displays the current instrument information of the TH2851, including 

product name, measurement frequency range, manufacturer, software version number, serial number, 

MAC address, IP address, etc., and allows for software updates. 

Open the system information screen according to the following steps: 
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1. Press System on the front panel to enter the System menu. 

2. Press Info button to open the System Information screen. 

3. The system IP address, only when the LAN port is connected, is displayed with the normal 

setting value, otherwise the default display is 127.0.0.1. 

Press Update link on the lower left corner to update the software. Select the software update 

package on the pop-up window and open it. The software is closed and updated automatically and 

will start automatically after the update is completed. 

8.6 Misc Setup 

8.6.1 GPIB Setup 

Set and modify the address of the GPIB: 

1. Press System on the front panel to enter the System menu. 

2. Press Misc Setup to access the Misc Setup menu. 

3. Press GPIB Setup, enter the new address in the input box and press x1 to finish the 

modification. 

8.6.2 Network Setup 

You can set up the network parameters of the TH2851 and switch the network connection on and off. 

The modified settings can only take effect after the software is restarted. 

1． Press System on the front panel to enter the System menu. 

2． Press Misc Setup to access the Misc Setup menu. 

3． Press Network Setup to make changes. 

8.6.3 Serial Port Setup 

Set the baud rate of the serial port of the TH2851. 

1. Press System on the front panel to enter the System menu. 

2. Press Misc Setup to access the Misc Setup menu. 

3. Press Serial Port Setup to select and modify the baud rate. 

8.6.4 Preset Setup 

You can modify the preset setup of the TH2851. When the preset is performed, you can restore to 
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factory settings or user settings. If the user settings file does not exist, only the factory settings can 

be restored. It is also possible to set whether a secondary confirmation is required when the preset 

setup is performed: 

1. Press System on the front panel to enter the System menu. 

2. Press Misc Setup to access the Misc Setup menu. 

3. Press Preset Setup to set up. 

8.6.5 Startup Setup 

Setting the state loading performed by the TH2851 at startup can be set to factory setting/user 

setting/auto setting. When set to factory settings, the system automatically loads the factory settings 

when powering up; when set to user settings, the system loads the user settings file (if the file exists) 

when powering up; when set to auto settings, the system loads the auto settings file (if the file exists) 

when powering up. When the startup setup is set to auto setting, the status setting file can be saved 

automatically every time during the software operation. If there is no relevant file when the software 

is started after user setting or auto setting is selected, it will be started with factory settings. 

Set up according to the following steps: 

1. Press System on the front panel to enter the System menu. 

2. Press Misc Setup to access the Misc Setup menu. 

3. Press Start up Setup to set up. 

8.6.6 Start Form Setup 

Set up the measurement interface that the TH2851 enters by default when the TH2851 starts up. It 

can be set to single point measurement / list measurement / trace sweep interface. 

Set up according to the following steps: 

1. Press System on the front panel to enter the System menu. 

2. Press Misc Setup to access the Misc Setup menu. 

3. Press Start Form Setup to make the settings. 

8.6.7 Key Lock 

The front panel or touch screen can be temporarily locked to prevent maloperation during remote 

operation. 

1． Press System on the front panel to enter the System menu. 

2． Press Misc Setup to access the Misc Setup menu. 
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3． Press Key Lock to set it up. 

8.6.8 Handler Setup 

Set up and modify the Handler output rules of TH2851. 

8.6.8.1 Effective Level Setup 

Set the effective output level of Handler, when set to high, the output is ON when it is high; when 

set to low, the output is ON when it is low. 

1． Press System on the front panel to enter the System menu. 

2． Press Misc Setup to access the Misc Setup menu. 

3． Press Handler Setup to enter the Handler Setup menu. 

4． Press Affective Level to toggle the Effective Level setup. 

8.6.8.2 Signal Type Setup 

Set the output signal of the Handler as a level signal or a pulse signal: 

1. Press System on the front panel to enter the System menu. 

2. Press Misc Setup to access the Misc Setup menu. 

3. Press Handler Setup to enter the Handler Setup menu. 

4. Press Signal Type to switch the Signal Type setup. 

8.6.8.3 Pulse Width Setup 

Set the pulse width when the output signal of Handler is a pulse signal, and the valid range of pulse 

width is 1ms-1000ms. 

1. Press System on the front panel to enter the System menu. 

2. Press Misc Setup to enter the Misc Setup menu. 

3. Press Handler Setup to enter the Handler Setup menu. 

4. Press Pulse Width (ms) and enter the pulse width that needs to be set up. 

8.6.8.4 Supply Voltage Setup 

Set the supply voltage of the Handler to Internal or External: 

1. Press System on the front panel to enter the System menu. 
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2. Press Misc Setup to access the Misc Setup menu. 

3. Press Handler Setup to enter the Handler Setup menu. 

4. Press Supply Voltage to switch the Supple Voltage setup. 

8.6.9 Beeper 

Set whether the buzzer sounds when a front panel button or a button in the menu bar is pressed. 

1. Press System on the front panel to enter the System menu. 

2. Press Misc Setup to access the Misc Setup menu. 

3. Press Beeper to switch the beeper ON/OFF status. 
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Chapter 9  Programming Commands 

9.1 Remote Control 

9.1.1 Types of Remote Control 

Depending on the system controller and the interface, the user can choose the types of 

remote-control system shown in the following table (after starting remote control, the front panel 

and screen will be locked and unlocked by pressing the Help key). 

System Controller Interface Summarize 

External controller (external 

computer, such as the PC or 

workstation) 

GPIB Connecting an external controller to the 

TH2851 via GPIB 

LAN Connecting an external controller to the 

TH2851 via LAN 

USB Connecting an external controller to the 

TH2851 via USB 

RS232 Connecting an external controller to the 

TH2851 via RS232 

9.1.1.1 GPIB Remote Control System 

GPIB (General Purpose Interface Bus) is an interface standard used to connect computers to 

peripheral devices that conform to IEEE 488.1, IEC-625, IEEE 488.2 and JIS-C1901 international 

standards. The GPIB interface enables the user to control the TH2851 from an external computer. 

The computer sends commands and commands to the TH2851 and receives data sent from the 

TH2851 via GPIB. 

9.1.1.2 LAN (Local Area Network) Remote Control System 

The TH2851 and the external controller are connected via LAN (Local Area Network) and the 

TH2851 is programmed and controlled using SCPI commands after connection. 

In the control system utilizing SCPI commands, communication between the external controller 

(client) and the TH2851 (server) is performed using the SICL-LAN protocol. Using SICL (Standard 

Instrument Control Program Library), the user can control the TH2851 by programming using SICL 

or VISA, in the UNIX environment using the C language, or in the Windows environment, the 

programming environment such as Visual C++ and Visual Basic language are used. 

When using LAN for remote control, you need to set the network environment of the TH2851 first. 

Set up the network environment of the TH2851 according to the following steps: 

1. Press System on the front panel to enter the System Setup menu. 
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2. Click Misc Setup > Network Setup to open the Network Setup menu 

3. Click Enable to set the network status of the TH2851 to ON. 

4. Click Network Config to bring up the system's Network Setup window and set the system's 

IP address. 

5. When you have finished making changes, click Return and the TH2851 will pop up a 

dialog box prompting that the software needs to be restarted to enable the settings, click 

OK to restart. 

6. On the device to be connected, set the IP address to the same network segment as the 

TH2851 and the port number to 5025, then connect the TH2851. 

9.1.1.3 USB and RS232 Remote Control System 

The TH2851 is controlled by programming the TH2851 through the RS232 serial port connected to 

the TH2851 and the external controller. The USB control system is using USB as a serial port. 

Modify the baud rate of the TH2851 serial communication protocol according to the following 

steps: 

1. Press System on the front panel to enter the System Setup menu. 

2. Click Misc Setup > Serial Port Setup to open the Serial Port Setup menu. 

3. Click the button corresponding to the baud rate to be set to complete the setting. 

9.1.2 About the SCPI Commands 

9.1.2.1 Type of Commands 

The following two groups of commands are available for the TH2851: 

TH2851 Commands: The TH2851-specific commands include all the measurement functions that 

the TH2851 has and some general-purpose functions. The commands in this group are arranged in a 

hierarchical structure, which is called the command tree. Each command consists of character 

strings (mnemonics) indicating each hierarchical level and the colon separators between the 

hierarchical levels. 

IEEE Common Commands: Commands that relate to the generic functions defined in the IEEE 

488.2 standard and are commonly available to instruments that support this standard. The 

commands in this group all begin with an asterisk (*) and the commands in them are not arranged in 

the hierarchical structure. 

9.1.2.2 The Concept of Command Trees 

The commands at the top of the command tree are called "root command" or simply "root". To 
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access lower-level commands in the tree, the user specifies a dedicated path in the DOS file system, 

such as the directory path. When the PC is powered on or restarted, the current path is set to the root 

command. The following describes changing the path setting using special characters in the 

message: 

End-of-message symbol: The end-of-message symbol, such as the <new line> character sets the 

current path to the root command. 

Colon: a colon between two command mnemonics lowers the level of the current path in the 

command tree. A colon used as the first character of a command specifies the command mnemonic 

that are located below the root command. 

Semicolon: The semicolon does not change the current path but is used to distinguish between two 

commands in the same message. 

9.1.2.3 Grammar of the Message 

This section describes the grammar for sending program messages over the GPIB. Program 

messages are messages that the user sends from the external controller to the instrument for 

controlling the instrument. A program message consists of one or more commands and their 

necessary parameters. 

Program Message End Symbol: A program message must end with one of the following three 

program message end symbols: <newline>, <^END> or <newline><^END>. <^END> indicates that 

the EOI on the GPIB interface is activated immediately after the previous data byte is sent. For 

example, the OUTPUT command on HTBasic automatically sends the end-of-message symbol 

when the last data byte has been sent. When programming, use '\n' (0x0a in hex) as the end symbol. 

Parameters: A space (ASCII code: 32) needs to be added between the command and its first 

parameter. When sending several parameters in a single command, each parameter should be 

separated by a comma. 

Messages containing multiple commands: when sending two or more commands in a single 

message, the commands are separated by a semicolon. 

9.1.3 Programming Examples 

The programming language of the programming example is c#. In the example, command is the 

command variable to be sent, data is the return data variable to be read, SendData is the command 

send function, and ReadData is the get return data function. Users can refer to the example and 

modify the command according to their actual situation. 

9.1.3.1 Single Point Measurement 

Set the measurement frequency to 1MHz, the measurement speed to 1, the measurement level 

to 200mV, the averaging times to 1, the AC range to auto range, the measurement parameters set to 
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|Z|,θ z(deg), R, X, perform one trigger and read the measurement data as follows: 

string command = ":TRIG:SOUR BUS" + '\n'; 

SendData(command); 

command = ":FREQ 1E6;:APER 1;:VOLT 0.2;:AVER:COUN 1;:FUNC:IMP:RANG AUTO" + 

'\n'; 

SendData(command); 

command = ":FUNC:PAR1:FORM Z; :FUNC:PAR2:FORM TZD; :FUNC:PAR3:FORM 

R; :FUNC:PAR4:FORM X" + '\n'; 

SendData(command); 

Thread.Sleep(100); 

SendData("*TRG" + '\n'); 

string data = ReadData(); 

9.1.3.2 List Measurement 

Set the number of points in the list to 10 and the frequency of each point to 1MHz, 

2MHz ......10MHz in that order, followed by a trigger and read the measurement data: 

string command = ":LIST:TRIG BUS" + '\n'; 

SendData(command); 

command = ":LIST:POIN 10" + '\n'; 

SendData(command); 

command = ""; 

for(int i = 0; i < 10; i++) 

{ 

double freq = 1000000 * (i + 1); 

command += ":LIST:FREQ" + (i + 1) + " " + freq; 

if(i ! = 9) command += ";"; 

else command += '\n'; 

} 

SendData(command); 

Thread.Sleep(100); 

SendData("*TRG" + '\n'); 
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string data = ReadData(); 

9.1.3.3 Trace Sweep 

The system is initialized, and then the number of trace points for channel 1 is set to 100, the 

start frequency to 100 kHz, the end frequency to 1 MHz, the measurement speed to 3, and the 

number of single point averages to 1. Then a trigger is performed, and the R and X values for each 

measurement point are read after completing one measurement cycle: 

string command = ":SYST:PRES" + '\n'; 

SendData(command); 

Thread.Sleep(500); 

command = ":TRIG:SOUR BUS" + '\n'; 

SendData(command); 

command = ":SENS1:SWE:POIN 100;:SENS1:APER 3;:INIT1:CONT 1" + '\n'; 

SendData(command); 

Thread.Sleep(50); 

command = ":SENS1:FREQ:STAR 1E5;:SENS1:FREQ:STOP 1E6" + '\n'; 

SendData(command); 

Thread.Sleep(50); 

command = ":TRIG:SING" + '\n';; 

Thread.Sleep(100); 

string data = ""; 

while(data ! = "+1\n") 

{ 

SendData("*OPC?" + '\n'); 

data = ReadData(); 

} 

command = ":CALC1:DATA:RDAT?" + '\n' 

SendData(command);  

data = ReadData(); 
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9.2 Command Reference 

9.2.1 Symbolic Conventions 

This section describes the symbolic conventions of the commands in this chapter and how the 

command reading should be performed. 

9.2.1.1 Command Type 

The section headed "Types of Commands" describes the types of commands which there are 

three main types: 

Command/Query: can be used to set parameters or to query them. 

Command: only be used to set parameters. 

Query: only be used to query parameters. 

9.2.1.2 Syntax 

The section headed "Syntax" is the syntax used to send commands from the external controller 

to the TH2851. The syntax consists of a command part and a parameter part. These two parts are 

separated by the space. 

If there are several parameters, a comma is used as a separator between adjacent parameters. 

Ellipsis (...) between commas indicates omitted parameters. For example, < number 1 >, ..., < 

number 4 > denotes four parameters, i.e., < number 1 >, < number 2 >, < number 3 >, and < number 

4 >. 

String-type parameters, < string >, < string1 >, etc. Also, < block > represents data in block 

format data. 

The user can omit the lowercase letters in syntax. For example, “ :BIAS:CURRent " can be 

shortened as: "BIAS:CURR". 

The definition of the symbols used in the syntax is shown below: 

<> The characters in the angle brackets are the necessary parameters for sending the command. 

[] The part in the square brackets can be omitted. 

{} The characters in the curly brackets indicate that the user must select one of the bracketed 

characters. Each character option is separated by a vertical bar {|}. 

For example, "BIAS:CURR 0.001", ":BIAS:CURRENT:LEVEL 1E-3", etc. can be used in the 

following syntax: 

Syntax: BIAS:CURRent[:LEVel] <numeric> 
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9.2.1.3 Description 

The section headed "Description" describes the use of the command or the operation performed 

by the command. 

9.2.1.4 Parameters 

The section titled "Parameters" describes the necessary parameters when sending the command. 

When the parameter is a numeric type or string type in <>, the definition of the parameter, the 

allowable value range, the preset (factory-set) value, etc. are given, and when the parameter is a 

selection type in {}, the description of each selection item is given. 

9.2.1.5 Examples 

A brief example is provided to the usage of the command 

9.2.1.6 Query Response 

The section titled "Query Response" describes the format of the reading return data when the 

command contains a query. 

Each parameter that can be read is contained in curly brackets {}, and if the curly brackets 

contain multiple parameters separated by vertical bars (|) at points, only one parameter can be read 

at a time. 

When several parameters are read, they are separated by a comma (,). Ellipsis (...) between the 

commas indicates omitted parameters. For example, < number 1 >, ..., < number 4 > denotes four 

parameters, i.e., < number 1 >, < number 2 >, < number 3 >, and < number 4 >. 

<newline><^END> represents the end of the program message. 

9.2.1.7 Related Keys 

The section titled "Related Keys" indicates the operation of the front panel keys and menu 

buttons that have the same effect as this command. 

9.2.2 Commonly Used Standard Commands 

9.2.2.1 *IDN 

Command Type: Query 

Syntax: *IDN? 
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Description: Get product information (manufacturer, model number, product serial number, etc.) 

of the TH2851 

Query Response: {text 1}, {text 2}, {text 3} <newline><^END> 

Text 1: Manufacturer, the default display is "Tonghui Electronic CO., LTD." 

Text 2: Product name and model number, the default product name is " TH2851 " 

Text 3: Product serial number 

Related keys: System > Info 

9.2.2.2 *OPC 

Command Type: Query 

Syntax: *OPC? 

Description: Read "+1" after all operations are complete, otherwise read "0" 

Query Response: {+1|0} < newline><^END> 

Related keys: None 

9.2.2.3 *RST 

Command Type: Command 

Syntax: *RST 

Description: Preset the instrument to the factory state, this command is different from the 

command: SYSTem:PREset 

Related keys: Preset 

9.2.2.4 *TRG 

Command Type: Command 

Syntax: *TRG 

Description: Perform a trigger. When the current measurement mode is point measurement or 

list sweep, the measurement result will be returned at the end of the measurement; when the current 

measurement is sweep mode, the trigger source is required to be set to Bus. 

Related keys: Trigger 
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9.2.3 Public Commands 

Public commands can be responded to at all measurement interfaces. 

9.2.3.1 :CORRECTION 

 :CORR:CLE 

Command Type: Command 

Syntax:  

:CORRection:CLEar 

Description: Initialize data for all user calibration points 

 

:CORR:LOAD 

Command Type: Command 

Syntax: [:SENSe]:CORRection:LOAD[:EXECute] 

Description: Perform load calibration for all frequency points 

Related Keys: Cal > Load > ALL Frequency Load 

 

 :CORR:LOAD:{R|C|L} 

Command Type: Command/Query 

Syntax: 

[:SENSe]:CORRection:LOAD: {R|C|L} <number> 

[:SENSe]:CORRection:LOAD: {R|C|L}? 

Description: Set or query the resistance/capacitance/inductance setting value of the load 

calibration 

Query Response: {< number>} <newline><^END> 

Related keys: Cal > Load > Load Resistance / Load Capacitance / Load Inductor 

 

 :CORR:LOAD:STAT 

Command Type: Command/Query 

Syntax: 
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[:SENSe]:CORRection:LOAD:STATe {ON|OFF|1|0} 

[:SENSe]:CORRection:LOAD:STATe? 

Description: Set or query the on-off state of the user load calibration  

Parameters: 

Parameter Selection Option 

Description Load calibration 

switch 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value ON 

 

Examples: 

Turn on the load calibration:  

:CORR:LOAD:STAT ON 

Query the load calibration open state:  

:CORR:LOAD:STAT? 

Query Response: {1|0}< newline><^END> 

Related keys: Cal > Load 

 

 :CORR:LOAD:TYPE 

Command Type: Command/Query 

Syntax: 

[:SENSe]:CORRection:LOAD:TYPE 

{RX|CPD|CPQ|CPG|CPRP|CSD|CSQ|CSRS|LPD|LPQ|LPG |LPRP|LSD|LSQ|LSRS| 

ZTD|ZTR|GB|YTD|YTR} 

 [:SENSe]:CORRection:LOAD:TYPE? 

Description: Set and query the parameters used for load calibration 

Parameters: 

Parameter Selection Option 

Description Load calibration 

parameter 

Data Type Character string type 

(String) 
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Range RX: R~X 

CPD: Cp~D 

CPQ: Cp~Q 

CPG: Cp~G 

CPRP: Cp~Rp 

CSD: Cs~D 

CSQ: Cs~Q 

CSRS: Cs~Rs 

LPD: Lp~D 

LPQ: Lp~Q 

LPG: Lp~G 

LPRP: Lp~Rp 

LSD: Ls~D 

LSQ: Ls~Q 

LSRS: Ls~Rs 

ZTD: |Z|~θ z(deg) 

ZTR: |Z|~θ z(rad) 

GB: G~B 

YTD: |Y|~θ y(deg) 

YTR: |Y|~θ y(rad) 

Preset Value RX 

 

Examples: 

Set the load calibration parameter to Cp~D:  

:CORR:LOAD:TYPE CPD 

Query the load calibration parameter:  

:CORR:LOAD:TYPE? 

Query Response: 

{RX|CPD|CPQ|CPG|CPRP|CSD|CSQ|CSRS|LPD|LPQ|LPG|LPRP|LSD|LSQ|LSRS| 

ZTD|ZTR|GB|YTD|YTR}< newline><^END> 

Related keys: Cal > Load Type 

 

 :CORR:OPEN 

Command Type: Command 

Syntax: [:SENSe]:CORRection:OPEN[:EXECute] 

Description: Open clear for all frequency points 

Related keys: Cal > Open > All Frequency Clear 
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 :CORR:OPEN:STAT 

Command Type: Command/Query 

Syntax: 

[:SENSe]:CORRection:OPEN:STATe {ON|OFF|1|0} 

[:SENSe]:CORRection:OPEN:STATe? 

Description: Set and query the on-off state of the user open calibration  

Parameters: 

Parameter Selection Option 

Description Open calibration 

switch 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value ON 

 

Examples: 

Turn on the open calibration:  

:CORR:OPEN:STAT ON 

Query the open calibration open state:  

:CORR:OPEN:STAT? 

Query Response: {1|0}< newline><^END> 

Related keys: Cal > Open 

 

 :CORR:SHOR 

Command Type: Command 

Syntax: [:SENSe]:CORRection:SHORt[:EXECute] 

Description: Short clear for all frequency points 

Related keys: Cal > Short > All Frequency Clear 

 

 :CORR:SHOR:STAT 

Command Type: Command/Query 

Syntax: 
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[:SENSe]:CORRection:SHORt:STATe {ON|OFF|1|0} 

[:SENSe]:CORRection:SHORt:STATe? 

Description: Set and query the on-off state of the user short calibration  

Parameters: 

Parameter Selection Option 

Description Short calibration 

switch 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value ON 

 

Examples: 

Turn on the short calibration:  

:CORR:SHOR:STAT ON 

Query the short calibration open state:  

:CORR:SHOR:STAT? 

Query Response: {1|0}< newline><^END> 

Related keys: Cal > Short 

 

 :CORR:SPOT{1-20}:FREQ 

Command Type: Command/Query 

Syntax: 

[:SENSe]:CORRection:SPOT{1-20}:FREQ < number > 

[:SENSe]:CORRection:SPOT{1-20}:FREQ? 

Description: Query and set the frequency of the specified user calibration point 

Parameters: 

Parameter Numerical value 

Description Calibration point 

frequency 

Data Type Double precision type 

(double) 

Range 10Hz - 130MHz 

Preset Value 1000Hz 
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Examples: 

Set the frequency of point 1 to 1MHz:  

:CORR:SPOT1:FREQ 1M 

Query the frequency of point 2:  

:CORR:SPOT2:FREQ? 

Query Response: {< number>}<newline><^END>  

 

 :CORR:SPOT{1-20}:LOAD 

Command Type: Command 

Syntax: [:SENSe]:CORRection:SPOT{1-20}:LOAD[:EXECute] 

Description: Perform the load calibration for the specified user calibration point 

 :CORR:SPOT{1-20}:LOAD:STAN 

Command Type: Command/Query 

Syntax: 

[:SENSe]:CORRection:SPOT{1-20}:LOAD:STANdard <number1>,<number2> 

[:SENSe]:CORRection:SPOT{1-20}:LOAD:STANdard? 

Description: Set and query the load reference value of the specified user calibration point 

Parameters: 

Parameters < Number 1 > < Number 2 > 

Description Load reference value 1 Load reference value 2 

Data Type Double precision type 

(double) 

Double precision type 

(double) 

Range -1E15 - 1E15 -1E15 - 1E15 

Preset Value 0 0 

Unit Depends on load 

parameter settings 

Depends on load 

parameter settings 

 

Examples: 

Set the LOAD reference value of point 1:  

:CORR:SPOT1:LOAD:STAN 1E6,1E6 

Query the LOAD reference value of point 2:  

:CORR:SPOT2:LOAD:STAN? 
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Query Response: {< number1>, < number2> }<newline><^END> 

The parameters of the return value depend on the set load parameters 

 

 :CORR:SPOT{1-20}:OPEN 

Command Type: Command 

Syntax: 

[:SENSe]:CORRection:SPOT{1-20}:OPEN[:EXECute] 

Description: Perform open circuit clear for the specified user calibration point 

 

 :CORR:SPOT{1-20}:SHOR 

Command Type: Command 

Syntax: 

[:SENSe]:CORRection:SPOT{1-20}:SHORt[:EXECute] 

Description: Perform short circuit clear for the specified user calibration point 

 

 :CORR:SPOT{1-20}:STAT 

[:SENSe]:CORRection:SPOT{1-20}:STATe {ON|OFF|1|0} 

[:SENSe]:CORRection:SPOT{1-20}:STATe? 

Description: Set and query the on-off state of the specified user calibration point 

Parameters: 

Parameter Selection Option 

Description User calibration point 

switch 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value ON 

 

Examples: 

Turn on the point 1 switch:  

:CORR:SPOT1:STAT ON 

Query the on-off state of point 2:  
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:CORR:SPOT2:STAT? 

Query Response: {1|0}< newline><^END>  

 

 :CORR:USE:DATA? 

Command Type: Query 

Syntax: [:SENSe]:CORRection:USE:DATA? 

Description: Query the calibration data of all user calibration points 

Query Response: {< number 1> },{< number 1> },...,{< number 120> }<newline><^END> 

A total of 20 user calibration points is returned for a total of 120 data, in the order of open 

circuit calibration data G, open circuit calibration data Cp, short circuit calibration data R, short 

circuit calibration data Ls, load calibration data 1, load calibration data 2. The type of load 

calibration data depends on the parameters that have been set for the load calibration. 

 

 :CORR2:COLL:ACQ:LOAD 

Command Type: Command 

Syntax: [:SENSe]:CORRection:COLLect:ACQuire:LOAD 

Description: Perform load calibration for all frequency points 

Related Keys: Cal > Load > All Frequency Load 

 

 :CORR2:COLL:ACQ:OPEN 

Command Type: Command 

Syntax: [:SENSe]:CORRection:COLLect:ACQuire:OPEN 

Description: Perform open circuit clear for all frequency points 

Related keys: Cal > Open > All Frequency Clear 

 

 :CORR2:COLL:ACQ:SHOR 

Command Type: Command 

Syntax: [:SENSe]:CORRection:COLLect:ACQuire:SHORt 

Description: Perform short circuit clear for all frequency points 

Related keys: Cal > Short > All Frequency Clear 
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 :CORR2:LOAD 

Command Type: Command/Query 

Syntax: 

[:SENSe]:CORRection2:LOAD {ON|OFF|1|0} 

[:SENSe]:CORRection2:LOAD? 

Description: Set and query the on-off state of the user load calibration  

Parameters: 

Parameters Selection Option 

Description Load calibration 

switch 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value ON 

 

Examples: 

Turn on the load calibration:  

:CORR2:LOAD ON 

Query the load calibration open state:  

:CORR2:LOAD? 

Query Response: {1|0}< newline><^END> 

Related keys: Cal > Load 

 

 :CORR2:OPEN 

Command Type: Command/Query 

Syntax: 

[:SENSe]:CORRection2:OPEN {ON|OFF|1|0} 

[:SENSe]:CORRection2:OPEN? 

Description: Set and query the on-off state of the user open calibration  

Parameters: 

Parameter Selection Option 

Description Open calibration 

switch 
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Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value ON 

 

Examples: 

Turn on the open calibration:  

:CORR2:OPEN ON 

Query the open calibration open state:  

:CORR2:OPEN? 

Query Response: {1|0}< newline><^END> 

Related keys: Cal > Open 

 

 :CORR2:SHOR 

Command Type: Command/Query 

Syntax: 

[:SENSe]:CORRection2:SHORt {ON|OFF|1|0} 

[:SENSe]:CORRection2:SHORt? 

Description: Set and query the on-off state of the user short calibration  

Parameters: 

 

Parameter Selection Option 

Description Short calibration 

switch 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value ON 

 

Examples: 

Turn on the short calibration:  

:CORR2:SHOR ON 

Query the short calibration open state: 

:CORR2:SHOR? 
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Query Response: {1|0}< newline><^END> 

Related keys: Cal > Short 

9.2.3.2 :DISPLAY 

:DISP:CCL 

Command Type: Command 

Syntax: 

:DISPlay:CCLear 

Description: Clear the warning message at the bottom of the screen 

9.2.3.3 :SYSTEM 

 :SYST:KLOC:KBD 

Command Type: Command/Query 

Syntax: 

:SYSTem:KLOCk:KBD {ON|OFF|1|0}  

:SYSTem:KLOCk:KBD? 

Description: Set or query whether the front panel is disabled 

Parameters: 

Parameter Selection Option 

Description Front panel lock 

switch 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value OFF 

 

Examples: 

Lock the front panel:  

:SYST:KLOC:KBD ON 

Query front panel lock state:  

:SYST:KLOC:KBD? 

Query Response: {1|0}< newline><^END> 
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Related keys: System > Misc Setup > Key Lock > Front Panel Lock 

 

 :SYST:KLOC:MOUS 

Command Type: Command/Query 

Syntax: 

:SYSTem:KLOCk:MOUSe {ON|OFF|1|0}  

:SYSTem:KLOCk:MOUSe? 

Description: Set or query whether the touch screen is disabled 

Parameters: 

Parameter Selection Option 

Description Touch screen lock 

switch 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value OFF 

 

Examples: 

Lock the touch screen:  

:SYST:KLOC:MOUS ON 

Query the touch screen lock state:  

:SYST:KLOC:MOUS? 

Query Response: {1|0}< newline><^END> 

Related keys: System > Misc Setup > Key Lock > Screen Lock 

 

 :SYST:POFF 

Command Type: Command 

Syntax:  

:SYSTem:POFF 

Description: Turn off the TH2851 program 

Related keys: System > Exit Application 
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 :SYST:PRES 

Command Type: Command 

Syntax:  

:SYSTem:PRESet 

Description: When the current measurement is in sweep mode, preset the TH2851 to the 

factory setting state, at this time the command differs from *RST in that the trigger mode of channel 

1 will be set to continuous mode automatically after the completion; when the current measurement 

is point measurement or list measurement, restore the instrument to the factory setting and return to 

the main page of point measurement. 

 

 :SYST:UPR 

Command Type: Command 

Syntax:  

:SYSTem:UReset 

Description: Preset the TH2851 to the user settings, or return an error if the user settings file 

does not exist 

9.2.4 Point Measurement and List Command 

This section introduces the commands for point measurement and List sweep. Only if the 

current page belongs to point measurement or list sweep (or its related setup screen), inputting 

commands in this section will take effect 

9.2.4.1 :AMPL 

:AMPL:ALC 

Command Type: Command/Query 

Syntax: 

:AMPLitude:ALC {ON|OFF|1|0} 

:AMPLitude:ALC? 

Description: Set or query the ALC (Automatic Level Control) state of the point measurement 

Parameters: 

Parameter Selection Option 

Description ALC switch 

Data Type Boolean type 



 138 

(Boolean) 

Range ON|OFF|1|0 

Preset Value OFF 

 

Examples: 

Set the ALC to ON: :AMPL:ALC ON 

Query the ALC state: :AMPL:ALC? 

Query Response: {1|0}< newline><^END> 

Related keys: Meas Setup > OSC Level > ALC > ALC Control 

9.2.4.2 :APER 

:APER 

Command Type: Command/Query 

Syntax: 

:APERture {1|2|3|4|5} 

:aperture? 

Description: Set and query the point measurement speed 

Parameters: 

Parameter Selection Option 

Description Measurement speed 

Data Type Numeric type 

(Integer) 

Range 1|2|3|4|5 

Preset Value 3 

 

Examples: 

Set the measurement speed to 1:  

:APER 1 

Query the point measurement speed:  

:APER? 

Query Response: {1|2|3|4|5}< newline><^END> 

Related keys: Meas Setup > Meas Time 
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9.2.4.3 :AVER:COUN 

Command Type: Command/Query 

Syntax: 

:AVERage:COUNt < number > 

:average:COUNt? 

Description: Set and query the point averaging count 

Parameters: 

Parameter Numerical value 

Description Averaging factor 

Data Type Numeric type 

(Integer) 

Range 1 – 999 

Preset Value 1 

 

Examples: 

Set the averaging factor to 5:  

:AVER:COUN 5 

Query the averaging factor:  

:AVER:COUN? 

Query Response: {< number>}<newline><^END> 

Related keys: Meas Setup > Avg Count 

9.2.4.4 BIAS 

 :BIAS:CURR 

Command Type: Command/Query 

Syntax: 

:BIAS:CURRent < number > 

:BIAS:CURRent? 

Description: Set or query the DC bias current. The setting does not mean that the DC bias is 

turned on. 

Parameters: 

Parameter Numerical value 
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Description DC bias current 

Data Type Double precision type 

(double) 

Range -0.1 - 0.1 

Unit A 

Preset Value 0 

 

Examples: 

Set the bias current to 0.1A:  

:BIAS:CURR 0.1 

Query the bias current:  

:BIAS:CURR? 

Query Response: {< number> }<newline><^END> 

Related keys: Meas Setup > DC Bias > Current Level 

 

 :BIAS:MODE  

Command Type: Command/Query 

Syntax: 

:BIAS:MODE {VOLTage|CURRent} 

:BIAS:MODE? 

Description: Set or query the point DC bias mode. The setting does not mean that the DC bias 

is turned on. 

Parameters: 

Parameter Selection Option 

Description DC bias mode 

Data Type Character string type 

(String) 

Range VOLT: Voltage mode 

CURR: Current Mode 

Preset Value VOLT 

 

Examples: 

Set the DC bias mode to voltage mode:  

:BIAS:MODE VOLT 

Query the DC bias mode:  
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:BIAS:MODE? 

Query Response: {VOLT|CURR}< newline><^END> 

Related keys: Meas Setup > DC Bias > DC Bias Mode 

 

 :BIAS:RANG 

Command Type: Command/Query 

Syntax: 

:BIAS:RANGe {M1|M10|M100} 

:BIAS:RANGe? 

Description: Set or query the DC bias range. The setting does not mean that the DC bias is 

turned on. 

Parameters: 

Parameter Selection Option 

Description DC bias range 

Data Type Character string type 

(String) 

Range M1: 1mA 

M10: 10mA 

M100: 100mA 

Preset Value M1 

 

Examples: 

Set the DC bias range to 1mA:  

:BIAS:RANG M1 

Query the DC bias range:  

:BIAS:RANG? 

Query Response: {M1|M10|M100}< newline><^END> 

Related keys: Meas Setup > DC Bias > Meas Range 

 

 :BIAS:STAT 

Command Type: Command/Query 

Syntax: 

:BIAS:STATe {ON|OFF|1|0}  
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:BIAS:STATe? 

Description: Set or query the on-off state of the DC bias 

Parameters: 

Parameter Selection Option 

Description DC Bias switch 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value OFF 

 

Examples: 

Turn on the DC bias:  

:BIAS:STAT ON 

Query the on-off state of the DC bias:  

:BIAS:STAT? 

Query Response: {1|0}< newline><^END> 

Related keys: Meas Setup > DC Bias > DC Bias State 

 

 :BIAS:VOLT 

Command Type: Command/Query 

Syntax: 

:BIAS:VOLTage < number > 

:BIAS:VOLTage? 

Description: Set or query the DC bias voltage. The setting does not mean that the DC bias is 

turned on. 

Parameters: 

Parameter Numerical Value 

Description DC bias voltage 

Data Type Double precision type 

(double) 

Range -40 - 40 

Unit V 

Preset Value 0 

 

Examples: 



 143 

Set the bias voltage to 1V:  

:BIAS:VOLT 1 

Query the bias voltage:  

:BIAS:VOLT? 

Query Response: {< number>}<newline><^END> 

Related keys: Meas Setup > DC Bias > Voltage Level 

9.2.4.5 COMPATATOR 

 :COMP 

Command Type: Command/Query 

Syntax: 

:COMParator[:STATe] {ON|OFF|1|0}  

:COMParator[:STATe]? 

Description: Set or query the point comparator state 

Parameters: 

Parameter Selection Option 

Description Comparator state 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value OFF 

 

Examples: 

Turn on the point measurement comparator:  

:COMP ON 

Query the status of the point measurement comparator:  

:COMP? 

Query Response: {1|0}< newline><^END> 

Related keys: Comparator > Comparator State 

 

 :COMP:BIN{1-9} 

Command Type: Command/Query 
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Syntax: 

:COMParator:BIN{1|2|3|4|5|6|8|9} [:STATe] {ON|OFF|1|0}  

:COMParator:BIN{1|2|3|4|5|6|8|9} [:STATe]? 

Description: Set or query the BIN (1-9) state in the point comparator 

Parameters: 

Parameter Selection Option 

Description BIN state 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value OFF 

 

Examples: 

Turn on the BIN1:  

:COMP:BIN1 ON 

Query the BIN2 on-off state:  

:COMP:BIN2? 

Query Response: {1|0}< newline><^END> 

Related keys: Comparator > Edit Comptr Table > BIN > State 

 

 

 :COMP:BIN{1-9}:COND{1-4}:LIM 

Command Type: Command/Query 

Syntax: 

:COMParator:BIN{1|2|3|4|5|6|7|8|9}:CONDition{1|2|3|4}:LIMit <number1>,<number2>  

:COMParator:BIN{1|2|3|4|5|6|7|8|9}:CONDition{1|2|3|4}:LIMit? 

Description: Set and query the limit line of each BIN table condition (1-4) of each BIN (1-9) in 

the point comparator. The limit line contains upper and lower limit values. 

Parameters: 

Parameter < Number 1 > < Number 2 > 

Description Lower value Upper value 

Data Type Double precision type 

(double) 

Double precision type 

(double) 
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Range -1E9 - 1E9 -1E9 - 1E9 

Preset Value 0 0 

Unit Depend on BIN 

parameters 

Depend on BIN 

parameters 

 

Examples: 

Set the upper limit of BIN1 condition 1 to 2k and the lower limit to 1k:  

:COMP:BIN1:COND1:LIM 1E3,2E3 

Query the upper and lower limits of BIN2 condition 2:  

:COMP:BIN2:COND2:LIM? 

Query Response: {< number1> }, {< number2>}<newline><^END> 

Related keys: Comparator > Edit Comptr Table > BIN > Upper / Lower 

 

 :COMP:BIN{1-9}:COND{1-4}:LTYP 

Command Type: Command/Query 

Syntax: 

:COMParator:BIN{1|2|3|4|5|6|7|8|9}:CONDition{1|2|3|4}:LTYPe {IN|OUT|ALL}  

:COMParator:BIN{1|2|3|4|5|6|7|8|9}:CONDition{1|2|3|4}:LTYPe? 

Description: Set and query the limit line type of each BIN table condition (1-4) of each BIN 

(1-9) in the point comparator 

Parameters: 

Parameter Selection Option 

Description Limit line type 

Data Type Character string type 

(String) 

Range IN|OUT|ALL 

Preset Value ALL 

 

Examples: 

Set the limit line type of BIN1 condition 1 to IN:  

:COMP:BIN1:COND1:LTYP IN 

Query the limit line type of BIN2 condition 2:  

:COMP:BIN2:COND2:LTYP? 

Query Response: {IN|OUT|ALL}< newline><^END> 
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Related keys: Comparator > Edit Comptr Table > BIN > In/Out 

 

 :COMP:CLE 

Command Type: Command 

Syntax: :COMParator:CLEar 

Description: Restore all point measurement comparator table to their initial values 

Related keys: Comparator > Edit Comptr Table > All Tables > Clear All 

 

 :COMP:COND{1-4}:MODE 

Command Type: Command/Query 

Syntax: 

:COMParator:CONDition{1|2|3|4}:MODE {OFF|DEV|PCNT|PDEV}  

:COMParator:CONDition{1|2|3|4}:MODE? 

Description: Set and query the data math of the point measurement comparator table condition 

(1-4) 

Parameters: 

Parameter Selection Option 

Description Comparator data math 

Data Type Character string type 

(String) 

Range OFF: Off 

DEV: Deviation 

PCNT: Percent 

PDEV: Deviation 

percent 

Preset Value OFF 

 

Examples: 

Set the data math of condition 1 to Deviation:  

:COMP:COND1:MODE DEV 

Query the data math of condition 2:  

:COMP:COND2:MODE? 

Query Response: {OFF|DEV|PCNT|PDEV }<newline><^END> 

Related keys: Comparator > Edit Comptr Table > Mode 
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 :COMP:COND{1-4}:NOM 

Command Type: Command/Query 

Syntax: 

:COMParator:CONDition{1|2|3|4}:NOMinal < number >  

:COMParator:CONDition{1|2|3|4}:NOMinal? 

Description: Set or query the reference value of the point measurement comparator table 

condition (1-4) 

Parameters: 

Parameter Numerical Value 

Description Comparator reference 

value 

Data Type Double precision type 

(double) 

Range -1E9 - 1E9 

Preset Value 0 

 

Examples: 

Set the reference value of condition 1 to 1000:  

:COMP:COND1:NOM 1E3 

Query the reference value of condition 2:  

:COMP:COND2:NOM? 

Query Response: {< number>}<newline><^END> 

Related keys: Comparator > Edit Comptr Table > Reference 

 

 :COMP:COND{1-4}:PAR 

Command Type: Command/Query 

Syntax: 

:COMParator:CONDition{1|2|3|4}:PARameter{Z|Y|TZR|TZD|TYR|TYD|RS|RP|LS|LP|CS|CP|

R|G|X|B|Q|D} 

:COMParator:CONDition{1|2|3|4}:PARameter? 

Description: Set or query the measurement parameters of the point measurement comparator 

table condition (1-4) 

Parameters: 
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Parameter Selection Option 

Description Comparator 

measurement 

parameter 

Data Type Character string type 

(String) 

Range Z:|Z| 

Y:|Y| 

TZR.θ z(rad) 

TZD.θ z(deg) 

TYR.θ y(rad) 

TYD.θ y(deg) 

RS: Rs 

RP: Rp 

LS: Ls 

LP: Lp 

CS: Cs 

CP: Cp 

R: R 

G: G 

X: X 

B: B 

Q: Q 

D: D 

Preset Value Z 

 

Examples: 

Set the parameters of condition 1 to R:  

:COMP:COND1:PAR R 

Query the parameters of condition 2: 

:COMP:COND2:PAR? 

Query Response: {Z|Y|TZR|TZD|TYR|TYD|RS|RP|LS|LP|CS|CP|R|G|X|B|Q|D}< 

newline><^END> 

Related keys: Comparator > Edit Comptr Table > Parameter 

 

 :COMP:COND{1-4}:SW 

Command Type: Command/Query 

Syntax: 

:COMParator:CONDition{1|2|3|4}:SWitch {ON|OFF|1|0} 
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:COMParator:CONDition{1|2|3|4}: SWitch? 

Description: Set or query the on-off state of the point measurement comparator table condition 

(1-4) 

Parameters: 

Parameter Selection Option 

Description Comparator condition 

switch 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value ON 

 

Examples: 

Turn on the setting conditon 1:  

:COMP:COND1:SW ON 

Query the on-off state of the setting condition 2: 

:COMP:COND2:SW? 

Query Response: {1|0}< newline><^END> 

Related keys: Comparator > Edit Comptr Table > State 

 

 :COMP:COUN 

Command Type: Command/Query 

Syntax: 

:COMParator:COUNt[:STATe] {ON|OFF|1|0}  

:COMParator:COUNt[:STATe]? 

Description: Set or query the open state of the point measurement comparator count 

Parameters: 

Parameter Selection Option 

Description Comparator count 

state 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value ON 
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Examples: 

Turn on the comparator count:  

:COMP:COUN ON 

Query the on-off state of the comparator count:  

:COMP:COUN? 

Query Response: {1|0}< newline><^END> 

Related keys: Comparator > Bin Count 

 

 :COMP:COUN:CLE 

Command Type: Command 

Syntax: :COMParator:COUNt:CLEar 

Description: Clear the current point measurement comparator count 

Related keys: Comparator > Clear Bin Count 

 

 :COMP:DATA:BCO 

Command Type: Query 

Syntax: :COMParator:DATA:BCOunt? 

Description: Query each BIN count of the comparator in the point measurement 

Query Response: {< number 1>}, {< number 2>},{< number 3>}, {< number 4>},{< number 

5>}, {< number 6>},{< number 7>}, {< number 8>},{< number 9>}, {< number 

10>}<newline><^END> 

Number 1 to number 9 represent the Bin count of the BIN 1 - BIN 9, and the number 10 

represents counts that failed to be sorted into any BIN (Out of Good). 

 

 :COMP:DATA:BIN 

Command Type: Query 

Syntax: :COMParator:DATA:BIN? 

Description: Query the most recent Bin result 

Query Response: {0|1|2|3|4|5|6|7|8|9|10}< newline><^END> 

In the command, 0 indicates that the BIN cannot be sorted into any BIN, 1-9 indicates the 

corresponding bin sequence number, and 10 indicates the bin failure caused by measurement errors 
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(usually Overload). 

 

 :COMP:OGB 

Command Type: Command/Query 

Syntax: 

:COMParator:OGBins < number >  

:COMParator:OGBins? 

Description: Set or query the number of qualified BINs of the point measurement comparator 

Parameters: 

Parameter Numerical Value 

Description Comparator number 

of good bins 

Data Type Numeric type 

(Integer) 

Range 1 - 9 

Preset Value 9 

 

Examples: 

Set the BIN1-BIN3 as qualified BINs:  

:COMP:OGB 3 

Query the number of qualified BINs:  

:COMP:OGB? 

Query Response: {< number>}<newline><^END> 

Related keys: Comparator > Edit Comptr Table > Good Bins 

9.2.4.6 CURRENT 

:CURR 

Command Type: Command/Query 

Syntax: 

:CURRent < number > 

:CURRent? 

Description: Set and query the current of the point measurement signal source and set the level 

mode to current mode automatically after setting the current. 
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Parameters: 

 

Parameter Numerical Value 

Description Signal source current 

Data Type Double precision type 

(double) 

Range 0.0002 - 0.02 

Preset Value 0.02 

Unit A 

 

Examples: 

Set the current to 10mA:  

:CURR 0.01 

Query the current value:  

:CURR? 

Query Response: {< number>}<newline><^END> 

Related keys: Meas Setup > OSC Level > Current Level 

9.2.4.7 DISPLAY 

:DISP:PAGE 

Command Type: Command/Query 

Syntax: 

:DISPlay:PAGE 

{MEASurement|LIST|STIMulus|SWEEp|CAL|COMParator|PoinTCOmparator} 

:DISPlay:PAGE? 

Description: Open the specified page, or query the currently displayed page 

Parameters: 

Parameter Selection Option 

Description Measuring Fixture 

Data Type Character string type (String) 

Range MEASurement: Point measurement interface 

LIST: List measurement interface 

STIMulus: Stimulus interface 

SWEEp: Sweep measurement interface 

CAL: User Calibration Interface 
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COMParator: Comparator interface 

PoinTCOmparator: Point measurement comparator interface 

 

Examples: 

Open the list measurement interface:  

:DISP:PAGE LIST 

Query Response: {MEAS|LIST|STIM|SWEE|CAL|COMP|PTCO}< newline><^END> 

9.2.4.8 FETCH 

 :FETC 

Command Type: Query 

Syntax: :FETCh[:IMPedance]? 

Description: Query the current measurement results of the point measurement/list sweep  

Query Response: 

Point: {<number1>}, {<number2>}, {<number3>}, {<number 4>}, {1|0}, 

{0|1|2|3|4|5|6|7|8|9|10} <newline> <^END> 

List: {< point 1 parameter 1> },{< point 1 parameter 2> },{< point 1 parameter 3> },{< point 1 

parameter 4> },..., {< point n parameter 1> },{< point n parameter 2> },{< point n parameter 

3> },{< point n parameter 4>},{1|0},{0|1|2|3|4|5|6|7|8|9|10}<newline><^END> 

In the response to the point measurement, number 1--number 4 are the measured values of the 

4 parameters of the current page; 

In the response to the list sweep, n is the number of measurement points in the list, and the first 

4*n numbers are the 4 parameter measurements of the n points. 

In the point measurement and list sweep, if the measurement error (Overload) occurs, the next 

implies the value of 1, otherwise 0. 

If the comparator is turned on, the last digit is the BIN result, 10 (list sweep is 16) indicates 

that the BIN cannot be sorted into any BIN, 1-9 (list is 1-15) indicate the corresponding BIN 

sequence number, -1 indicates that the bin is failed due to the measurement error (usually Overload 

will appear) 

 

 :FETC:CORR 

Command Type: Query 

Syntax: :FETCh[:IMPedance]:CORRected? 

Description: Query the point measurement/list sweep corrected measurements (R-X) 
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Query Response: 

Point: {< number>},{< number2>}<newline><^END> 

List: {< point 1R value>},{< point 1X value>},..., {< point nR value>},{< point nX 

value>}<newline><^END> 

In the response to the point measurement, number 1 is the R value and number 2 is the X value. 

In the response to the list sweep, n is the number of measurement points in the list, and the 

parameters of the response are the R and X values of each point in turn. 

 

 :FETC:SMON:IAC 

Command Type: Query 

Syntax:  

:FETCh:SMONitor:IAC? 

Description: Query the measurement data of AC current monitoring in point measurement/list 

sweep 

Query Response: {< number>}<newline><^END> 

 

 :FETC:SMON:IDC 

Command Type: Query 

Syntax:  

:FETCh:SMONitor:IDC? 

Description: Query the measurement data of DC current monitoring in point measurement/list 

sweep 

Query Response: {< number>}<newline><^END> 

 

 :FETC:SMON:VAC 

Command Type: Query 

Syntax:  

:FETCh:SMONitor:VAC? 

Description: Query the measurement data of AC voltage monitoring in point measurement/list 

sweep 

Query Response: {< number>}<newline><^END> 
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 :FETC:SMON:VDC 

Command Type: Query 

Syntax:  

:FETCh:SMONitor:VDC? 

Description: Query the measurement data of DC voltage monitoring in point measurement/list 

sweep 

Query Response: {< number>}<newline><^END> 

9.2.4.9 FREQUENCY 

:FREQ 

Command Type: Command/Query 

Syntax: 

:FREQuency < number > 

:FREQuency? 

Description: Set or query the frequency of the point measurement 

Parameters: 

Parameters Numerical Value 

Description Measurement 

Frequency 

Data Type Double precision type 

(Double) 

Range 10Hz - 130MHz 

Preset Value 1000Hz 

 

Examples: 

Set the frequency to 1MHz:  

:FREQ 1E6 

Query the current measurement frequency:  

:FREQ? 

Query Response: {< number>}<newline><^END> 

Related keys: Meas Setup > Frequency 
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9.2.4.10 FUNCTION 

 :FUNC:DEV{1-4}:MODE 

Command Type: Command/Query 

Syntax: 

:FUNCtion:DEV{1|2|3|4}:MODE {OFF|ABSolute|PERCent} 

:FUNCtion:DEV{1|2|3|4}:MODE? 

Description: Set or query the math mode of the selected measurement parameter 

Parameters: 

Parameter Selection Option 

Description Math Mode 

Data Type Character string type (String) 

Range OFF: OFF 

ABSolute: Deviation mode 

PERCent: Deviation percent 

mode 

Preset Value OFF 

 

Examples: 

Set the math mode of parameter 1 to the deviation mode:  

:FUNC:DEV1:MODE ABS 

Query the math mode of parameter 2:  

:FUNC:DEV1:MODE? 

Query Response: {OFF|ABS|PERC }<newline><^END> 

Related keys: Display > Parameter > Math Mode 

 

 :FUNC:DEV{1-4}:REF 

Command Type: Command/Query 

Syntax: 

:FUNCtion:DEV{1|2|3|4}:REFerence < number> 

:FUNCtion:DEV{1|2|3|4}:REFerence? 

Description: Set or query the reference value of the selected measurement parameter 

Parameters: 
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Parameter Numerical Value 

Description Reference value 

Data Type Double precision type 

(double) 

Range -1E9 - 1E9 

Preset Value 0 

Unit Depends on 

measurement 

parameters 

 

Examples: 

Set the reference value of parameter 1 to 1000:  

:FUNC:DEV1:REF 1E3 

Query the reference value of parameter 2:  

:FUNC:DEV1:REF? 

Query Response: {< number> }<newline><^END> 

Related keys: Display > Parameter > Reference 

 

 :FUNC:IMP:RANG 

Command Type: Command/Query 

Syntax: 

:FUNCtion:IMPedance:RANGe {AUTO|50|500|5K|50K} 

:FUNCtion:IMPedance:RANGe? 

Description: Set or query the AC range of the point measurement 

Parameters: 

Parameter Selection Option 

Description AC range 

Data Type Character string type (String) 

Range AUTO: AUTO 

50: 50Ω 

500: 500Ω 

5K: 5kΩ 

50K: 50kΩ 

Preset Value AUTO 

 

Examples: 
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Set the AC range to AUTO:  

:FUNC:IMP:RANG AUTO 

Query the current AC range:  

:FUNC:IMP:RANG? 

Query Response: {AUTO|50|500|5K|50K}< newline><^END> 

Related keys: Meas Setup > ACRange 

 

 :FUNC:PAR{1-4}:FORM 

Command Type: Command/Query 

Syntax: 

:FUNCtion:PARamater{1|2|3|4}:FORMat 

{Z|Y|TZR|TZD|TYR|TYD|RS|RP|LS|LP|CS|CP|R|G|X|B |Q|D} 

:FUNCtion:PARamater{1|2|3|4}:FORMat? 

Description: Set and query the parameter name of the selected measurement parameter 

Parameters: 

 

Parameter Selection Option 

Description Point measurement parameter 

Data Type Character string type (String) 

Range Z:|Z| 

Y:|Y| 

TZR.θ z(rad) 

TZD.θ z(deg) 

TYR.θ y(rad) 

TYD.θ y(deg) 

RS: Rs 

RP: Rp 

LS: Ls 

LP: Lp 

CS: Cs 

CP: Cp 

R: R 

G: G 

X: X 

B: B 

Q: Q 

D: D 
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DCR: DCR 

ER: |εr| (requires permittivity module 

support) 

ER1: εr' (requires permittivity 

module support) 

ER1: εr'' (requires permittivity 

module support) 

U1: μ' (requires troidalcore module 

support)  

U2: μ'' (requires troidalcore module 

support)  

TAN: tan δ (requires troidalcore 

module support) 

Preset Value Z 

 

Examples: 

Set the parameter 1 to |Z|:  

:FUNC:PAR1:FORM Z 

Query the parameter name of parameter 2:  

:FUNC:PAR2:FORM? 

Query Response: 

{Z|Y|TZR|TZD|TYR|TYD|RS|RP|LS|LP|CS|CP|R|G|X|B|Q|D|ER|ER1|ER2|U1|U2|TAN} 

<newline><^END> 

Related keys: Display > Parameter > Parameter 

 

 :FUNC:SMON:{IAC|VAC} 

Command Type: Command/Query 

Syntax: 

:FUNCtion:SMONitor:{IAC|VAC} {ON|OFF|1|0} 

:FUNCtion:SMONitor:{IAC|VAC}? 

Description: Set or query the on-off state of AC monitor, when it is OFF, the DC monitor will 

be on 

Parameters: 

Parameter Selection Option 

Description AC monitor state 

Data Type Boolean type 

(Boolean) 
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Range ON|OFF|1|0 

Preset Value ON 

 

Examples: 

Turn on the AC monitor:  

:FUNC:SMON:IAC ON 

Query the on-off state of the AC monitor:  

:FUNC:SMON:IAC? 

Query Response: {1|0}< newline><^END> 

Related keys: Meas Setup > AC/DC Monitor 

 

 :FUNC:SMON:{IDC|VDC} 

Command Type: Command/Query 

Syntax: 

:FUNCtion:SMONitor:{IDC|VDC} {ON|OFF|1|0} 

:FUNCtion:SMONitor:{IDC|VDC}? 

Description: Set or query the on-off state of DC monitor, when it is off, the AC monitor will be 

on 

Parameters: 

Parameter Selection Option 

Description DC monitor state 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value OFF 

 

Examples: 

Turn on the AC monitor:  

:FUNC:SMON:IDC ON 

Query the open state of the AC monitor:  

:FUNC:SMON:IDC? 

Query Response: {1|0}< newline><^END> 

Related keys: Meas Setup > AC/DC Monitor 
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9.2.4.11 INITIATE 

 :INIT 

Command Type: Command 

Syntax:  

:INITiate 

Description: Set the trigger mode to internal trigger 

 

 :INIT:CONT 

Command Type: Command/Query 

Syntax: 

:INITiate:CONTinuos {ON|OFF|1|0} 

:INITiate:CONTinuos? 

Description: Set the trigger mode to internal trigger, query whether the current trigger mode is 

internal trigger 

Parameters: 

Parameter Selection Option 

Description Internal trigger state 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value OFF 

 

Examples: 

Set the point measurement trigger mode to internal trigger:  

:INIT:CONT ON 

Query whether it is internal trigger: 

 :INIT:CONT? 

Query Response: {1|0}< newline><^END> 

9.2.4.12 LIST 

 :LIST:APER 

Command Type: Command/Query 
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Syntax: 

:LIST:APERture {1|2|3|4|5} 

:LIST:APERture? 

Description: Set or query the measurement time of the list sweep 

Parameters: 

Parameter Selection Option 

Description Measurement time 

Data Type Numeric type 

(Integer) 

Range 1|2|3|4|5 

Preset Value 1 

 

Examples: 

Set the measurement time to 2:  

:LIST:APER 2 

Query the list measurement time:  

:LIST:APER? 

Query Response: {1|2|3|4|5}< newline><^END> 

Related keys: Meas Setup > Meas Time 

 

 :LIST:BIAS:CURR 

Command Type: Command/Query 

Syntax: 

:LIST:BIAS:CURRent[point number] < number> 

:LIST:BIAS:CURRent[point serial number]? 

Description: Set or query the DC bias current of the selected measurement point in the list 

sweep. The setting does not mean that the DC bias is switched on. 

Parameters: 

Parameter Numerical Value 

Description DC bias current 

Data Type Double precision type 

(double) 

Range -0.1 - 0.1 

Unit A 
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Preset Value 0 

 

Examples: 

Set the bias current of the 10th point to 0.1A:  

:LIST:BIAS:CURR10 0.1 

Query the bias current of the 20th point:  

:LIST:BIAS:CURR20? 

Query Response: {< number>}<newline><^END>  

Related keys: Stim Table > DC Bias 

 

 :LIST:BIAS:MODE  

Command Type: Command/Query 

Syntax: 

:LIST:BIAS:MODE[point serial number] {VOLTage|CURRent} 

:LIST:BIAS:MODE[point serial number]? 

Description: Set or query the DC bias mode of the selected measurement point in the list sweep. 

The setting does not mean that the DC bias is switched on. 

Parameters: 

Parameter Selection Option 

Description DC bias mode 

Data Type Caracter string type 

(String) 

Range VOLT: Voltage mode 

CURR: Current mode 

Preset Value VOLT 

 

Examples: 

Set the DC bias mode of the 10th point to voltage mode:  

:LIST:BIAS:MODE10 VOLT 

Query the DC bias mode of the 20th point:  

:LIST:BIAS:MODE20? 

Query Response: {VOLT|CURR}< newline><^END>  

Related keys: Stim Table > Bias Mode 
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 :LIST:BIAS:RANG 

Command Type: Command/Query 

Syntax: 

:LIST:BIAS:RANGe[point serial number] {M1|M10|M100} 

:LIST:BIAS:RANGe[point serial number]? 

Description: Set or query the DC bias range of the selected measurement point in the list sweep. 

The setting does not mean that the DC bias is switched on. 

Parameters: 

Parameter Selection Option 

Description DC bias range 

Data Type Character string type 

(String) 

Range M1: 1mA 

M10: 10mA 

M100: 100mA 

Preset Value M1 

 

Examples: 

Set the DC bias range of the 10th point to 1mA:  

:LIST:BIAS:RANG10 M1 

Query the DC bias current of the 20th point:  

:LIST:BIAS:RANG20? 

Query Response: {M1|M10|M100}< newline><^END>  

Related keys: Stim Table > Meas Range 

 :LIST:BIAS:STAT 

Command Type: Command/Query 

Syntax: 

:LIST:BIAS:STATe[Stimulus] {ON|OFF|1|0}  

:LIST:BIAS:STATe[Stimulus]? 

Description: Set or query the on-off state of the DC bias of the selected measurement point in 

the list sweep 

Parameters: 
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Parameter Selection Option 

Description DC bias state 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value OFF 

 

Examples: 

Turn on the DC bias of the 10th point:  

:LIST:BIAS:STAT10 ON 

Query the DC bias state of the 20th point:  

:LIST:BIAS:STAT20? 

Query Response: {1|0}< newline><^END>  

Related keys: Stim Table > Bias State 

 

 :LIST:BIAS:VOLT 

Command Type: Command/Query 

Syntax: 

:LIST:BIAS:VOLTage[Stimulus] < number> 

:LIST:BIAS:VOLTage [Stimulus]? 

Description: Set or query the DC bias voltage of the selected measurement point in the list 

sweep. The setting does not mean that the DC bias is switched on. 

Parameters: 

Parameter Numerical Value 

Description DC bias voltage 

Data Type Double precision type 

(double) 

Range -40 - 40 

Unit V 

Preset Value 0 

 

Examples: 

Set the bias voltage of the 10th point to 1V:  

:LIST:BIAS:VOLT10 1 

Query the bias voltage of the 20th point:  
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:LIST:BIAS:VOLT20? 

Query Response: {< number>}<newline><^END> 

Related keys: Stim Table > DC Bias 

 

 :LIST:CLE 

Command Type: Command 

Syntax: :LIST:CLEar 

Description: Clear the list measurement points of the current page, restore them to the default 

value 

 

 :LIST:CLE:ALL 

Command Type: Command 

Syntax: :LIST:CLEar:ALL 

Description: Clear the list measurement points of all pages, restore them to the default value 

 

 :LIST:COMP 

Command Type: Command/Query 

Syntax: 

:LIST:COMParator[:STATe] {ON|OFF|1|0}  

:LIST:COMParator[:STATe]? 

Description: Set or query the list comparator state 

Parameters: 

Parameter Selection Option 

Description Comparator state 

Data Type Boolean type 

(Boolean) 

Range On|Off|1|0 

Preset Value Off 

 

Examples: 

Turn on the list comparator:  

:LIST:COMP ON 
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Query the list comparator state: 

:LIST:COMP? 

Query Response: {1|0}< newline><^END> 

Related keys: Comparator > Comparator State 

 

 :LIST:COMP:BIN{1-15} 

Command Type: Command/Query 

Syntax: 

:LIST:COMParator:BIN{1-15} [:STATe] {ON|OFF|1|0}  

:LIST:COMParator:BIN{1-15} [:STATe]? 

Description: Set or query the state of BIN (1-15) in the list comparator 

Parameters: 

Parameter Selection Option 

Description BIN state 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value OFF 

 

Examples: 

Turn on the BIN1:  

:LIST:COMP:BIN1 ON 

Query the on-off state of BIN2:  

:LIST:COMP:BIN2? 

Query Response: {1|0}< newline><^END> 

Related keys: Stim Table > Comparator > BIN > State 

 

 :LIST:COMP:BIN{1-15}:COND{1-4}:LIM 

Command Type: Command/Query 

Syntax: 

:LIST:COMParator:BIN{1-15}:CONDition{1|2|3|4}:LIMit <number1>,<number2>  

:LIST:COMParator:BIN{1-15}:CONDition{1|2|3|4}:LIMit? 
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Description: Set and query the limit line of the comparator condition setting (1-4) of BIN (1-15) 

in the list. The limit line contains the upper and lower limit values. 

Parameters: 

Parameter < Number 1 > < Number 2 > 

Description Lower Value Upper Value 

Data Type Double precision type 

(double) 

Double precision type 

(double) 

Range -1E9 - 1E9 -1E9 - 1E9 

Preset Value 0 0 

Unit Depends on 

comparator parameters 

Depends on 

comparator parameters 

 

Examples: 

Set the upper limit of BIN1 condition 1 to 2k and the lower limit to 1k:  

:LIST:COMP:BIN1:COND1:LIM 1E3,2E3 

Query the upper and lower limits of BIN2 condition 2: 

:LIST:COMP:BIN2:COND2:LIM? 

Query Response: {< number1>}, {< number2>}<newline><^END> 

Related keys: Stim Table > Comparator > BIN > Upper/Lower 

 

 :LIST:COMP:BIN{1-15}:COND{1-4}:LTYP 

Command Type: Command/Query 

Syntax: 

:LIST:COMParator:BIN{1-15}:CONDition{1|2|3|4}:LTYPe {IN|OUT|ALL}  

:LIST 

Description: Set and query the limit line type of the comparator condition setting (1-4) of BIN 

(1-15) in the list 

Parameters: 

Parameters Selection Option 

Description Limit line type 

Data Type Character string type 

(String) 

Range IN|OUT|ALL 

Preset Value ALL 
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Examples: 

Set the limit line type of BIN1 Condition 1 to IN:  

:LIST:COMP:BIN1:COND1:LTYP IN 

Query the limit line type of BIN2 Condition 2:  

:LIST:COMP:BIN2:COND2:LTYP? 

Query Response: {IN|OUT|ALL}< newline><^END> 

Related keys: Stim Table > Comparator > BIN > In/Out 

 

 :LIST:COMP:BIN{1-15}:COND{1-4}:MODE 

Command Type: Command/Query 

Syntax: 

:LIST:COMParator:BIN{1-15}:CONDition{1|2|3|4}:MODE {OFF|DEV|PCNT|PDEV}  

:LIST:COMParator:BIN{1-15}:CONDition{1|2|3|4}:MODE? 

Description: Set and query the data math of the comparator condition setting (1-4) of the list 

comparator setting BIN (1-15)  

Parameters: 

Parameter Selection Option 

Description Comparator data math 

Data Type Character string type 

(String) 

Range OFF: OFF 

DEV: Deviation 

PCNT: Percent 

PDEV: Percent 

Deviation 

Preset Value OFF 

 

Examples: 

Set the data math of BIN1 Conditon 1 to Deviation:  

:LIST:COMP:BIN1:COND1:MODE DEV 

Query the data math of BIN2 Condition 2:  

:LIST:COMP:BIN2:COND2:MODE? 

Query Response: {OFF|DEV|PCNT|PDEV}< newline><^END> 

Related keys: Stim Table > Comparator > BIN > Mode 
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 :LIST:COMP:BIN{1-15}:COND{1-4}:NOM 

Command Type: Command/Query 

Syntax: 

:LIST:COMParator:BIN{1-15}:CONDition{1|2|3|4}:NOMinal < number>  

:LIST:COMParator:BIN{1-15}:CONDition{1|2|3|4}:NOMinal? 

Description: Set or query the reference value of the comparator condition setting (1-4) of the 

list comparator BIN (1-15) 

Parameters: 

Parameter Numerical Value 

Description Comparator reference 

value 

Data Type Double precision type 

(double) 

Range -1E9 - 1E9 

Preset Value 0 

 

Examples: 

Set the reference value of BIN1 Condition 1 to 1000:  

:LIST:COMP:BIN1:COND1:NOM 1E3 

Query the reference value of BIN2 Condition 2:  

:LIST:COMP:BIN2:COND2:NOM? 

Query Response: {< number>}<newline><^END> 

Related keys: Stim Table > Comparator > BIN > Reference 

 

 :LIST:COMP:CLE 

Command Type: Command 

Syntax: :LIST:COMParator:CLEar 

Description: Restore all list comparator settings to the initial values 

Related keys: Stim Table > Comparator > All Tables > Clear All 

 

:LIST:COMP:COND{1-4}:PAR 

Command Type: Command/Query 

Syntax: 
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:LIST:COMParator:CONDition{1|2|3|4}:PARameter 

{Z|Y|TZR|TZD|TYR|TYD|RS|RP|LS|LP|CS| CP|R|G|X|B|Q|D} 

:LIST:COMParator:CONDition{1|2|3|4}:PARameter? 

Description: Set or query the measurement parameters of the list comparator setting condition 

(1-4) 

Parameters: 

Parameter Selection Option 

Description Comparator 

measurement 

parameter 

Data Type Character string type 

(String) 

Range Z:|Z| 

Y:|Y| 

TZR.θ z(rad) 

TZD.θ z(deg) 

TYR.θ y(rad) 

TYD.θ y(deg) 

RS: Rs 

RP: Rp 

LS: Ls 

LP: Lp 

CS: Cs 

CP: Cp 

R: R 

G: G 

X: X 

B: B 

Q: Q 

D: D 

Preset Value Z 

 

Examples: 

Set the parameters of Condition 1 to R:  

:LIST:COMP:COND1:PAR R 

Query the parameters of Condition 2:  

:LIST:COMP:COND2:PAR? 

Query Response: 

{Z|Y|TZR|TZD|TYR|TYD|RS|RP|LS|LP|CS|CP|R|G|X|B|Q|D }<newline><^END> 
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Related keys: Stim Table > Comparator > Parameter 

 

 :LIST:COMP:COUN 

Command Type: Command/Query 

Syntax: 

:LIST:COMParator:COUNt[:STATe] {ON|OFF|1|0}  

:LIST:COMParator:COUNt[:STATe]? 

Description: Set or query the open state of the list comparator count 

Parameters: 

Parameter Selection Option 

Description Comparator count 

state 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value ON 

 

Examples: 

Turn on the comparator count:  

:LIST:COMP:COUN ON 

Query the on-off state of the comparator count:  

:LIST:COMP:COUN? 

Query Response: {1|0}< newline><^END> 

Related keys: Comparator > Bin Count 

 

 :LIST:COMP:COUN:CLE 

Command Type: Command 

Syntax:  

:LIST:COMParator:COUNt:CLEar 

Description: Clear the count of the current list comparator 

Related keys: Comparator > Clear Bin Count 
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 :LIST:COMP:DATA:BCO 

Command Type: Query 

Syntax:  

:LIST:COMParator:DATA:BCOunt? 

Description: query the comparator count of each BIN in the list 

Query Response: {< number 1>}, {< number 2>},{< number 3>}, {< number 4>},{< number 

5>}, {< number 6>},{< number 7>}, {< number 8>},{< number 9>}, {< number 10>}< 

newline><^END> 

Number 1 – number 9 represent the comparator count of BIN 1 - BIN 9, and the number 10 

represents counts that fail to be sorted into any BIN (Out of Good) 

 :LIST:COMP:DATA:BIN 

Command Type: Query 

Syntax:  

:LIST:COMParator:DATA:BIN? 

Description: Query the most recent comparator result 

Query Response: {0|1|2|3|4|5|6|7|8|9|10}< newline><^END> 

In the command, 0 indicates that the BIN cannot be sorted into any BIN, 1-9 indicate the 

corresponding BIN sequence number, and 10 indicates the comparator failure caused by 

measurement errors (usually Overload) 

 

 :LIST:COUN 

Command Type: Command/Query 

Syntax: 

:LIST:COUN[Stimulus] < number> 

:LIST:COUN[Stimulus]? 

Description: Set or query the average count of the selected measurement points in the list 

sweep. 

Parameters: 

Parameter Numerical Value 

Description Average count 

Data Type Numeric type 

(Integer) 

Range 1 - 999 
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Preset Value 1 

 

Examples: 

Set the average count of the 10th point to 5:  

:LIST:COUN10 5 

Query the average count of the 20th point:  

:LIST:COUN20? 

Query Response: {< number>}<newline><^END> 

Related keys: Stim Table > Avg Count 

 

 :LIST:CURR 

Command Type: Command/Query 

Syntax: 

:LIST:CURRent[Stimulus] < number> 

:LIST:CURRent[Stimulus]? 

Description: Set or query the signal source current of the selected measurement point in the list 

sweep. 

Parameters: 

Parameter Numerical Value 

Description Signal source current 

Data Type Double precision type 

(double) 

Range 0.0002 - 0.02 

Unit A 

Preset Value 0.02 

 

Examples: 

Set the signal source current of the 10th point to 1mA: 

 :LIST:CURR10 1E-3 

Query the signal source current of the 20th point:  

:LIST:CURR20? 

Query Response: {< number>}<newline><^END> 

Related keys: Stim Table > OSC Level 
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 :LIST:DEL 

Command Type: Command/Query 

Syntax: 

:LIST:DELay[Stimulus] < number> 

:LIST:DELay[Stimulus]? 

Description: Set or query the point delay of the selected point 

Parameters: 

Parameter Numerical Value 

Description Point delay 

Data Type Double precision type 

(double) 

Range 0s - 30s 

Preset Value 0s 

 

Examples: 

Set the point delay of point 10 to 100ms:  

:LIST:DEL10 0.01 

Query the point delay of point 20: 

:LIST:DEL20? 

Query Response: {< number>}<newline><^END> 

Related keys: Stim Table > Point Delay 

 

 :LIST:FREQ 

Command Type: Command/Query 

Syntax: 

:LIST:FREQ[Stimulus] < number> 

:LIST:FREQ[Stimulus]? 

Description: Set or query the measurement frequency of the selected point 

Parameters: 

Parameter Numerical Value 

Description Measurement 
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frequency 

Data Type Double precision type 

(double) 

Range 10Hz - 130MHz 

Preset Value 1000Hz 

 

Examples: 

Set the frequency of point 10 to 1MHz:  

:LIST:FREQ10 1E6 

Query the measurement frequency of point 20:  

:LIST:FREQ20? 

Query response: {<number>}<newline><^END> 

Related keys: Stim Table > Frequency 

 

 :LIST:MODE 

Command Type: Command/Query 

Syntax: 

:LIST:MODE {SEQuence|STEP} 

:LIST:MODE? 

Description: Set the list type of the list sweep 

Parameters: 

Parameter Selection Option 

Description List type 

Data Type Character string type 

(String) 

Range SEQ: Sequence 

STEP: Step 

Preset Value SEQ 

 

Examples: 

Set the list type to Sequence:  

:LIST:MODE SEQ 

Query list type:  

:LIST:MODE? 
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Query Response: {SEQ|STEP}< newline><^END> 

Related keys: Point/List > List Type 

 

 :LIST:OSC 

Command Type: Command/Query 

Syntax: 

:LIST:OSC[Stimulus] {VOLTage|CURRent} 

:LIST:OSC[Stimulus]? 

Description: Set or query the signal source level mode of the selected measurement point 

Parameters: 

Parameter Selection Option 

Description List type 

Data Type Character string type 

(String) 

Range VOLT: Voltage mode 

CURR: Current mode 

Preset Value VOLT 

 

Examples: 

Set the 10th point signal source to voltage mode:  

:LIST:OSC10 VOLT 

Query the signal source mode of the 20th point:  

:LIST:OSC20? 

Query Response: {VOLT|CURR}< newline><^END> 

Related keys: Stim Table > OSC Mode 

 

 :LIST:PAR:FORM 

Command Type: Command/Query 

Syntax: 

:LIST:PARameter{1|2|3|4}:FORMat 

{Z|Y|TZR|TZD|TYR|TYD|RS|RP|LS|LP|CS|CP|R|G|X|B|Q|D} 

:LIST:PARameter{1|2|3|4}:FORMat? 

Description: Set or query the parameter name of the specified measurement parameter 
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Parameters: 

Parameter Selection Option 

Description Measurement parameter 

Data Type Character string type (String) 

Range Z:|Z| 

Y:|Y| 

TZR.θ z(rad) 

TZD.θ z(deg) 

TYR.θ y(rad) 

TYD.θ y(deg) 

RS: Rs 

RP: Rp 

LS: Ls 

LP: Lp 

CS: Cs 

CP: Cp 

R: R 

G: G 

X: X 

B: B 

Q: Q 

D: D 

ER: |εr| (requires permittivity module 

support) 

ER1: εr' (requires permittivity 

module support) 

ER2: εr'' (requires permittivity 

module support) 

U1: μ' (requires troidalcore module 

support)  

U2: μ'' (requires troidalcore module 

support)  

TAN: tan δ (requires troidalcore 

module support) 

NONE: None (not displayed) 

Preset Value Z 

 

Examples: 

Set the parameter 1 to |Z|:  

:LIST:PAR1:FORM Z 

Query the parameter name of the parameter 2:  

:LIST:PAR2:FORM? 
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Query Response: 

{Z|Y|TZR|TZD|TYR|TYD|RS|RP|LS|LP|CS|CP|R|G|X|B|Q|D|ER|ER1|ER2|U1|U2|TAN} 

<newline><^END> 

Related keys: Display > Parameter 

 

 :LIST:PERM:A1 

Command Type: Command/Query 

Syntax: 

:LIST:PERMittivity:A1 {ON|OFF|1|0} 

:LIST:PERMittivity:A1? 

Description: Set or query the electrode in the calculation of permittivity. This command must 

be enabled with the permittivity permission before it can be used. 

Parameters: 

Parameter Selection Option 

Description Display State 

Data Type Boolean type (Boolean) 

Range ON|OFF|1|0 

Commands ON: Electrode is A1 

OFF: Electrode is A2 

Preset Value ON 

 

Examples: 

Set the current electrode to A1:  

:LIST:PERM:A1 ON 

Query the electrode:  

:LIST:PERM:A1? 

Query Response: {1|0}< newline><^END> 

Related keys: Point/List > Electrode 

 

 :LIST:PERM:THIC 

Command Type: Command/Query 

Syntax: 

:LIST:PERMittivity:THICkness < number>  
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:LIST:PERMittivity:THICkness? 

Description: Set or query the thickness in the calculation of permittivity. This command must 

be enabled with the permittivity permission before it can be used. 

Parameters: 

Parameter Numerical Value 

Description Thickness 

Data Type Double precision type 

(double) 

Range 1E-9 - 999 

Unit m 

Preset Value 0.01 

 

Examples: 

Set the thickness to 5mm:  

:LIST:PERM:THIC 5E-3 

Query the thickness:  

:LIST:PERM:THIC? 

Query Response: {< number>}<newline><^END> 

Related keys: Point/List > Thickness 

 

 :LIST:POIN 

Command Type: Command/Query 

Syntax: 

:LIST:POINt < number> 

:LIST:POINt? 

Description: Set or query the number of measurement points in the list sweep, the measurement 

point parameter set by this command will be the default parameter. 

Parameters: 

Parameter Numerical Value 

Description Number of 

measurement points 

Data Type Numeric type 

(Integer) 

Range 1 - 1601 
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Preset Value 1 

 

Examples: 

Set the number of measurement points to 20:  

:LIST:POIN 20 

Query the number of measurement points:  

:LIST:POIN? 

Query Response: {< number>}<newline><^END> 

 

 :LIST:RANG 

Command Type: Command/Query 

Syntax: 

:LIST:RANGe [Stimulus] {AUTO|50|500|5K|50K} 

:LIST:RANGe [Stimulus]? 

Description: Set or query the AC range of the selected measurement point 

Parameters: 

Parameter Selection Option 

Description AC range 

Data Type Character string type 

(String) 

Range AUTO: Auto range 

50: 50Ω 

500: 500Ω 

5K: 5kΩ 

50K: 50kΩ 

Preset Value AUTO 

 

Examples: 

Set the AC range of the 10th point to auto range:  

:LIST:RANG10 AUTO 

Query the AC range of the 20th point:  

:LIST:RANG20? 

Query Response: AUTO|50|500|5K|50K}< newline><^END> 

Related keys: Stim Table > AC Range 
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 :LIST:TRIG 

Command Type: Command/Query 

Syntax: 

:LIST:TRIG {INTernal|MANualEXTernal|BUS} 

:LIST:TRIG? 

Description: Set the trigger mode of the list sweep 

Parameters: 

Parameter Selection Option 

Description Trigger mode 

Data Type Character string type 

(String) 

Range INT: Internal trigger 

MAN: Manual trigger 

EXT: External trigger 

BUS: Bus trigger 

Preset Value INT 

 

Examples: 

Set the trigger mode to manual trigger:  

:LIST:TRIG MAN 

Query the current trigger mode:  

:LIST:TRIG? 

Query Response: {INT|MAN|EXT|BUS}< newline><^END> 

Related keys: Point/List > Trigger Mode 

 

 :LIST:TROI:HEIG 

Command Type: Command/Query 

Syntax: 

:LIST:TROIdalcore:HEIGht? 

:LIST:TROIdalcore:HEIGht < number> 

Description: Set and query the troidal core height in the calculation of troidalcore. This 

command must be enabled with the troidalcore permission before it can be used. 

Parameters: 
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Parameter Numerical Value 

Description Troidal core height 

Data Type Double precision type 

(double) 

Range 1e-9 - 999 

Preset Value 0.005 

Unit m 

 

Examples: 

Set the troidal core height to 10mm:  

:LIST:TROI:HEIG 0.01 

Query the troidal core height:  

:LIST:TROI:HEIG? 

Query Response: {< number>}<newline><^END> 

Related keys: Point/List > Troidal core Height 

 

 :LIST:TROI:INN 

Command Type: Command/Query 

Syntax: 

:LIST:TROIdalcore:INNer? 

:LIST:TROIdalcore:INNer < number> 

Description: Set and query the troidal core inner in the calculation of troidalcore. This 

command must be enabled with the troidalcore permission before it can be used. 

Parameters: 

Parameter Numerical Value 

Description Troidal core inner 

Data Type Double precision type 

(double) 

Range 1e-9 - 999 

Preset Value 0.008 

Unit m 

 

Examples: 

Set the troidal core inner to 10 mm:  

:LIST:TROI:INN 0.01 
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Query the troidal core inner:  

:LIST:TROI:INN? 

Query Response: {< number>}<newline><^END> 

Related keys: Point/List > Troidal core Inner 

 

 :LIST:TROI:OUT 

Command Type: Command/Query 

Syntax: 

:LIST:TROIdalcore:OUTer? 

:LIST:TROIdalcore:OUTer < number> 

Description: Set and query the troidal core outer in the calculation of troidalcore. This 

command must be enabled with the troidalcore permission before it can be used. 

Parameters: 

Parameter Numerical Value 

Description Troidal core outer 

Data Type Double precision type 

(double) 

Range 1e-9 - 999 

Preset Value 0.015 

Unit m 

 

Examples: 

Set the troidal core outer to 20mm:  

:LIST:TROI:OUT 0.02 

Query the troidal core outer:  

:LIST:TROI:OUT? 

Query Response: {< number>}<newline><^END> 

Related keys: Point/List > Troidal core Outer 

 

 :LIST:VOLT 

Command Type: Command/Query 

Syntax: 

:LIST:VOLTage[Stimulus] < number> 
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:LIST:VOLTage [Stimulus]? 

Description: Set or query the signal source voltage of the selected measurement point in the list 

sweep. 

Parameters: 

Parameter Numerical Value 

Description Signal source voltage 

Data Type Double precision type 

(double) 

Range 0.005 - 1 

Unit V 

Preset Value 0.5 

 

Examples: 

Set the signal source voltage of the 10th point to 1V:  

:LIST:VOLT10 1 

Query the signal source voltage of the 20th point:  

:LIST:VOLT20? 

Query Response: {< number>}<newline><^END> 

Related keys: Stim Table > OSC Level 

9.2.4.13 PERMITTIVITY 

 :PERM:A1 

Command Type: Command/Query 

Syntax: 

:PERMittivity:A1 {ON|OFF|1|0} 

:PERMittivity:A1? 

Description: Set or query the electrode in the calculation of permittivity. This command must 

be enabled with the permittivity permission before it can be used. 

Parameters: 

Parameter Selection Option 

Description Display 

Data Type Boolean type (Boolean) 

Range ON|OFF|1|0 

Commands ON: Electrode is A1 
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OFF: Electrode is A2 

Preset Value ON 

 

Examples: 

Set the current electrode to A1: 

:PERM:A1 ON 

Query the electrode:  

:PERM:A1? 

Query Response: {1|0}< newline><^END> 

Related keys: Meas Setup > Electrode 

 

 :PERM:THIC 

Command Type: Command/Query 

Syntax: 

:PERMittivity:THICkness < number>  

:PERMittivity:THICkness? 

Description: Set or query the thickness in the calculation of permittivity. This command must 

be enabled with the permittivity permission before it can be used. 

Parameters: 

Parameter Numerical Value 

Description Thickness 

Data Type Double precision type 

(double) 

Range 1E-9 - 999 

Unit m 

Preset Value 0.01 

 

Examples: 

Set the thickness to 5 mm:  

:PERM:THIC 5E-3 

Query the thickness:  

:PERM:THIC? 

Query Response: {< number>}<newline><^END> 
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Related keys: Meas Setup > Thickness 

9.2.4.14 MEMORY 

 :MMEM:LIST 

Command Type: Command 

Syntax:  

:MMEMory:LIST < filename> 

Description: Save the list measurement data to the specified file name 

Related keys: Save/Reall > Export List Data 

 :MMEM:LOAD 

Command Type: Command 

Syntax:  

:MMEMory:LOAD[:STATe] "< filename>" 

Description: Load the measurement state settings file of the specified file path 

Related keys: Save/Recall > Recall State > Recall State 

 

 :MMEM:LOAD:STAT 

Command Type: Command 

Syntax:  

:MMEMory:LOAD:STATe {1|2|3|4|5|6|7|8} 

Description: Read the measurement state settings saved at the specified location 

Parameters: 

Parameter Selection Option 

Description Measurement state 

position 

Data Type Numeric type 

(Integer) 

Range 1|2|3|4|5|6|7|8 

 

Examples: Read the data of position 3:  

:MMEM:LOAD:STAT 3 

Related keys: Save/Recall > Recall State 
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 :MMEM:STOR 

Command Type: Command 

Syntax:  

:MMEMory:STOR[:STATe] "< filename>" 

Description: Store the current measurement state settings to the specified file path 

Related keys: Save/Recall > Save State > Save State 

 

 :MMEM:STOR:STAT 

Command Type: Command 

Syntax:  

:MMEMory:STORe:STATe {1|2|3|4|5|6|7|8} 

Description: Store the current measurement state settings to the specified location 

Parameters: 

Parameter Selection Option 

Description Measurement state 

position 

Data Type Numeric type 

(Integer) 

Range 1|2|3|4|5|6|7|8 

 

Examples: Store the measurement state settings in position 3:  

:MMEM:STOR:STAT 3 

Related keys: Save/Recall > Save State 

9.2.4.15 TRIGGER 

 :TRIG 

Command Type: Command 

Syntax:  

:TRIGger 

Description: Perform a trigger 
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 :TRIG:DEL 

Command Type: Command/Query 

Syntax: 

:TRIGger:DELay < number> 

:trigger:delay? 

Description: Set or query the trigger delay of the point measurement 

Parameters: 

Parameter Numerical Value 

Description Trigger delay 

Data Type Double precision type 

(double) 

Range 0s - 30s 

Preset Value 0s 

 

Examples: 

Set the point measurement trigger delay to 1 second:  

:TRIG:DEL 1 

Query the point measurement trigger delay:  

:TRIG:DEL? 

Query Response: {< number>}<newline><^END> 

Related keys: Meas Setup > Trigger Delay 

 

 :TRIG:SOUR 

Command Type: Command/Query 

Syntax: 

:TRIGger:SOURce {INTernal|MANual|EXTernal|BUS} 

:TRIGger:SOURce? 

Description: Set the trigger mode of the point measurement 

Parameters: 

Parameter Selection Option 

Description Trigger mode 

Data Type Character string type 

(String) 
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Range INT: Internal trigger 

MAN: Manual trigger 

EXT: External trigger 

BUS: Bus trigger 

Preset Value INT 

 

Examples: 

Set the trigger mode to manual trigger:  

:TRIG:SOUR MAN 

Query the current trigger mode:  

:TRIG:SOUR? 

Query Response: {INT|MAN|EXT|BUS}< newline><^END> 

Related keys: Meas Setup > Trigger Mode 

9.2.4.16 TROIDALCORE 

 :TROI:HEIG 

Command Type: Command/Query 

Syntax: 

:TROIdalcore:HEIGht? 

:TROIdalcore:HEIGht < number> 

Description: Set and query the troidal core height in the calculation of troidalcore. This 

command must be enabled with the troidalcore permission before it can be used. 

Parameters: 

Parameter Numerical Value 

Description Troidal core height 

Data Type Double precision type 

(double) 

Range 1e-9 - 999 

Preset Value 0.005 

Unit m 

 

Examples: 

Set the troidal core height to 10mm:  

:TROI:HEIG 0.01 

Query the troidal core height:  
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:TROI:HEIG? 

Query Response: {< number>}<newline><^END> 

Related keys: Meas Setup > Troidal core Height 

 

 :TROI:INN 

Command Type: Command/Query 

Syntax: 

:TROIdalcore:INNer? 

:TROIdalcore:INNer < number> 

Description: Set and query the troidal core inner in the calculation of troidalcore. This 

command must be enabled with the troidalcore permission before it can be used. 

Parameters: 

Parameter Numerical Value 

Description Troidal core inner 

Data Type Double precision type 

(double) 

Range 1e-9 - 999 

Preset Value 0.008 

Unit m 

 

Examples: 

Set the troidal core inner to 10 mm:  

:TROI:INN 0.01 

Query the troidal core inner:  

:TROI:INN? 

Query Response: {< number>}<newline><^END> 

Related keys: Meas Setup > Troidal core Inner 

 

 :TROI:OUT 

Command Type: Command/Query 

Syntax: 

:TROIdalcore:OUTer? 

:TROIdalcore:OUTer < number> 
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Description: Set and query the troidal core outer in the calculation of troidalcore. This 

command must be enabled with the troidalcore permission before it can be used. 

Parameters: 

Parameter Numerical Value 

Description Troidal core outer 

Data Type Double precision type 

(double) 

Range 1e-9 - 999 

Preset Value 0.015 

Unit m 

 

Examples: 

Set the troidal core outer to 20 mm:  

:TROI:OUT 0.02 

Query the troidal core outer:  

:TROI:OUT? 

Query Response: {< number>}<newline><^END> 

Related keys: Meas Setup > Troidal core Outer 

9.2.4.17 VOLTAGE 

:VOLT 

Command Type: Command/Query 

Syntax: 

:VOLTage < number> 

:VOLTage? 

Description: Set and query the voltage level of the point measurement signal source, and 

automatically set the level mode to voltage mode after setting the voltage. 

Parameters: 

Parameter Numerical Value 

Description Signal source voltage 

Data Type Double precision type 

(double) 

Range 0.005 - 1 

Preset Value 0.5 

Unit V 
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Examples: 

Set the voltage to 1V:  

:VOLT 1 

Query the voltage value:  

:VOLT? 

Query Response: {< number>}<newline><^END> 

Related keys: Meas Setup > OSC Level > Voltage Level 

9.2.5 Trace Sweep Command 

This part introduces the related commands of the trace sweep. The commands entered in this 

part will take effect only if the current page belongs to the trace sweep (or its related setting 

interface). 

9.2.5.1 ABORT 

:ABOR 

Command Type: Command 

Syntax:  

:ABORt 

Description: Immediately terminate the current sweep cycle and start a new one 

Related keys: Trigger Mode > Restart 

9.2.5.2 CALCULATE 

 :CALC<Ch>:AVER 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>:AVERage[:STATe] {ON|OFF|1|0}  

:CALCulate<Ch>:AVERage[:STATe]? 

Description: Set or query the averaging state of the selected measurement channel 

Parameters: 

Parameter Selection Option 

Description Averaging 
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Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value OFF 

 

Examples: 

Set the averaging of channel 1 to ON:  

:CALC1:AVER ON 

Query the averaging state of channel 2:  

:CALC2:AVER? 

Query Response: {1|0}< newline><^END> 

Related keys: Avg > Averaging 

 

 :CALC<Ch>:AVER:CLE 

Command Type: Command 

Syntax:  

:CALCulate<Ch>:AVERage:CLEar 

Description: Clear the averaging count of the selected measurement channel and restart 

Related keys: Avg > Averaging Restart 

 

 :CALC<Ch>:AVER:COUN 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>:AVERage:COUNt < number>  

:CALCulate<Ch>:AVERage:COUNt? 

Description: Set or query the averaging count of the selected measurement channel 

Parameters: 

Parameter Numerical Value 

Description Averaging factor 

Data Type Numeric type 

(Integer) 

Range 1 - 999 

Preset Value 1 
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Examples: 

Set the averaging count of channel 1 to 5:  

:CALC1:AVER:COUN 5 

Query the averaging count of channel 2:  

:CALC2:AVER:COUN? 

Query Response: {< number>}<newline><^END> 

Related keys: Avg > Avg Factor 

 

 :CALC<Ch>:DATA:FDAT 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:DATA:FDATa < digit 1>,< digit 2>...< digit n*2>  

:CALCulate<Ch>[:SELected]:DATA:FDATa? 

Description: Set or query the measured value of the current trace of the specified channel 

Parameters: 

Parameter Numerical Value 

Description Measured value of trace 

The number of measurement points is n. Each 

measurement point corresponds to two <number> 

The i-th measurement point input parameters are < digit 

i*2-1> and < digit i*2>,  

if the measured parameters of the trace are complex Z or 

complex Y, the <digit i*2-1> is the real part of the 

measurement data of the ith point, 

<number i*2> is the imaginary part of the measured data of 

the ith point 

Otherwise, 

<digit i*2-1> is the measured data of the ith point, 

<number i*2> is fixed to 0 

Data Type Double precision type (double) 

Note If the number of <numbers> entered in the command is not 

equal to n*2, an error will be returned 

 

Query Response: {< number 1>},{< number 2>}...{< number n*2>}<newline><^END> 
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 :CALC<Ch>:DATA:FMEM 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:DATA:FMEMory < digit 1>,< digit 2>...< digit n*2>  

:CALCulate<Ch>[:SELected]:DATA:FMEMory? 

Description: Set or query the measured value of the current memory trace of the specified 

channel 

Parameters: 

Parameter Numerical Value 

Description Measured value of memory trace 

The number of measurement points is n. Each 

measurement point corresponds to two <number> 

The i-th measurement point input parameters are < digit 

i*2-1> and < digit i*2>,  

if the measured parameters of the trace are complex Z or 

complex Y, the <digit i*2-1> is the real part of the 

measurement data of the ith point, 

<number i*2> is the imaginary part of the measured data of 

the ith point 

Otherwise, 

<digit i*2-1> is the measured data of the ith point, 

<number i*2> is fixed to 0 

Data Type Double precision type (double) 

Note If the number of <numbers> entered in the command is not 

equal to n*2, an error will be returned 

 

Query Response: {< number 1>},{< number 2>}...{< number n*2>}<newline><^END> 

 

 :CALC<Ch>:DATA:RDAT 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:DATA:RDATa < digit 1>,< digit 2>...< digit n*2>  

:CALCulate<Ch>[:SELected]:DATA:RDATa? 

Description: Set or query the measurement result of the current trace of the specified channel 

(R-X) 

Parameters: 
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Parameter Numerical Value 

Description Measured value of trace 

The number of measurement points is n. Each 

measurement point corresponds to two <number> 

The i-th measurement point input parameters are < digit 

i*2-1> and < digit i*2>, and 

< number i*2-1> is the R value of the i-th point 

< number i*2> is the X value of the i-th point 

Data Type Double precision type (double) 

Note If the number of <numbers> entered in the command is not 

equal to n*2, an error will be returned 

 

Query Response: {< number 1>},{< number 2>}...{< number n*2>}<newline><^END> 

 

 :CALC<Ch>:DATA:RMEM 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:DATA:RMEMory < number 1>,< number 2>...< number n*2>  

:CALCulate<Ch>[:SELected]:DATA:RMEMory? 

Description: Set or query the measurement result of the current memory trace of the specified 

channel (R-X) 

Parameters: 

Parameter Numerical Value 

Description Measured value of trace 

The number of measurement points is n. Each 

measurement point corresponds to two <number> 

The i-th measurement point input parameters are < digit 

i*2-1> and < digit i*2>, and 

< number i*2-1> is the R value of the i-th point 

< number i*2> is the X value of the i-th point 

Data Type Double precision type (double) 

Note If the number of <numbers> entered in the command is not 

equal to n*2, an error will be returned 

 

Query Response: {< number 1>},{< number 2>}...{< number n*2>}<newline><^END> 

 

 :CALC<Ch>:DATA:XAX 

Command Type: Query 
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Syntax: :CALCulate<Ch>[:SELected]:DATA:XAXis? 

Description: Get the value on the X-axis corresponding to each measurement point 

Query Response: {< number 1>},{< number 2>}...{< number n>}<newline><^END> 

 

 :CALC<Ch>:EPAR 

Command Type: Command 

Syntax: :CALCulate<Ch>:EPARameters[:EXECute] 

Description: Execute equivalent circuit analysis of measured data for the selected channels 

with the selected models 

Related keys: Analysis > Equivalent Circuit > Calculate 

 

 :CALC<Ch>:EPAR:CIRC 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>:EPARameters:CIRCuit[:TYPE] {A|B|C|D|E|F|G}  

:CALCulate<Ch>:EPARameters:CIRCuit[:TYPE]? 

Description: Set or query the equivalent circuit model of the selected channels 

Parameters: 

Parameter Selection Option 

Description Equivalent circuit model 

Data Type Character string type (String) 

Range A|B|C|D|E|F|G 

Preset Value A 

 

Examples: 

Set the equivalent circuit model of channel 1 to model C:  

:CALC1:EPAR:CIRC C 

Query the equivalent circuit model of channel 2:  

:CALC2:EPAR:CIRC? 

Query Response: {A|B|C|D|E|F|G}< newline><^END>  

Related keys: Analysis > Equivalent Circuit > Select Circuit 
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 :CALC<Ch>:EPAR:CIRC:{A|B|C|D|E|F|G}:C1 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>:EPARameters:CIRCuit:{A|B|C|D|E|F|G}:C1 <number>  

:CALCulate<Ch>:EPARameters:CIRCuit:{A|B|C|D|E|F|G}:C1? 

Description: Set or query the capacitance value C1 corresponding to the selected equivalent 

circuit model in the selected channel 

Parameters: 

Parameter Numerical Value 

Description Capacitance value C1 

Data Type Double precision type 

(double) 

Range -1E15 - 1E15 

Preset Value 0 

Unit F 

 

Examples: 

Set the capacitor C1 value of channel 1 model C to 1nF:  

:CALC1:EPAR:CIRC:C:C1 1E-9 

Query the capacitor C1 value of channel 2 model A:  

:CALC2:EPAR:CIRC:A:C1? 

Query Response: <number><newline><^END>  

Related keys: Analysis > Equivalent Circuit > C1 

 

 :CALC<Ch>:EPAR:CIRC:{A|B|C|D|E|F|G}:L1 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>:EPARameters:CIRCuit:{A|B|C|D|E|F|G}:L1 < number>  

:CALCulate<Ch>:EPARameters:CIRCuit:{A|B|C|D|E|F|G}:L1? 

Description: Set or query the inductance value L1 corresponding to the selected equivalent 

circuit model in the selected channel 

Parameters: 

Parameters Numerical Value 
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Description Inductance value L1 

Data Type Double precision type 

(double) 

Range -1E15 - 1E15 

Preset Value 0 

Unit H 

 

Examples: 

Set the inductor L1 value of channel 1 model C to 1nH: 

:CALC1:EPAR:CIRC:C:L1 1E-9 

Query the inductor L1 value of channel 2 model A:  

:CALC2:EPAR:CIRC:A:L1? 

Query Response: <number><newline><^END>  

Related keys: Analysis > Equivalent Circuit > L1 

 

 :CALC<Ch>:EPAR:CIRC:{A|B|C|D|E|F|G}:R1 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>:EPARameters:CIRCuit:{A|B|C|D|E|F|G}:R1 < number>  

:CALCulate<Ch>:EPARameters:CIRCuit:{A|B|C|D|E|F|G}:R1? 

Description: Set or query the resistance value R1 corresponding to the selected equivalent 

circuit model in the selected channel 

Parameters: 

Parameter Numerical Value 

Description Resistance value R1 

Data Type Double precision type 

(double) 

Range -1E15 - 1E15 

Preset Value 0 

Unit Ω 

 

Examples: 

Set the resistor R1 value of channel 1 model C to 1kΩ:  

:CALC1:EPAR:CIRC:C:R1 1E3 

Query the resistor R1 value of channel 2 model A:  
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:CALC2:EPAR:CIRC:A:R1? 

Query Response: <number><newline><^END>  

Related keys: Analysis > Equivalent Circuit > R1 

 

 :CALC<Ch>:EPAR:CIRC:E:C0 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>:EPARameters:CIRCuit:E:C0 < number>  

:CALCulate<Ch>:EPARameters:CIRCuit:E:C0? 

Description: Set or query the capacitance value C0 corresponding to the equivalent circuit 

model E in the selected channel 

Parameters: 

Parameters Numerical Value 

Description Capacitance value C0 

Data Type Double precision type 

(double) 

Range -1E15 - 1E15 

Preset Value 0 

Unit F 

 

Examples: 

Set the capacitor C0 value of channel 1 model E to 1nF:  

:CALC1:EPAR:CIRC:E:C0 1E-9 

Query the capacitor C0 value of channel 2 model E:  

:CALC2:EPAR:CIRC:E:C0? 

Query Response: <number><newline><^END>  

Related keys: Analysis > Equivalent Circuit > C0 

 

 :CALC<Ch>:EPAR:CIRC:{F|G}:R1 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>:EPARameters:CIRCuit:{F|G}:R0 < number>  

:CALCulate<Ch>:EPARameters:CIRCuit:{F|G}:R0? 
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Description: Set or query the resistance value R0 corresponding to the selected equivalent 

circuit model F or G in the selected channel 

Parameters: 

Parameter Numerical Value 

Description Resistance value R0 

Data Type Double precision type 

(double) 

Range -1E15 - 1E15 

Preset Value 0 

Unit Ω 

 

Examples: 

Set the resistor R0 value of channel 1 model F to 1kΩ:  

:CALC1:EPAR:CIRC:F:R0 1E3 

Query the resistor R0 value of channel 2 model G:  

:CALC2:EPAR:CIRC:G:R0? 

Query Response: <number><newline><^END>  

Related keys: Analysis > Equivalent Circuit > R0 

 

 :CALC<Ch>:EPAR:DISP 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>:EPARameters:DISPlay[:STATe] {ON|OFF|1|0}  

:CALCulate<Ch>:EPARameters:DISPlay[:STATe]? 

Description: Set or query the on-off state of the equivalent circuit model and calculation results 

displayed on the screen 

Parameters: 

Parameters Selection Option 

Description Display 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value OFF 

 

Examples: 
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Set the equivalent circuit display of channel 1 to ON:  

:CALC1:EPAR:DISP ON 

Query the on-off state of the equivalent circuit display of channel 2:  

:CALC2:EPAR:DISP? 

Query Response: {1|0}< newline><^END> 

Related keys: Analysis > Equivalent Circuit > Display 

 :CALC<Ch>:EPAR:SIM 

Command Type: Command 

Syntax: :CALCulate<Ch>:EPARameters:SIMulate[:IMMediate] 

Description: Immediately perform an equivalent circuit simulation calculation for the current 

set value of the selected channel and write the data into the trace and memory trace 

Related keywords: Analysis > Equivalent Circuit > Stimulate 

 

 :CALC<Ch>:EPAR:SIM:AUTO 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>:EPARameters:SIMulate:AUTO {ON|OFF|1|0}  

:CALCulate<Ch>:EPARameters:SIMulate:AUTO? 

Description: Set or query the open state of the automatic equivalent circuit simulation 

calculation of the selected channel. When it is set to ON, if an equivalent circuit parameter is 

modified, the simulation calculation will be performed automatically and the measurement results 

will be written to the trace and memory trace; when it is set to OFF, the results will not be written to 

the trace after the equivalent circuit simulation calculation is completed. 

Parameters: 

Parameter Selection Option 

Description Stimulate 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value OFF 

 

Examples: 

Set the equivalent circuit auto simulation of channel 1 to ON:  

:CALC1:EPAR:SIM:AUTO ON 
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Query the on-off state of the equivalent circuit auto simulation of channel 2:  

:CALC2:EPAR:SIM:AUTO? 

Query Response: {1|0}< newline><^END> 

Related keys: Analysis > Equivalent Circuit > Stimulate 

 

 :CALC<Ch>:LIM 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:LIMit[:STATe] {ON|OFF|1|0}  

:CALCulate<Ch>[:SELected]:LIMit[:STATe]? 

Description: Set or query the on-off state of the sweep limit test 

Parameters: 

Parameter Selection Option 

Description Trace sweep state 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value OFF 

 

Examples: 

Set the trace sweep of channel 1 to ON: 

:CALC1:LIM ON 

Query the on-off state of the trace sweep of channel 2:  

:CALC2:LIM? 

Query Response: {1|0}< newline><^END> 

Related keys: Analysis > Limit Setup > Limit State 

 

 :CALC<Ch>:LIM:ADD 

Command Type: Command 

Syntax: 

:CALCulate<Ch>[:SELected]:LIMit:ADD<number1>,<number2>,{ABS|DEV|PER|DPE

R},<number3>,<number4> 
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Description: add a segment of limit line for the specified channel and trace, this command only 

takes effect after the limit reference value is set 

Parameter: 

Parameter Data 

Description Limit line parameter: 

<Number 1>: the start X value of the limit line, the value 

should be between the start value and the end value of the 

trace scanning, if not, it will be adjusted automatically; 

<Number 2>: the ending X value of the limit line, the value 

should be taken between the set trace scanning start value 

and end value, and not less than the starting X value, if not, 

it will be adjusted automatically; 

{ABS|DEV|PER|DPER}: the upper and lower limit types 

of the limit line, which are Absolute Value| Deviation value 

|Percentage| Deviation Percentage; 

<number 3>: the upper limit of the limit line, if the upper 

and lower limit types are percentage or deviation 

percentage, then the value is a percentage; 

<number 4>: the lower limit of the limit line, if the upper 

and lower limit types are percentage or deviation 

percentage, then the value is a percentage 

Attention If the parameters are wrong or not all parameters are set, an 

error will be returned 

 

Example: 

Add a limit line for the selected trace of channel 1: frequency 1MHz-10MHz, deviation 

percentage type, the upper and lower limits of the limit line are -10%-20%:  

CALC1:LIM:ADD 1E6,1E7,DPER,20,-10 

 

 :CALC<Ch>:LIM:CLE 

Command Type: Command 

Syntax: 

:CALCulate<Ch>[:SELected]:LIMit:CLEar 

Description: Clear all the selected channels and traces. 

Related Keywords: Analysis > Limit Setup > Edit Limit Line >Clear 

 

 :CALC<Ch>:LIM:REF 



 206 

Command Type: Command 

Syntax: 

:CALCulate<Ch>[:SELected]:LIMit:REFerence 

Description: Set the limit reference value for selected channel and trace, changing the trace 

parameter will clear the reference value. 

Related key: Analysis> Limit Setup > Data→Reference 

 

 :CALC<Ch>:LIM:SHOW 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:LIMit:SHOW[:STATe] {ON|OFF|1|0}  

:CALCulate<Ch>[:SELected]:LIMit:SHOW[:STATe]? 

Description: Set or query the display state of the selected trace scanning limit line 

Parameters: 

Parameters Option 

Description Trace sweep limit line state 

Data type Boolean 

Range ON|OFF|1|0 

Default value OFF 

 

Example: 

Set the trace scanning limit line state of channel 1 to ON:  

:CALC1:LIM:SHOW ON 

To query the state of the trace scanning limit line of channel 2:  

:CALC2:LIM:SHOW? 

Query Answer: {1|0}<newline><^END> 

Related key: Analysis>Limit Setup>Limit Line 

 

 :CALC<Ch>:LIM:TEST 

Command Type: Query 

Syntax: 

:CALCulate<Ch>[:SELected]:LIMit:TEST? 
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Description: Query the trace scanning limit result of the currently selected trace. 

Example: 

Query the trace scanning limit result of the selected trace of channel 1:  

:CALC1:LIM:TEST? 

Query response: {1|0}<newline><^END> 

 

 :CALC<Ch>:LIM:TEST:ALL 

Command Type: Query 

Syntax: 

:CALCulate<Ch>[:SELected]:LIMit:TEST:ALL? 

Description: Query the combined result of trace scanning limit and marker limit for the 

currently selected trace. 

Example: 

Query the combined limit result of the selected trace of channel 1:  

:CALC1:LIM:TEST:ALL? 

Query response: {1|0}<newline><^END> 

Special instruction: If the trace scanning limit is not turned on, it will be judged as limit failure; 

if the marker is not activated or the marker limit is not turned on, the 

marker will be skipped. 

 

 :CALC<Ch>:MARK<Mk> 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MARKer<Mk>[:STATe] {ON|OFF|1|0}  

:CALCulate<Ch>[:SELected]:MARKer<Mk>[:STATe]? 

Description: Set or query the on-off state of the selected marker of the selected channel 

Parameters: 

Parameter Selection Option 

Description Marker state 

Data Type Boolean (Boolean) 

Range ON|OFF|1|0 

Preset Value OFF 
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Examples: 

Set the marker 1 of channel 1 to ON:  

:CALC1:MARK1 ON 

Query the on-off state of marker 2 of channel 2:  

:CALC2:MARK2? 

Query Response: {1|0}< newline><^END> 

Related keys: Marker > Marker 1 - Marker 9, Reference Marker 

 

 :CALC<Ch>:MARK<Mk>:ACT 

Command Type: Command 

Syntax: :CALCulate<Ch>[:SELected]:MARKer<Mk>:ACTivate 

Description: Activate the selected marker of the selected channel in the command 

Related keys: Marker > Marker 1 - Marker 9, Reference Marker 

 :CALC<Ch>:MARK:AOFF 

Command Type: Command 

Syntax: :CALCulate<Ch>[:SELected]:MARKer:AOFF 

Description: Turn off all markers in the selected channel 

Related keys: Marker > Clear Markers > All OFF 

 

 :CALC<Ch>:MARK:COUP 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MARKer:COUPle {ON|OFF|1|0}  

:CALCulate<Ch>[:SELected]:MARKer:COUPle? 

Description: Set or query the on-off state of the marker couple of the selected channel 

Parameters: 

Parameter Selection Option 

Description Marker couple 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 
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Preset Value OFF 

 

Examples: 

Set the marker of channel 1 to Couple:  

:CALC1:MARK:COUP ON 

Query the marker couple state of channel 2:  

:CALC2:MARK:COUP? 

Query Response: {1|0}< newline><^END> 

Related keys: Marker Function > Discrete 

 

 :CALC<Ch>:MARK:DISC 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MARKer:DISCrete {ON|OFF|1|0}  

:CALCulate<Ch>[:SELected]:MARKer:DISCrete? 

Description: Set or query whether the marker of the selected channel set is allowed to be 

positioned between the discrete points 

Parameters: 

Parameter Selection Option 

Description Marker discrete point 

state 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value OFF 

 

Examples: 

Set the marker of channel 1 to position only to Discrete:  

:CALC1:MARK:DISC ON 

Query whether the marker of channel 2 can be positioned between the discrete 

points: :CALC2:MARK:DISC? 

Query Response: {1|0}< newline><^END> 

Related keys: Marker Function > Couple 
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 :CALC<Ch>:MARK:FUNC:DOM 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MARKer:FUNCtion:DOMain[:STATe] {ON|OFF|1|0} 

:CALCulate<Ch>[:SELected]:MARKer:FUNCtion:DOMain[:STATe]? 

Description: Set or query the open state of the marker search range of the selected channel 

Parameters: 

Parameter Selection Option 

Description Marker search range 

state 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value OFF 

 

Examples: 

Set the marker search unit of channel 1 to ON:  

:CALC1:MARK:FUNC:DOM ON 

Query the open state of the marker search range of channel 2:  

:CALC2:MARK:FUNC:DOM? 

Query Response: {1|0}< newline><^END> 

Related keys: Marker Search > Search Range > Search Range 

 

 :CALC<CH>:MARK:FUNC:DOM:STAR 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MARKer:FUNCtion:DOMain:STARt < number>  

:CALCulate<Ch>[:SELected]:MARKer:FUNCtion:DOMain:STARt? 

Description: Set or query the start value of the marker search range 

Parameters: 

Parameter Numerical Value 

Description Search range start 

value 
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Data Type Double precision type 

(double) 

Unit Hz|V|A 

 

Examples: 

Set the search range start value of channel 1 to 1 kHz:  

:CALC1:MARK:FUNC:DOM:STAR 1E3 

Query the search range start value of channel 2: 

:CALC2:MARK:FUNC:DOM:STAR? 

Query Response: {< number>}<newline><^END> 

Related keys: Marker Search > Search Range > Start 

 

 :CALC<Ch>:MARK:FUNC:DOM:STOP 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MARKer:FUNCtion:DOMain:STOP < number>  

:CALCulate<Ch>[:SELected]:MARKer:FUNCtion:DOMain:STOP? 

Description: Set or query the termination value of the marker search range 

Parameters: 

Parameter Numerical Value 

Description Search range 

termination value 

Data Type Double precision type 

(double) 

Unit Hz|V|A 

 

Examples: 

Set the search range termination value of channel 1 to 1 MHz:  

:CALC1:MARK:FUNC:DOM:STOP 1E6 

Query the search range termination value of channel 2: 

:CALC2:MARK:FUNC:DOM:STOP? 

Query Response: {< number>}<newline><^END> 

Related keys: Marker Search > Search Range > Stop 
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 :CALC<Ch>:MARK<Mk>:FUNC:EXEC 

Command Type: Command 

Syntax:  

:CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:EXECute  

Description: Immediately perform a marker search 

Related keywords: Marker Search > Max | Min | Peak | Target | Multi Peak | Multi Target 

 

 :CALC<Ch>:MARK:FUNC:MULT:PEXC 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MARKer:FUNCtion:MULTi:PEXCursion < number>  

:CALCulate<Ch>[:SELected]:MARKer:FUNCtion:MULTi:PEXCursion? 

Description: Set or query the multiple peak excursion of the selected channel 

Parameters: 

Parameter Numerical Value 

Description Peak excursion 

Data Type Double precision type 

(double) 

Range 0 - 1E15 

Preset Value 3 

Unit Depends on 

measurement 

parameters 

 

Examples: 

Set the multiple peak excursion of channel 1 to 1kΩ:  

:CALC1:MARK:FUNC:MULT:PEXC 1E3 

Query the multiple peak excursion of channel 2:  

:CALC2:MARK:FUNC:MULT:PEXC? 

Query Response: <number><newline><^END>  

Related keys: Marker Search > Multi Peak > Peak Excursion 
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 :CALC<Ch>:MARK:FUNC:MULT:PPOL 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MARKer:FUNCtion:MULTi:PPOLarity 

{POSitive|NEGative|BOTH}  

:CALCulate<Ch>[:SELected]:MARKer:FUNCtion:MULTi:PPOLarity? 

Description: Set or query the peak polarity of the multiple peaks of the selected channel 

Parameters: 

Parameter Selection Option 

Description Peak polarity 

Data Type Character string type 

(String) 

Range POSitive|NEGative|BOTH 

Preset Value BOTH 

 

Examples: 

Set the multiple peak polarity of channel 1 to peak: :CALC1:MARK:FUNC:MULT:PPOL POS 

Query the multiple peak polarity of channel 2: :CALC2:MARK:FUNC:MULT:PPOL? 

Query Response: {POS|NEG|BOTH}< newline><^END> 

Related keys: Marker Search > Multi Peak > Peak Polarity 

 

 :CALC<Ch>:MARK:FUNC:MULT:TARG 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MARKer:FUNCtion:MULTi:TARGet < number>  

:CALCulate<Ch>[:SELected]:MARKer:FUNCtion:MULTi:TARGet? 

Description: Set and query the target value of the multiple target values of the selected channel 

Parameter: 

Parameter Numerical Value 

Description Target value 

Data Type Double precision type 

(double) 

Range -1E15 - 1E15 

Preset Value 0 
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Unit Depends on 

measurement 

parameters 

 

Examples: 

Set the target of the multiple target value of channel 1 to 1kΩ: 

 :CALC1:MARK:FUNC:MULT:TARG 1E3 

Query the target of the multiple target values of channel 2:  

 :CALC2:MARK:FUNC:MULT:TARG? 

Query Response: <number><newline><^END>  

Related keys: Marker Search > Multi Target > Target 

 

 :CALC<Ch>:MARK:FUNC:MULT:TTR 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MARKer:FUNCtion:MULTi:TTRansition 

{POSitive|NEGative|BOTH}  

:CALCulate<Ch>[:SELected]:MARKer:FUNCtion:MULTi:TTRansition? 

Description: Set or query the transition of the multiple target values of the selected channel 

Parameters: 

 

Parameter Selection Option 

Description Target transition 

Data Type Character string type 

(String) 

Range POSitive|NEGative|BOTH 

Preset Value BOTH 

 

Examples: 

Set the transition of the multiple target value of channel 1 to positive:  

:CALC1:MARK:FUNC:MULT:TTR POS 

Query the transition of the multiple target value of channel 2:  

:CALC2:MARK:FUNC:MULT:TTR? 

Query response: {POS|NEG|BOTH}< newline><^END> 
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Related keys: Marker Search > Multi Target > Target Transition 

 

 :CALC<Ch>:MARK:FUNC:MULT:TYPE 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MARKer:FUNCtion:MULTi:TYPE {OFF|PEAK|TARGet}  

:CALCulate<Ch>[:SELected]:MARKer:FUNCtion:MULTi:TYPE? 

Description: Set or query whether the marker search of the current channel is multiple search 

Parameters: 

Parameter Selection Option 

Description Multiple search 

Data Type Character string type 

(String) 

Range OFF|PEAK|TARGet 

Preset Value BOTH 

 

Examples: 

Set the marker search of channel 1 to multiple peak:  

:CALC1:MARK:FUNC:MULT:TYPE PEAK 

Query whether the channel 2 is multiple marker search:  

:CALC2:MARK:FUNC:MULT:TYPE? 

Query Response: {OFF|PEAK|TARG}< newline><^END> 

 

 :CALC<Ch>:MARK<Mk>:FUNC:PEXC 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:PEXCursion < number>  

:CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:PEXCursion? 

Description: Set or query the peak excursion of the selected marker of the selected channel 

Parameters: 

Parameter Numerical Value 

Description Peak excursion 
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Data Type Double precision type 

(double) 

Range 0 - 1E15 

Preset Value 3 

Unit Depends on 

measurement 

parameters 

 

Examples: 

Set the peak excursion of channel 1 marker 1 to 1kΩ:  

:CALC1:MARK1:FUNC:PEXC 1E3 

Query the peak excursion of channel 2 marker 2:  

:CALC2:MARK2:FUNC:PEXC? 

Query Response: <number><newline><^END>  

Related keys: Marker Search > Peak > Peak Excursion 

 

 :CALC<Ch>:MARK<Mk>:FUNC:PPOL 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:PPOLarity 

{POSitive|NEGative|BOTH}  

:CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:PPOLarity? 

Description: Set or query the peak polarity of the selected marker peak of the selected channel 

Parameters: 

Parameter Selection Option 

Description Peak polarity 

Data Type Character string type 

(String) 

Range POSitive|NEGative|BOTH 

Preset Value BOTH 

 

Examples: 

Set the peak polarity of the channel 1 marker to peak:  

:CALC1:MARK1:FUNC:PPOL POS 

Query the peak polarity of channel 2 marker 2:  
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:CALC2:MARK2:FUNC:PPOL? 

Query Response: {POS|NEG|BOTH}< newline><^END> 

Related keys: Marker Search > Peak > Peak Polarity 

 

 :CALC<Ch>:MARK<Mk>:FUNC:TARG 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:TARGet < number>  

:CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:TARGet? 

Description: Set and query the target value of the selected marker of the selected channel 

Parameters: 

Parameters Numerical Value 

Description Target value 

Data Type Double precision type 

(double) 

Range -1E15 - 1E15 

Preset Value 0 

Unit Depends on 

measurement 

parameters 

 

Examples: 

Set the target of channel 1 marker 1 target value to 1kΩ:  

:CALC1:MARK1:FUNC:TARG 1E3 

Query the target of channel 2 marker 2 target value:  

:CALC2:MARK2:FUNC:TARG? 

Query Response: <number><newline><^END>  

Related keys: Marker Search > Target > Target 

 :CALC<Ch>:MARK<Mk>:FUNC:TRAC 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:TRACking {ON|OFF|1|0}  

:CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:TRACking? 
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Description: Set or query the open state of the marker tracking function of the selected marker 

of the selected channel. When the marker tracking is turned on, the marker will perform a marker 

search immediately after each sweep cycle is completed 

Parameters: 

Parameter Selection Option 

Description Marker tracking state 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value OFF 

 

Examples: 

Turn on the marker tracking of channel 1 marker 1:  

:CALC1:MARK1:FUNC:TRAC ON 

Query the open state of the marker tracking of channel 2 marker 2:  

:CALC2:MARK2:FUNC:TRAC? 

Query Response: {1|0}< newline><^END> 

Related keys: Marker Search > Tracking 

 

 :CALC<Ch>:MARK<Mk>:FUNC:TTR 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:TTRansition 

{POSitive|NEGative|BOTH}  

:CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:TTRansition? 

Description: Set or query the transition of the target value of the selected marker of the selected 

channel 

Parameters: 

Parameter Selection Option 

Description Target transition 

Data Type Character string type 

(String) 

Range POSitive|NEGative|BOTH 

Preset Value BOTH 
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Examples: 

Set the target transition of channel 1 marker 1 to Positive:  

:CALC1:MARK1:FUNC:TTR POS 

Query the target transition of channel 2 marker 2:  

:CALC2:MARK2:FUNC:TTR? 

Query Response: {POS|NEG|BOTH}< newline><^END> 

Related keys: Marker Search > Target > Target Transition 

 

 :CALC<Ch>:MARK<Mk>:FUNC:TYPE 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:{MAXimum|MINimum|PEAK|LPEa

k|RPEak|TARGet|LTARget|RTARget} 

:CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:TYPE? 

Description: Set or query the mode of the current marker search 

Parameters: 

Parameter Selection Option 

Description Marker search mode 

Data Type Character string type (String) 

Range MAXimum: Search maximum 

value 

MINimum: Search minimum 

value 

PEAK: Search peak value 

LPEak: Search left peak value 

RPEak: Search right peak value 

TARGet: Search target value 

LTARget: Search left target 

value 

RTARget: Search right target 

value 

Preset Value BOTH 

 

Examples: 

Set the marker search mode of channel 1 to search maximum:  

:CALC1:MARK:FUNC:TYPE MAX 
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Query the marker search mode of channel 2:  

:CALC2:MARK:FUNC:TYPE? 

Query Response: {MAX|MIN|PEAK|LPE|RPE|TARG|LTAR|RTAR}< newline><^END> 

Related keys: Marker Search > Max | Min | Target | Peak 

 

 :CALC<Ch>:MARK<Mk>:LIM 

Command type: command/query 

Syntax: 

:CALCulate<Ch>[:SELected]:MARKer<Mk>:LIMit {ON|OFF|1|0} 

:CALCulate<Ch>[:SELected]:MARKer<Mk>:LIMit? 

Description: Set or query the marker limit state of the selected marker 

Parameters: 

Parameter Selection Option 

Description Marker limit state 

Data Type Boolean 

Range ON|OFF|1|0 

Preset Value OFF 

Example: 

Turn on the marker limit for the current trace marker 1 of channel 1:  

:CALC1:MARK1:LIM ON 

Query the marker limit state of the current trace marker 2 of channel 1: 

:CALC1:MARK2:LIM? 

Query response: {1|0}<newline><^END> 

 

 :CALC<Ch>:MARK<Mk>:LIM:LOW 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MARKer<Mk>:LIMit:LOWer <numeric> 

:CALCulate<Ch>[:SELected]:MARKer<Mk>:LIMit:LOWer? 

Description: Set or query the lower limit of marker limit for a selected trace 

Parameter: 
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Parameter Numerical value 

Description Lower limit  

Data Type Double 

Range -1E15 – 1E15 

Preset Value 0 

Unit Depends on measurement parameter and limit type 

 

Example: 

Set the lower limit of the current trace marker 1 of channel 1 to 0.01:   

:CALC1:MARK1:LIM:LOW 0.01 

Query the lower limit of the current trace marker 2 of channel 1: 

:CALC1:MARK2:LIM:LOW?  

Query response: <number><newline><^END> 

 

 :CALC<Ch>:MARK<Mk>:LIM:REF 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MARKer<Mk>:LIMit:REFerence <numbers> 

:CALCulate<Ch>[:SELected]:MARKer<Mk>:LIMit: REFerence? 

DESCRIPTION: Set or query the reference value of the marker limit for the selected trace 

Parameters: 

Parameter Numerical value 

Description Reference value  

Data Type Double 

Range -1E15 – 1E15 

Preset Value 0 

Unit Depends on measurement parameter 

 

Example: 

Set the reference value of the current trace marker 1 of channel 1 to 100:  

:CALC1:MARK1:LIM:REF 100 

Query the reference value of the current trace marker 2 of channel 1: 

 :CALC1:MARK2:LIM:REF?  
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Query response: <number><newline><^END> 

 

 :CALC<Ch>:MARK<Mk>:LIM:TEST 

Command Type: Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MARKer<Mk>:LIMit:TEST? 

Description: Query the marker limit results for a selected trace 

Query Response: {1|0}<newline><^END> 

Description：You need to activate the marker and turn on the limit state of this marker, make 

one measurement and then query the limit result. 

 

 :CALC<Ch>:MARK<Mk>:LIM:TYPE 

Command Type: Command/Query 

Syntax 

:CALCulate<Ch>[:SELected]:MARKer<Mk>:LIMit:TYPE {ABS|DEV|PER|DPER} 

:CALCulate<Ch>[:SELected]:MARKer<Mk>:LIMit:TYPE? 

Description: Set or query the marker limit type of the selected marker 

Parameters: 

Parameter Selection Option 

Description Limit type 

Data Type String 

Range ABS: Absolute value  

DEV: Deviation  

PER: Percentage 

DPER: Deviation Percentage 

Preset Value ABS 

Instruction In Percentage and Deviation 

percentage types, upper and 

lower limits as percentages 

Example: 

Set the limit type of the current trace marker 1 of channel 1 to Deviation type:  

:CALC1:MARK1:LIM:TYPE DEV 

Query the limit type of the current trace marker 2 of channel 1:  

:CALC1:MARK2:LIM:TYPE?  
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Query response: {ABS|DEV|PER|DPER}<newline><^END> 

 

 :CALC<Ch>:MARK<Mk>:LIM:UPP 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MARKer<Mk>:LIMit:UPPer <Number> 

:CALCulate<Ch>[:SELected]:MARKer<Mk>:LIMit:UPPer? 

Description: Set or query the upper limit of marker limit for a selected marker 

Parameter: 

Parameter Numerical value 

Description Upper Limit  

Data Type Double 

Range -1E15 – 1E15 

Preset Value 0 

Unit Depends on measurement parameter and limit type 

Example: 

Set the upper limit of the current trace marker 1 of channel 1 to 1000:  

:CALC1:MARK1:LIM:UPP 1000 

Query the upper limit of the current trace marker 2 of channel 1:  

:CALC1:MARK2:LIM:UPP?  

Query response: <number><newline><^END> 

 

 :CALC<Ch>:MARK:MATH:STAT 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MARKer:MATH:STATistics[:STATe] {ON|OFF|1|0}  

:CALCulate<Ch>[:SELected]:MARKer:MATH:STATistics[:STATe]? 

Description: Set or query the open state of the marker statistics 

Parameters: 

Parameter Selection Option 

Description Marker statistics state 

Data Type Boolean type 
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(Boolean) 

Range ON|OFF|1|0 

Preset Value OFF 

 

Examples: 

Turn on the marker statistics state of channel 1:  

:CALC1:MARK:MATH:STAT ON 

Query the on-off state of the marker statistics of channel 2:  

:CALC2:MARK:MATH:STAT? 

Query Response: {1|0}< newline><^END> 

Related keys: Marker Function > Statistics 

 :CALC<Ch>:MARK:MATH:STAT:DATA 

Command Type: Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MARKer:MATH:STATistics:DATA? 

Description: Query the current statistics data 

Query Response: {< number1>},{< number2>},{< number3>},{< 

number4>}<newline><^END> 

< Number 1>: Range span 

< Number 2>: Average value 

< Number 3>: Standard deviation 

< Number 4>: Peak-to-peak value 

 

 :CALC<Ch>:MARK:REF 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MARKer:REFerence[:STATe] {ON|OFF|1|0}  

:CALCulate<Ch>[:SELected]:MARKer:REFerence[:STATe]? 

Description: Set or query the on-off state of the reference marker of the selected channel 

Parameters: 

Parameter Selection Option 

Description Reference marker 
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state 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value OFF 

 

Examples: 

Turn on the reference marker of channel 1:  

:CALC1:MARK:REF ON 

Query the on-off state of the reference marker of channel 2:  

:CALC2:MARK:REF? 

Query Response: {1|0}< newline><^END> 

Related keys: Marker > Ref Marker Mode 

 

 :CALC<Ch>:MARK<Mk>:SET 

Command Type: Command 

Syntax: 

:CALCulate<Ch>[:SELected]:MARKer<Mk>:SET {CENTer|STARt|STOP|RLEVel|ZOOM} 

Description: Set the position of the selected marker of the selected channel to the Stimulus 

Parameters: 

Parameter Selection Option 

Description Stimulus type 

Data Type Character string type (String) 

Range STARt: Set the marker position to the stimulus 

start value 

STOP: Set the marker position to the stimulus 

termination value 

CENTer: Set the marker position to the stimulus 

center value 

RLEVel: Set the marker value to the reference 

value of the response value 

ZOOM: Zoom the horizontal axis according to the 

set zoom ratio 

 

Examples: 

Set the position of channel 1 marker 1 to the stimulus center value:  
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:CALC1:MARK1:SET CENT 

Related keys: Marker Function > Marker→Start | Marker→Stop | Marker→Center | 

Marker→Reference | Marker Zoom 

 

 :CALC<Ch>:MARK<Mk>:X 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MARKer<Mk>:X[:DATA] < number>  

:CALCulate<Ch>[:SELected]:MARKer<Mk>:X[:DATA]? 

Description: Set or query the stimulus value of the selected marker of the selected channel 

Examples: 

Set the stimulus value of channel 1 marker 1 to 1 MHz:  

:CALC1:MARK1:X 1E6 

Query the stimulus value of channel 2 marker 2:  

:CALC2:MARK2:X? 

Query Response: <number><newline><^END> 

Related keys: Marker > Marker1 - Marker9 | Ref Marker 

 

 :CALC<Ch>:MARK<Mk>:X:POS 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MARKer<Mk>:X:POSition < number>  

:CALCulate<Ch>[:SELected]:MARKer<Mk>:X:POSition? 

Description: Set or query the position of the selected marker of the selected channel relative to 

the measurement point 

Parameters: 

Parameter Numerical Value 

Description Measurement point 

position value 

Data Type Double precision type 

(double) 

Range 1 - Number of 
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measurement points 

Preset Value 1 

 

Examples: 

Set the position of channel 1 marker 1 to 100:  

:CALC1:MARK1:X:POS 100 

Query the position of channel 2 marker 2:  

:CALC2:MARK2:X:POS? 

Query Response: <number><newline><^END> 

 

 :CALC<Ch>:MARK<Mk>:Y 

Command Type: Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MARKer<Mk>:Y? 

Description: Query the measured (response) value of the selected marker of the selected 

channel 

Query Response: <number><newline><^END> 

 

 :CALC<Ch>:MARK:ZAP 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MARKer:ZAPerture < number>  

:CALCulate<Ch>[:SELected]:MARKer:ZAPerture? 

Description: Set or query the marker zooming aperture of the selected channel 

Parameters: 

Parameter Numerical Value 

Description Zooming aperture 

Data Type Double precision type 

(double) 

Range 0.01 - 100 

Preset Value 10 

Unit % 

 

Examples: 



 228 

Set the zooming aperture of channel 1 to 20%:  

:CALC1:MARK:ZAP 20 

Query the zooming aperture of channel 1: 

:CALC2:MARK:ZAP? 

Query Response: <number><newline><^END> 

Related keys: Marker Function > Zooming Aperture 

 

 :CALC<Ch>:MATH:FUNC 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MATH:FUNCtion 

{NORMal|DIVide|MULTiply|SUBTract|ADD}  

:CALCulate<Ch>[:SELected]:MATH:FUNCtion? 

Description: Set or query the data math mode of the selected channel. When the memory trace 

of the trace does not exist, only NORMal can be set; when the number of measurement points of the 

channel is changed, the value is automatically modified to NORMal 

Parameters: 

Parameter Selection Option 

Description Data math type 

Data Type Character string type (String) 

Range NORMal: DATA (no arithmetic) 

DIVide: DATA/MEM 

MULTiply: DATA*MEM 

SUBTract: DATA-MEM 

ADD: DATA+MEM 

DATA refers to the data in the measurement trace, 

MEM refers to the data in the memory trace 

Preset Value NORMal 

 

Examples: 

Set the data math for the currently selected trace of channel 1 to ADD:  

:CALC1:MATH:FUNC ADD 

Query the data math for the currently selected trace of channel 2:  

:CALC2:MATH:FUNC? 

Query Response: {NORM|DIV|MULT|SUBT|ADD}< newline><^END> 
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Related keys: Display > Data Math 

 

 :CALC<Ch>:MATH:MEM 

Command Type: Command 

Syntax: :CALCulate<Ch>[:SELected]:MATH:MEMorize 

Description: Copy the measurement data of the current trace of the selected channel to the 

corresponding memory trace 

Related keys: Display > Data→Mem 

 

 :CALC<Ch>:MATH:OFFS 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MATH:OFFSet < number>  

:CALCulate<Ch>[:SELected]:MATH:OFFSet? 

Description: Set or query the data math offset of the current trace of the selected channel 

Parameters: 

Parameter Numerical Value 

Description Data math offset 

Data Type Double precision type 

(double) 

Range -1E15 - 1E15 

Preset Value 0 

Unit Depends on 

measurement 

parameters 

 

Examples: 

Set the offset of the current trace of channel 1 to 1k:  

:CALC1:MATH:OFFS 1E3 

Query the offset of the current trace of channel 2:  

:CALC2:MATH:OFFS? 

Query Response: <number><newline><^END> 

Related keys: Display > Data Math Offset 
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 :CALC<Ch>:MST 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>[:SELected]:MSTatistics[:STATe] {ON|OFF|1|0}  

:CALCulate<Ch>[:SELected]:MSTatistics[:STATe]? 

Description: Set or query the on-off state of the statistics of the selected channel 

Parameters: 

Parameter Selection Option 

Description Statistics state 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value OFF 

 

Examples: 

Turn on the statistics of channel 1:  

:CALC1:MST ON 

Query the on-off state of the statistic of channel 2:  

:CALC2:MST? 

Query Response: {1|0}< newline><^END> 

Related keys: Marker Function > Statistics 

 

 :CALC<Ch>:MST:DATA 

Command Type: Query 

Syntax:  

:CALCulate<Ch>[:SELected]:MSTatistics:DATA? 

Description: Query the statistical values of the selected channel 

Query Response: {< number1> },{< number2> },{< number3> },{< 

number4> }<newline><^END> 

< Number 1>: Range span 

< Number 2>: Average value 
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< Number 3>: Standard deviation 

< Number 4> : Peak-to-peak value 

 

 :CALC<Ch>:OSCA:DATA 

Command Type: Query 

Syntax:  

:CALCulate<Ch>:OSweepalysis:DATA? 

Description: Query the parameters of OSC analysis of the selected channel  

Parameters: 

Parameter Numerical Value 

Description OSC analysis parameters 

The query returns 18 values, the meaning of each value is 

as follows: 

< Number 1>: Free capacitance Ct 

< Number 2>: Free loss Dt 

< Number 3>: Resonance frequency Fs 

< Number 4>: Anti-resonance frequency Fp 

< Number 5>: Impedance minimum Zmin 

< Number 6>: Impedance maximum Zmax 

< Number 7>: Conductance maximum Gmax 

< Number 8>: Half-power point frequency F1 

< Number 9>: Half-power point frequency F2 

< Number 10>: Direct capacitance C0 

< Number 11>: Dynamic capacity C1 

< Number 12>: Dynamic resistance R1 

< Number 13>: Dynamic inductance L1 

< Number 14>: Phase angle maximum θmax 

< Number 15>: Phase angle maximum point frequency 

θmax Frequency 

< Number 16>: Phase angle maximum point impedance 

θmax Resistance 

< Number 17>: Phase angle maximum point capacitance 

θmax Capacity 

< Numeral 18>: Electromechanical coupling coefficient Kt 

< Number 19>: Quality factor Qm 

Data Type Double precision type (double) 

 

Query Response: {< number 1>},{< number 2>}...{< number 18>}<newline><^END> 
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 :CALC<Ch>:OSCA:EQUA 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>:OSweepalysis:EQUAtion {1|2}  

:CALCulate<Ch>:OSweepalysis:EQUAtion? 

Description: Set or query the equation of calculating the quality factor Qm in the OSC analysis 

of the selected channel  

Parameters: 

Parameter Numerical Value 

Description Equation serial number 

Data Type Numeric type (Integer) 

Range 1|2 

s
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In the above equation: 

Qm: Quality factor 

Fs: Resonance frequency 

F1, F2: Half-power point and F2 > F1 

Fp: Anti-resonance frequency 

R: Impedance min. 

Ct: Free capacitance 

Preset Value 1 

 

Examples: 

Set the Qm calculation equation of channel 1 to equation 1:  

:CALC1:OSCA:EQUA 1 

Query the Qm equation of channel 2: 

:CALC2:OSCA:EQUA? 

Query Response: {1|2}< newline><^END> 

Related keys: Analysis > OSC Analysis > Q Equation 

 

 :CALC<Ch>:OSCA:STAT 
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Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>:OSweepalysis:STATe {ON|OFF|1|0}  

:CALCulate<Ch>:OSweepalysis:STATe? 

Description: Set or query the OSC analysis state of the selected channel, and it is effective only 

when the sweep mode of the selected channel is sweep 

Parameters: 

Parameter Selection Option 

Description OSC analysis state 

Data Type Boolean type (Boolean) 

Range ON|OFF|1|0 

Preset Value OFF 

 

Examples: 

Turn on the OSC analysis of channel 1:  

:CALC1:OSCA:STAT ON 

Query the on-off state of the OSC analysis of channel 2:  

:CALC2:OSCA:STAT? 

Query Response: {1|0}< newline><^END> 

Related keys: Analysis > OSC Analysis > State 

 

 :CALC<Ch>:PAR:COUN 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>:PARameter:COUNt <number>  

:CALCulate<Ch>:PARameter:COUNt? 

Description: Set or query the number of traces of the selected channel 

Parameters: 

Parameters Numerical Value 

Description Number of traces 

Data Type Numeric type 

(Integer) 

Range 1|2|3|4 
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Preset Value 2 

 

Examples: 

Set the number of traces of channel 1 to 4:  

:CALC1:PAR:COUN 4 

Query the number of traces of channel 2:  

:CALC2:PAR:COUN? 

Query Response: {1|2|3|4}< newline><^END> 

Related keys: Display > Num of Traces 

 

 :CALC<Ch>:PAR<Tr>:DEF 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>:PARameter<Tr>:DEFine 

{Z|Y|R|X|G|B|LS|LP|CS|CP|RS|RP|Q|D|TZR|TZD|TYR |TYD|VAC|IAC}  

:CALCulate<Ch>:PARameter<Tr>:DEFine? 

Description: Set or query the measurement parameters of the selected trace of the selected 

channel 

Parameters: 

Parameter Selection Option 

Description Sweep measurement parameters 

Data Type Character string type (String) 

Range Z: Absolute impedance value 

Y: Absolute admittance value 

TZR: Impedance phase (radian) 

TZD: Impedance phase (angle)  

TYR: admittance phase (radian) 

TYD: admittance phase (angle) 

RS: Equivalent circuit series resistance 

RP: Equivalent circuit parallel resistance 

LS: Equivalent circuit series inductance 

LP: Equivalent circuit parallel inductance 

CS: Equivalent circuit series capacitance 

CP: Equivalent circuit parallel capacitance 

R: Equivalent circuit resistance 

G: Equivalent circuit conductance 

X: Equivalent circuit reactance 
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B: Equivalent circuit susceptance 

Q: Quality factor 

D: Dissipation factor 

VAC: Signal source AC voltage 

IAC: Signal source AC current 

IMP: Complex Z 

ADM: Complex Y 

ER: Relative permittivity |εr| (requires permittivity 

module support) 

ER1: Relative permittivity real part εr' (requires 

permittivity module support) 

ER2: Relative permittivity imaginary part εr'' (requires 

permittivity module support) 

U1: Complex permeability real part μ' (requires 

troidalcore module support)  

U2: Complex permeability imaginary part μ'' (requires 

troidalcore module support)  

TAN: Phase tan δ (requires troidalcore module support)  

 

Examples: 

Set the measurement parameters of channel 1 trace 1 to the equivalent series resistance:  

:CALC1:PAR1:DEF RS  

Query the measurement parameters of channel 2 trace 2:  

:CALC2:PAR2:DEF? 

Query Response: 

{Z|Y|R|X|G|B|LS|LP|CS|CP|RS|RP|Q|D|TZR|TZD|TYR|TYD|VAC|IAC|ER|ER1|ER2|U1|U2|TAN} 

<newline> <^END> 

Related keys: Meas > Trace1 | Trace2 | Trace3 | Trace4 

 

 :CALC<Ch>:PAR<Tr>:SEL 

Command Type: Command 

Syntax:  

:CALCulate<Ch>:PARameter<Tr>:SELect 

Description: Set the selected trace of the selected channel as the active trace 

Examples: 

Set the channel 1 trace 1 as the active trace: :CALC1:PAR1:SEL 
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 :CALC<Ch> :PERM:A1 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>:PERMittivity:A1 {ON|OFF|1|0} 

:CALCulate<Ch>:PERMittivity:A1? 

Description: Set or query the electrode in the calculation of the permittivity of the selected 

channel; this command must be enabled with the permittivity permission before it can be used. 

Parameters: 

Parameter Selection Option 

Description Display 

Data Type Boolean type (Boolean) 

Range ON|OFF|1|0 

Command ON: Electrode is A1 

OFF: Electrode is A2 

Preset Value ON 

Examples: 

Set the electrode of channel 1 to A1: :CALC1:PERM:A1 ON 

Query the electrode of channel 2: :CALC2:PERM:A1? 

Query Response: {1|0}< newline><^END> 

Related keys: Meas > Electrode 

 

 :CALC<Ch> :PERM:THIC 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch>:PERMittivity:THICkness <number>  

:CALCulate<Ch>:PERMittivity:THICkness? 

Description: Set or query the thickness in the calculation of the permittivity of the selected 

channel; this command must be enabled with the permittivity permission before it can be used. 

Parameters: 

Parameter Numerical Value 

Description Thickness 

Data Type Double precision type 

(double) 

Range 1E-9 - 999 
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Unit m 

Preset Value 0.01 

 

Examples: 

Set the thickness of channel 1 to 5 mm:  

:CALC1:PERM:THIC 5E-3 

Query the thickness of channel 2:  

:CALC2:PERM:THIC? 

Query Response: {< number>}<newline><^END> 

Related keys: Meas > Thickness 

 

 :CALC<Ch> :TROI:HEIG 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch> :TROIdalcore:HEIGht? 

:CALCulate<Ch> :TROIdalcore:HEIGht <number> 

Description: Set and query the troidal core height in the calculation of the troidalcore of the 

selected channel; this command must be enabled with the troidalcore permission before it can be 

used. 

Parameters: 

Parameter Numerical Value 

Description Troidal core height 

Data Type Double precision type 

(double) 

Range 1e-9 - 999 

Preset Value 0.005 

Unit m 

 

Examples: 

Set the troidal core height of channel 1 to 10mm:  

:CALC1:TROI:HEIG 0.01 

Query the troidal core height of channel 2:  

:CALC2:TROI:HEIG? 

Query Response: {< number>}<newline><^END> 
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Related keys: Meas > Troidal Core Height 

 

 :CALC<Ch> :TROI:INN 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch> :TROIdalcore:INNer? 

:CALCulate<Ch> :TROIdalcore:INNer <number> 

Description: Set and query the troidal core inner in the calculation of the troidalcore of the 

selected channel; this command must be enabled with the troidalcore permission before it can be 

used. 

Parameters: 

Parameter Numerical Value 

Description Troidal core inner 

Data Type Double precision type 

(double) 

Range 1e-9 - 999 

Preset Value 0.008 

Unit m 

 

Examples: 

Set the troidal core inner of channel 1 to 10 mm:  

:CALC1:TROI:INN 0.01 

Query the troidal core inner of channel 2:  

:CALC2:TROI:INN? 

Query Response: {< number>}<newline><^END> 

Related keys: Meas > Troidal Core Inner 

 

 :CALC<Ch> :TROI:OUT 

Command Type: Command/Query 

Syntax: 

:CALCulate<Ch> :TROIdalcore:OUTer? 

:CALCulate<Ch> :TROIdalcore:OUTer <number> 

Description: Set and query the troidal core outer in the calculation of the troidalcore of the 
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selected channel; this command must be enabled with the troidalcore permission before it can be 

used. 

Parameters: 

Parameter Numerical Value 

Description Troidal core outer 

Data Type Double precision type 

(double) 

Range 1e-9 - 999 

Preset Value 0.015 

Unit m 

 

Examples: 

Set the troidal core outer of channel 1 to 20mm:  

:CALC1:TROI:OUT 0.02 

Query the troidal core outer of channel 2:  

:CALC2:TROI:OUT? 

Query Response: {< number>}<newline><^END> 

Related keys: Meas > Troidal Core Outer 

9.2.5.3 DISPLAY 

 :DISP:MAX 

Command Type: Command/Query 

Syntax: 

:DISPlay:MAXimize {ON|OFF|1|0}  

:DISPlay:MAXimize? 

Description: Set or query whether the currently selected channel is in the maximum display 

state. When the display is maximized, only the selected channel will be displayed on the 

measurement screen. 

Parameters: 

Parameter Selection Option 

Description Channel maximization 

display 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 
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Preset Value OFF 

 

Examples: 

Turn on the current channel maximization display:  

:DISP:MAX ON 

Query Response: {1|0}< newline><^END> 

Related keys: Channel Max 

 

 :DISP:SPL 

Command Type: Command/Query 

Syntax: 

:DISPlay:SPLit {D1|D1_2|D12|D1_2_3|D12_34|D1_1_2|D112|D12_33|D13_23|D123|D11_23| 

D12_13|D1234|D1_2_3_4}  

:DISPlay:SPLit? 

Description: Set or query the channel distribution method 

 
 

Parameters: 

Parameter Selection Option 
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Description Channel distribution type 

Data Type Character string type (String) 

Range D1|D1_2|D12|D1_2_3|D12_34|D1_1_2|D112|D12_33|D13_23|D123|D11_23| 

D12_13|D1234|D1_2_3_4 

Preset Value D1 

 

Examples: 

Set the channel distribution to D12:  

:DISP:SPL D12 

Query the channel distribution:  

:DISP:SPL? 

Query Response: 

{D1|D1_2|D12|D1_2_3|D12_34|D1_1_2|D112|D12_33|D13_23|D123|D11_23|D12_13|D1234|D1_2

_3_4}< newline><^END> 

Related keys: Display > Allocate Channels 

 :DISP:WIND<Ch>:ACT 

Command Type: Command 

Syntax: 

:DISPlay:WINDow<Ch>:ACTivate 

Description: Set the selected channel as the active channel. Only the currently displayed 

channel can be set, otherwise an error will be returned. 

Related keys: Channel Prev | Channel Next 

 

 :DISP:WIND<Ch>:LAB 

Command Type: Command/Query 

Syntax: 

:DISPlay:WINDow<Ch>:LABel {ON|OFF|1|0}  

:DISPlay:WINDow<Ch>:LABel? 

Description：Set or query the on-off state of the display of the Y-axis label of the measurement 

coordinate system 

Parameters: 

Parameter Selection Option 

Description Label display 
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Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value ON 

 

Examples: 

Turn on the Y-axis label display of channel 1:  

:DISP:WIND1 ON 

Query Response: {1|0}< newline><^END> 

Related keys: Display > Graticule Label 

 

 :DISP:WIND<Ch>:MAX 

Command Type: Command/Type 

Syntax: 

:DISPlay:WINDow<Ch>:MAXimize {ON|OFF|1|0}  

:DISPlay:WINDow<Ch>:MAXimize? 

Description: Set or query whether the active trace of the currently selected channel is in the 

maximum display state. When it is in the maximum display, only the active traces will be displayed 

on the channel interface 

Parameters: 

Parameter Selection Option 

Description Trace maximization 

display 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value OFF 

 

Examples: 

Turn on the trace maximization display of channel 1:  

:DISP:WIND1:MAX ON 

Query Response: {1|0}< newline><^END> 

Related keys: Trace Max 

 

 :DISP:WIND<Ch>:SPL 
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Command Type: Command/Query 

Syntax: 

:DISPlay:WINDow<Ch>:SPLit 

{D1|D1_2|D12|D1_2_3|D12_34|D1_1_2|D112|D12_33|D13_23| D123|D11_23| 

D12_13|D1234|D1_2_3_4}  

:DISPlay:WINDow<Ch>:SPLit? 

Description: Set or query the distribution methods of traces in the selected channel 

 
 

Parameters: 

Parameter Selection Option 

Description Trace distribution type 

Data Type Character string type (String) 

Range D1|D1_2|D12|D1_2_3|D12_34|D1_1_2|D112|D12_33|D13_23|D123|D11_23| 

D12_13|D1234|D1_2_3_4 

Preset Value D1 

 

Examples: 

Set the trace distribution of channel 1 to D12:  

:DISP:WIND1:SPL D12 

Query the trace distribution of channel 2:  
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:DISP:WIND2:SPL? 

Query Response: 

{D1|D1_2|D12|D1_2_3|D12_34|D1_1_2|D112|D12_33|D13_23|D123|D11_23|D12_13|D1234|D1_2

_3_4}< newline><^END> 

Related keys: Display > Allocate Trace 

 :DISP:WIND<Ch>:TRAC<Tr>:DATA 

Command Type: Command/Query 

Syntax: 

:DISPlay:WINDow<Ch>:TRACe<Tr>:DATA[:STATe] {ON|OFF|1|0}  

:DISPlay:WINDow<Ch>:TRACe<Tr>:DATA[:STATe]? 

Description: Set or query the on-off state of the data trace of the selected trace of the selected 

channel 

Parameters: 

Parameter Selection Option 

Description Data trace display 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value ON 

 

Examples: 

Turn on the data trace display of channel 1 trace 1:  

:DISP:WIND1:TRAC1:DATA ON 

Query the data trace display state of channel 2 trace 2:  

:DISP:WIND1:TRAC1:DATA? 

Query Response: {1|0}< newline><^END> 

Related keys: Display > Display 

 

 :DISP:WIND<Ch>:TRAC<Tr>:MEM 

Command Type: Command/Query 

Syntax: 

:DISPlay:WINDow<Ch>:TRACe<Tr>:MEMory[:STATe] {ON|OFF|1|0}  

:DISPlay:WINDow<Ch>:TRACe<Tr>:MEMory[:STATe]? 
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Description: Set or query the on-off state of the memory trace of the selected trace of the 

selected channel 

Parameters: 

Parameter Selection Option 

Description Memory trace display 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value OFF 

 

Examples: 

Turn on the memory trace display of channel 1 trace 1: 

:DISP:WIND1:TRAC1:MEM ON 

Query the memory trace display state of channel 2 trace 2:  

:DISP:WIND1:TRAC1:MEM? 

Query Response: {1|0}< newline><^END> 

Related keys: Display > Display 

 

 :DISP:WIND<Ch>:TRAC<Tr>:Y:AUTO 

Command Type: Command 

Syntax: 

:DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe]:AUTO 

Description: Automatically scale the Y axis of the selected trace of the selected channel 

Related keys: Scale > Auto Scale 

 

 :DISP:WIND<Ch>:TRAC<Tr>:Y:BOTT 

Command Type: Command/Query 

Syntax: 

:DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe]:BOTTom < number>  

:DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe]:BOTTom? 

Description: Set or query the minimum value of the selected trace of the selected channel when 

the vertical coordinate is logarithmic axis. This command will only be responded to when the 

vertical coordinate is logarithmic 
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Parameters: 

Parameter Numerical Value 

Description Logarithmic minimum 

value 

Data Type Double precision type 

(double) 

Range 1E-18 - 1E15 

Preset Value 10 

Unit Depends on 

measurement 

parameters 

 

Examples: 

Set the lower limit of the logarithmic axis of channel 1 trace 1 to 1000:  

:DISP:WIND1:TRAC1:Y:BOTT 1E3 

Query the lower limit of the logarithmic axis of channel 2 trace 2:  

:DISP:WIND2:TRAC2:Y:BOTT? 

Query Response: {< number>}<newline><^END> 

Related keys: Scale > Log-Y Bottom 

 

 :DISP:WIND<Ch>:TRAC<Tr>:Y:PDIV 

Command Type: Command/Query 

Syntax: 

:DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe]:PDIVision < number>  

:DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe]:PDIVision? 

Description: Set or query the scale of each region of the selected trace of the selected channel 

when the vertical coordinate is linear axis. This command will only be responded to when the 

vertical coordinate is linear 

Parameters: 

Parameter Numerical Value 

Description Division scale 

Data Type Double precision type 

(double) 

Range 1E-18 - 1E15 

Preset Value 0.01 

Unit Depends on 
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measurement 

parameters 

 

Examples: 

Scale the logarithmic axis division scale of channel 1 trace 1 to 10:  

:DISP:WIND1:TRAC1:Y:PDIV 10 

Query the division scale of channel 2 trace 2:  

:DISP:WIND2:TRAC2:Y:PDIV? 

Query Response: {< number>}<newline><^END> 

Related keys: Scale > Scale/Div 

 :DISP:WIND<Ch>:TRAC<Tr>:Y:RLEV 

Command Type: Command/Query 

Syntax: 

:DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe]:RLEVel < number>  

:DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe]:RLEVel? 

Description: Set or query the reference value of the selected trace of the selected channel when 

the vertical coordinate is linear axis. This command will only be responded to when the vertical 

coordinate is linear 

Parameters: 

Parameter Numerical Value 

Description Reference value 

Data Type Double precision type 

(double) 

Range -1E15 - 1E15 

Preset Value 99 

Unit Depends on 

measurement 

parameters 

 

Examples: 

Set the vertical coordinate reference value of channel 1 trace 1 to 1M:  

:DISP:WIND1:TRAC1:Y:RLEV 1E6 

Query the vertical coordinate reference value of channel 2 trace 2:  

:DISP:WIND2:TRAC2:Y:RLEV? 

Query Response: {< number>}<newline><^END> 
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Related keys: Scale > Reference Y Value 

 

 :DISP:WIND<Ch>:TRAC<Tr>:Y:RPOS 

Command Type: Command/Query 

Syntax: 

:DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe]:RPOSition < number>  

:DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe]:RPOSition? 

Description: Set or query the relative position of selected trace of the selected channel in the 

vertical coordinate reference value on the vertical coordinate, the value can be set from 0 to the set 

number of vertical coordinate partitions. This command will only be responded to if the vertical 

coordinate is linear 

Parameters: 

Parameter Numerical Value 

Description Reference value 

Data Type Integer 

Range 0 - 30 

Preset Value 5 

 

Examples: 

Set the position of the reference value of channel 1 trace 1 as 5:  

:DISP:WIND1:TRAC1:Y:RPOS 5 

Query the position of the reference value of channel 2 trace 2:  

:DISP:WIND2:TRAC2:Y:RPOS? 

Query Response: {< number>}<newline><^END> 

Related keys: Scale > Reference Position 

 

 :DISP:WIND<Ch>:TRAC<Tr>:Y:TOP 

Command Type: Command/Query 

Syntax: 

:DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe]:TOP < number>  

:DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe]:TOP? 

Description: Set or query the maximum value of the selected trace of the selected channel 

when the vertical coordinate is logarithmic axis. This command is only responded to when the 
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vertical coordinate is logarithmic 

Parameters: 

Parameter Numerical Value 

Description Logarithmic 

maximum value 

Data Type Double precision type 

(double) 

Range 1E-18 - 1E15 

Preset Value 10k 

Unit Depends on 

measurement 

parameters 

 

Examples: 

Set the logarithmic upper limit of channel 1 trace 1 to 1M:  

:DISP:WIND1:TRAC1:Y:TOP 1E9 

Query the logarithmic upper limit of channel 2 trace 2: 

:DISP:WIND2:TRAC2:Y:TOP? 

Query Response: {< number>}<newline><^END> 

Related keys: Scale > Log-Y Top 

 

 :DISP:WIND<Ch>:TRAC<Tr>:Y:SPAC 

Command Type: Command/Query 

Syntax: 

:DISPlay:WINDow<Ch>:TRACe<Tr>:Y:SPACing {LINear|LOGarithmic}  

:DISPlay:WINDow<Ch>:TRACe<Tr>:Y:SPACing? 

Description: Set and query the Y-axis type (linear/logarithmic axis) of the selected trace of the 

selected channel 

Parameters: 

Parameters Selection Option 

Description Y-axis type 

Data Type Character string type 

(String) 

Range LINear|LOGarithmic 

Preset Value LINear 
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Examples: 

Set the vertical coordinate of channel 1 trace 1 to the logarithmic:  

:DISP:WIND1:TRAC<Tr>:Y:SPAC LOG 

Query the vertical coordinate type of channel 2 trace 2:  

:DISP:WIND2:TRAC2:Y:SPAC? 

Query Response: {LIN|LOG}< newline><^END> 

Related keys: Format > Y-Axis 

 

 :DISP:WIND<Ch>:X:SPAC 

Command Type: Command/Query 

Syntax: 

:DISPlay:WINDow<Ch>:X:SPACing {LINear|OBASe}  

:DISPlay:WINDow<Ch>:X:SPACing? 

Description: Set and query the type of the X-axis as frequency mode | sequential mode when 

the sweep type is Segment (Segment) 

Parameters: 

Parameter Selection Option 

Description X-axis type 

Data Type Character string type 

(String) 

Range LINear: Frequency base 

OBASe: Order base 

Preset Value OBASe 

 

Examples: 

Set the horizontal coordinate of channel 1 to frequency base:  

:DISP:WIND1:X:SPAC LIN 

Query the horizontal coordinate type of channel 2:  

:DISP:WIND2:X:SPAC? 

Query Response: {LIN|OBA}< newline><^END> 

Related keys: Sweep Setup > Segment Display 
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 :DISP:WIND<Ch>:Y:DIV 

Command Type: Command/Query 

Syntax: 

:DISPlay:WINDow<Ch>:Y[:SCALe]:Divisions < number>  

:DISPlay:WINDow<Ch>:Y[:SCALe]:DIVisions? 

Description: Set and query the number of divisions of the Y-axis of the coordinate system. This 

command will only be responded to if the vertical coordinate is linear 

Parameters: 

Parameter Numerical Value 

Description Number of Y-axis 

divisions 

Data Type Numeric type 

(Integer) 

Range 4 - 30 

Preset Value 10 

 

Examples: 

Divide the Y-axis of channel 1 into 10 divisions:  

:DISP:WIND1:Y:DIV 10 

Query the number of Y-axis divisions of channel 2:  

:DISP:WIND2:Y:DIV? 

Query Response: {< number> }<newline><^END> 

Related keys: Scale > Divisions 

9.2.5.4 INIT 

 :INIT<Ch> 

Command Type: Command 

Syntax:  

:INITiate<Ch>[:IMMediate] 

Description: When the command is input, if the trigger state of the selected channel is in hold 

mode, the trigger state of the channel will be set to single mode for one sweep cycle; when the 

sweep cycle is finished, the trigger state returns to hold mode. If the trigger mode of this channel is 

not in hold mode, then return an error 

Related keys: Trigger Mode > Single 
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 :INIT<Ch>:CONT 

Command Mode: Command/Query 

Syntax: 

:INITiate<Ch>:CONTinuous {ON|OFF|1|0}  

:INITiate<Ch>:CONTinuous? 

Description: Set and query whether the trigger mode of the selected channel is continuous 

mode 

Parameters: 

Parameter Selection Option 

Description Continuous mode 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value ON 

 

Examples: 

Set the trigger mode of channel 1 to continuous mode:  

:INIT1:CONT ON 

Query whether the trigger mode of channel 2 is continuous mode:  

:INIT2:CONT? 

Query Response: {1|0}< newline><^END> 

Related keys: Trigger Mode > Continuous 

9.2.5.5 MMEMORY 

 :MMEM:_COPY 

Command Type: Command 

Syntax:  

:MMEMory:COPY "< filename1>", "< filename2>" 

Description: Copy the file from file name 1 to file name 2 

Example:  

:MMEM:COPY "D:\temp1.txt", "D:\temp2.txt" 
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 :MMEM:DEL 

Command Type: Command 

Syntax:  

:MMEMory:DEL "< filename>" 

Description: Delete the file in the specified location 

Example:  

:MMEM:DEL "D:\temp1.txt" 

 

 :MMEM:LOAD 

Command Type: Command 

Syntax:  

:MMEMory:LOAD[:STATe] "< filename>" 

Description: Load the sweep state settings file of the specified location 

Related keys: Save/Recall > Recall State > Recall State 

 

 :MMEM:LOAD:CHAN 

Command Type: Command 

Syntax:  

:MMEMory:LOAD:CHANnel[:STATe] {A|B|C|D} 

Description: Load the sweep channel state settings of the specified gear 

Related keys: Save/Recall > Recall Channel 

 

 :MMEM:LOAD:LIM 

Command Type: Command 

Syntax:  

:MMEMory:LOAD:LIMit "< filename>" 

Description: Load the sweep limit test file of the specified location 

Related keys: Analysis > Limit Test > Edit Limit Line > Import 
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 :MMEM:LOAD:SEGM 

Command Type: Command 

Syntax:  

:MMEMory:LOAD:SEGMemt "< filename>" 

Description: Load the sweep segment state settings file of the specified location 

Related keys: Sweep Setup > Edit Frequency Segment > Import 

 

 :MMEM:STOR 

Command Type: Command 

Syntax:  

:MMEMory:STORe[:STATe] "< filename>" 

Description: Save the sweep state settings file in the specified location 

Related keys: Save/Recall > Save State > Save State 

 

 :MMEM:STOR:CHAN 

Command Type: Command 

Syntax:  

:MMEMory:STORe:CHANnel[:STATe] {A|B|C|D} 

Description: Load the sweep channel state settings in the specified gear 

Related keys: Save/Recall > Save Channel 

 

 :MMEM:STOR:CHAN:CLE 

Command Type: Command 

Syntax: 

:MMEMory:STORe:CHANnel:CLEar 

Description: Clear all saved channel settings 

Related keys: Save/Recall > Save Channel > Clear States 

 

 :MMEM:STOR:EPAR 

Command Type: Command 
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Syntax:  

:MMEMory:STORe:EPARameters[:STATe] "< filename>" 

Description: Save the equivalent circuit simulation result file in the specified location 

Related keys: Analysis > Equivalent Circuit > Export 

 

 :MMEM:STOR:FDAT 

Command Type: Command 

Syntax:  

:MMEMory:STORe:FDATa "< filename>" 

Description: Save the measurement data of the current active channel of the active trace at the 

specified location 

Related keys: Save/Recall > Save Trace Data > Scope > Single 

 

 :MMEM:STOR:IMAG 

Command Type: Command 

Syntax:  

:MMEMory:STORe:IMAGe "< filename>" 

Description: Save the screenshot of the current screen in the specified location (please do not 

set the file path to the root of the C drive) 

Related keys: System > Dump Screen Image 

 

 :MMEM:STOR:LIM 

Command Type: Command 

Syntax:  

:MMEMory:STORe:LIMit "< filename>" 

Description: Save the sweep limit test settings file in the specified location 

Related keys: Analysis > Limit Test > Edit Limit Line > Export 

 

 :MMEM:STOR:SALL 

Command Type: Command/Query 
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Syntax: 

:MMEMory:STORe:SALL {ON|OFF|1|0} 

:MMEMory:STORe:SALL? 

Description: Set or query the save mode when the sweep state is saved, it only saves the 

currently displayed channels and traces, or saves all channels and traces 

Parameters: 

Parameter Selection Option 

Description Save mode 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value OFF 

 

Examples: 

Set the save mode to save all channels and traces:  

:MMEM:STOR:SALL ON 

Query the current save mode:  

:MMEM:STOR:SALL? 

Query Response: {1|0}< newline><^END> 

Related keys: Save/Recall > Channel/Trace 

 

 :MMEM:STOR:SEGM 

Command Type: Command 

Syntax:  

:MMEMory:STORe:SEGMemt "< filename>" 

Description: Save the sweep segment state settings file in the specified location 

Related keys: Sweep Setup > Edit Frequency Segment > Export 

 

 :MMEM:STOR:STYP 

Command Type: Command/Query 

Syntax: 

:MMEMory:STORe:STYPe {STATe|DSTate}  
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:MMEMory:STORe:STYPe? 

Description: Set or query the save range when the sweep state is saved, only the setup state is 

saved, or the trace data is also saved 

Parameters: 

Parameter Selection Option 

Description Scope 

Data Type Character string type (String) 

Range STATe: Save the setting state only 

DSTate: Save both setup state and trace data 

Preset Value STATe 

 

Examples: 

Set the save scope to save the setup state and trace data:  

:MMEM:STOR:STYP DST 

Query the current save scope:  

:MMEM:STOR:STYP? 

Query Response: {STAT|DST}< newline><^END> 

Related keys: Save/Recall > Save Type 

9.2.5.6 SENSE 

 :SENS:APER 

Command Type: Command/Query 

Syntax: 

:SENSe<Ch>:APERture[:TIME] {1|2|3|4|5}  

:SENSe<Ch>:APERture[:TIME]? 

Description: Set and query the sweep time of the selected channel 

Parameters: 

Parameter Selection Option 

Description Measurement time 

Data Type Numeric type 

(Integer) 

Range 1|2|3|4|5 

Preset Value 1 

 

Examples. 
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Set the measurement time of channel 1 to 2:  

:SENS1:APER 2 

Query the measurement time of channel 2:  

:SENS2:APER? 

Query Response: {1|2|3|4|5}< newline><^END> 

Related keys: Avg > Meas Time 

 

 :SENS<Ch>:AVER 

Command Type: Command/Query 

Syntax: 

:SENSe<Ch>:AVERage[:STATe] {ON|OFF|1|0}  

:SENSe<Ch>:AVERage[:STATe]? 

Description: Set or query the point average of the selected channel 

Parameters: 

Parameter Selection Option 

Description Point Average 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value OFF 

 

Examples: 

Turn on the point average of channel 1:  

:SENS1:AVER ON 

Query the point average state of channel 2:  

:SENS2:AVER? 

Query Response: {1|0}< newline><^END> 

Related keys: Avg > Point Avg 

 

 :SENS<Ch>:AVER:COUN 

Command Type: Command/Query 

Syntax: 
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:SENSe<Ch>:AVERage:COUNt < number>  

:SENSe<Ch>:AVERage:COUNt? 

Description: Set or query the point average count of the selected channel 

Parameters: 

Parameter Selection Option 

Description Average factor 

Data Type Numeric type 

(Integer) 

Range 1 - 999 

Preset Value 1 

 

Examples: 

Set the point average count of channel 1 to 5:  

:SENS1:AVER:COUN 5 

Query the point average count of channel 2:  

:SENS2:AVER:COUN? 

Query Response: {< number>}<newline><^END> 

Related keys: Avg > Point Avg Factor 

 

 :SENS<Ch>:DC:MEAS:CLE 

Command Type: Command 

Syntax: 

:SENSe<Ch>:DC:MEASure:CLEar 

Description: Clear the DC monitor data of the selected channel 

Related keys: Meas > DC Monitor Setup > Clear 

 

 :SENS<Ch>:DC:MEAS:DATA:DCI 

Command Type: Query 

Syntax: 

:SENSe<Ch>:DC:MEASure:DATA:DCI? 

Description: Query the DC monitor current of the specified channel 

Query Response: {< number>}<newline><^END> 
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 :SENS<Ch>:DC:MEAS:DATA:DCV 

Command Type: Query 

Syntax:  

:SENSe<Ch>:DC:MEASure:DATA:DCV? 

Description: Query the DC monitoring voltage of the specified channel 

Query Response: {< number>}<newline><^END> 

 :SENS<Ch>:DC:MEAS:ENAB 

Command Type: Command/Query 

Syntax: 

:SENSe<Ch>:DC:MEASure:ENABle {ON|OFF|1|0}  

:SENSe<Ch>:DC:MEASure:ENABle? 

Description: Set or query the open state of DC monitor of the selected channel 

Parameters: 

Parameter Selection Option 

Description DC monitor state 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value ON 

 

Examples: 

Turn on the DC monitor of channel 1:  

:SENS1:DC:MEAS:ENAB ON 

Query the open state of the DC monitor of channel 2:  

:SENS2:DC:MEAS:ENAB? 

Query Response: {1|0}< newline><^END> 

Related keys: Meas > DC Monitor Setup 

 

 :SENS<Ch>:FREQ 

Command Type: Command/Query 

Syntax: 
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:SENSe<Ch>:FREQuency[:CW] < number>  

:SENSe<Ch>:FREQuency[:CW]? 

Description: Set or query the CW frequency of the selected channel 

Parameters: 

Parameter Numerical Value 

Description CW frequency 

Data Type Double precision type 

(double) 

Range 10 - 130M 

Unit Hz 

Preset Value 1M 

 

Examples: 

Set the CW frequency of channel 1 to 10 MHz:  

:SENS1:FREQ 1E7 

Query the CW frequency of channel 2:  

:SENS2:FREQ? 

Query Response: {< number> }<newline><^END> 

Related keys: Sweep Setup > CW Frequency 

 

 :SENS<Ch>:FREQ:CENT 

Command Type: Command/Query 

Syntax: 

:SENSe<Ch>:FREQuency:CENTer < number>  

:SENSe<Ch>:FREQuency:CENTer? 

Description: Set or query the center value of the sweep frequency of the selected channel 

Parameters: 

Parameter Numerical Value 

Description Sweep frequency 

center value 

Data Type Double precision type 

(double) 

Range 10 - 130M 

Unit Hz 
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Preset Value 50.5k 

 

Examples: 

Set the sweep frequency center value of channel 1 to 1MHz:  

:SENS1:FREQ:CENT 1E6 

Query the sweep frequency center value of channel 2:  

:SENS2:FREQ:CENT? 

Query Response: {< number> }<newline><^END> 

Related keys: Center 

 

 :SENS<Ch>:FREQ:DATA 

Command Type: Query 

Syntax:  

:SENSe<Ch>:FREQuency:DATA? 

Description: Query the measurement frequency of all measurement points in the specified 

channel 

Query Response: {< number 1>},{< number 2>}...{< number n>}<newline><^END> 

 

 :SENS<Ch>:FREQ:SPAN 

Command Type: Command/Query 

Syntax: 

:SENSe<Ch>:FREQuency:SPAN < number>  

:SENSe<Ch>:FREQuency:SPAN? 

Description: Set or query the span value of the sweep frequency of the selected channel 

Parameters: 

Parameter Numerical Value 

Description Sweep frequency span 

value 

Data Type Double precision type 

(double) 

Range 0 - 129000000 

Unit Hz 

Preset Value 99k 
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Examples: 

Set the sweep frequency span value of channel 1 to 100 kHz:  

:SENS1:FREQ:SPAN 1E5 

Query the sweep frequency span value of channel 2:  

:SENS2:FREQ:SPAN? 

Query Response: {< number> }<newline><^END> 

Related keys: Span 

 :SENS<Ch>:FREQ:STAR 

Command Type: Command/Query 

Syntax: 

:SENSe<Ch>:FREQuency:STARt < number>  

:SENSe<Ch>:FREQuency:STARt? 

Description: Set or query the start value of the sweep frequency of the selected channel 

Parameters: 

Parameter Numerical Value 

Description Sweep frequency start 

value 

Data Type Double precision type 

(double) 

Range 10 - 130M 

Unit Hz 

Preset Value 1k 

 

Examples: 

Set the sweep frequency start value of channel 1 to 1MHz:  

:SENS1:FREQ:STAR 1E6 

Query the sweep frequency start value of channel 2:  

:SENS2:FREQ:STAR? 

Query Response: {< number> }<newline><^END> 

Related keys: Start 

 

 :SENS<Ch>:FREQ:STOP 
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Command Type: Command/Query 

Syntax: 

:SENSe<Ch>:FREQuency:STOP < number>  

:SENSe<Ch>:FREQuency:STOP? 

Description: Set or query the termination value of the sweep frequency of the selected channel 

Parameters: 

Parameter Numerical Value 

Description Sweep frequency 

termination value 

Data Type Double precision type 

(double) 

Range 10 - 130M 

Unit Hz 

Preset Value 100k 

 

Examples: 

Set the sweep frequency termination value of channel 1 to 10MHz:  

:SENS1:FREQ:STOP 1E7 

Query the sweep frequency termination value of channel 2:  

:SENS2:FREQ:STOP? 

Query Response: {< number> }<newline><^END> 

Related keys: Stop 

 

 :SENS<Ch>:SEGM:DATA 

Command Type: Command/Query 

:SENSe<Ch>:SEGMent:DATA < data>  

:SENSe<Ch>:SEGMent:DATA? 

Description: Set or query the segment setting data of the specified channel 

Parameters: 

Parameter Data 

Description Segment settings 

The segment setup data is arranged in the following order, N represents 

the number of segments and n represents the number between 1 and n  

Data = {< Start bit>,< Frequency mode>,< Source level setting 
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state>,< DC bias setting state>,< Measurement speed setting state>,< 

Average factor setting state>, < Measurement time setting state>, < 

Time delay setting state>,< Number of segments>, < Segment 1 

frequency>, < Segment 1 frequency2>, < Segment 1 points>, [Segment 

1 source level mode], [Segment 1 source level value], [Segment 1 DC 

bias mode], [Segment 1 DC bias value], [Segment 1 measurement 

speed], [Segment 1 average count], [Segment 1 measurement time], 

[Segment 1 delay time], ... , < Segment N frequency 1>, < Segment N 

frequency 2>, < Segment N points>, [Segment N source level mode], 

[Segment N source level value], [Segment N DC bias mode], [Segment 

N DC bias value], [Segment N measurement speed], [Segment N 

average count], [Segment N measurement time], [Segment N delay 

time] }  

The individual parameters are described below: 

< Start bit>: Always 7 

< Frequency mode>: Frequency setting mode 

0: Frequency setting mode is start/stop 

1: Frequency setting mode is center/span 

< Source level setting state>: Whether each segment is set the source 

level 

0: OFF, 1: ON  

< DC bias setting state>: Whether each segment is set the DC bias 

0: OFF, 1: ON  

< Measurement speed setting state>: Whether each segment is set the 

measurement speed  

0: OFF, 1: ON  

< Average count setting state>: Whether each segment is set the 

average count 

0: OFF, 1: ON  

< Measurement time setting state>: Whether each segment is set the 

measurement time 

0: OFF, 1: ON  

< Delay setting state>: Whether each segment is set the delay time 

0: OFF, 1: ON  

< Number of segments>: Total number of segments  

< Segment n frequency 1>: Segment n start frequency / center 

frequency, depending on < Frequency mode> 

< Segment n frequency 2>: Segment n stop frequency / span 

frequency, depending on < Frequency mode> 

< Segment n points>: number of points in segment n, at least 1, total 

number of points in all segments satisfying 2-1601 

[Segment n source level mode]: Source level mode for segment n: 

voltage mode = 0, current mode = 1. Not necessary to set when 

<source level setting state> = 0 
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[Segment n source level value]: The source level value for segment n. 

Not necessary to set when < Source level setting state> = 0 

[Segment n DC bias mode]: DC bias mode for segment n: voltage 

mode = 0, current mode = 1. Not necessary to set when < DC bias 

setting state > = 0 

[Segment n DC bias value]: DC bias value of segment n. Not necessary 

to set when < DC bias setting state >= 0 

[Segment n measurement speed]: Measurement speed (1-5) of segment 

n. Not necessary to set when < Measurement speed setting state >= 0 

[Segment n average count]: Average count of each measurement point 

for segment n. Not necessary when < Average count setting state >= 0 

[Segment n measurement time]: The measurement time for segment n 

does not have to be set when < Measurement time setting state> = 0 

[Segment n delay time]: Measurement delay time of each point of 

segment n. Not necessary to set when < delay time setting state >= 0 

An error will be returned if the necessary parameters are missing or if 

the value is set incorrectly 

Preset Value 7,0,0,0,0,0,0,0,0,0,1,20,1000000,2 

 

Query Response: {< data> }<newline><^END> 

Related keys: Sweep Setup > Edit Segment Table 

 

 :SENS<Ch>:SEGM:SWE:POIN 

Command Type: Query 

Syntax: :SENSe<Ch>:SEGMent:SWEep:POINts? 

Description: Query the total number of points in the segment settings of the specified channel 

Query Response: {< number>}<newline><^END> 

:SENS<Ch>:SWE:DEL 

Command Type: Command/Query 

Syntax: 

:SENSe<Ch>:SWEep:DELay < Digital>  

:SENSe<Ch>:SWEep:DELay? 

Description: Set or query the sweep delay of the specified channel 

Parameters: 

Parameter Numerical Value 

Description Sweep delay 

Data Type Double precision type 
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(double) 

Range 0s - 30s 

Preset Value 0s 

 

Examples: 

Set the sweep delay of channel 1 to 1 second:  

:SENS1:SWE:DEL 1 

Query the sweep delay of channel 2:  

:SENS2:SWE:DEL? 

Query Response: {< number>}<newline><^END> 

Related keys: Sweep Setup > Sweep Delay 

 

 :SENS<Ch>:SWE:DIR 

Command Type: Command/Query 

Syntax: 

:SENSe<Ch>:SWEep:DIRection {UP|DOWN}  

:SENSe<Ch>:SWEep:DIRection? 

Description: Set and query the sweep direction of the specified channel 

Parameters: 

Parameter Selection Option 

Description Sweep direction 

Data Type Character string type 

(String) 

Range UP: Up 

DOWN: Down 

Preset Value UP 

 

Examples: 

Set the sweep direction of channel 1 to DOWN:  

:SENS1:SWE:DIR DOWN 

Query the sweep direction of channel 2:  

:SENS2:SWE:DIR? 

Query Response: {UP|DOWN}< newline><^END> 
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Related keys: Sweep Setup > Direction 

 

 :SENS<Ch>:SWE:PDEL 

Command Type: Command/Query 

Syntax: 

:SENSe<Ch>:SWEep:PDEL < number>  

:SENSe<Ch>:SWEep:PDEL? 

Description: Set or query the point delay of the specified channel 

Parameters: 

Parameter Numerical Value 

Description Point delay 

Data Type Double precision type 

(double) 

Range 0s - 30s 

Preset Value 0s 

 

Examples: 

Set the point delay of channel 1 to 1 second:  

:SENS1:SWE:PDEL 1 

Query the point delay of channel 2:  

:SENS2:SWE:PDEL? 

Query Response: {< number>}<newline><^END> 

Related keys: Sweep Setup > Point Delay 

 

 :SENS<Ch>:SWE:POIN 

Command Type: Command/Query 

Syntax: 

:SENSe<Ch>:SWEep:POINts <number>  

:SENSe<Ch>:SWEep:POINts? 

Description: Set or query the number of measurement points of the specified channel 

Parameters: 

Parameter Numerical Value 
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Description Points 

Data Type Numeric type 

(Integer) 

Range 2 - 1601 

Preset Value 201 

 

Examples: 

Set the points of channel 1 to 100:  

:SENS1:SWE:POIN 100 

Query the points of channel 2:  

:SENS2:SWE:POIN? 

Query Response: {< number>}<newline><^END> 

Related keys: Sweep Setup > Points 

 

 :SENS<Ch>:SWE:TIME 

Command Type: Command/Query 

Syntax: 

:SENSe<Ch>:SWEep:TIME < number>  

:SENSe<Ch>:SWEep:TIME? 

Description: Set or query the sweep time of the specified channel 

Parameters: 

Parameter Numerical Value 

Description Measurement time 

Data Type Double precision type 

(double) 

Range 0s - 86400s 

Preset Value 0s 

 

Examples: 

Set the measurement time of channel 1 to 10 seconds:  

:SENS1:SWE:TIME 10 

Query the measurement time of channel 2:  

:SENS2:SWE:TIME? 

Query Response: {< number>}<newline><^END> 
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Related keys: Sweep Setup > Sweep Time 

 

 :SENS<Ch>:SWE:TYPE 

Command Type: Command/Query 

Syntax: 

:SENSe<Ch>:SWEep:TYPE {LINear|LOGarithmic|SEGMent|POWer|BIAS|LBIas}  

:SENSe<Ch>:SWEep:TYPE? 

Description: Set and query the sweep type (stimulus value) of the specified channel 

Parameters: 

Parameter Selection Option 

Description Sweep Type 

Data Type Character string type (String) 

Range LINear: Stimulus value is linear 

frequency 

LOGarithmic: Stimulus value is 

logarithmic frequency 

SEGMent: Stimulus value is segment 

POWer: Stimulus value is signal 

source level 

BIAS: Stimulus value is linear DC 

bias 

LogBIas: Stimulus value is 

logarithmic DC bias 

Preset Value LINear 

 

Examples: 

Set the sweep type of channel 1 to the signal source level:  

:SENS1:SWE:TYPE POW 

Query the sweep type of channel 2:  

:SENS2:SWE:TYPE? 

Query Response: {LIN|LOG|SEGM|POW|BIAS|LBI}< newline><^END> 

Related keys: Sweep Type 

9.2.5.7 SERVICE 

 :SERV:ACH:ACT 
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Command Type: Command/Query 

Syntax: 

:SERVice:ACHannel:ACTive <Value>  

:SERVice:ACHannel:ACTive? 

Description: Set or query the currently active channel 

Parameters: 

Parameters Numerical Value 

Description Active channel serial 

number 

Data Type Numeric type 

(Integer) 

Range 1 - 4 

Preset Value 1 

 

Examples: 

Set channel 1 as the active channel:  

:SERV:ACH:ACT 1 

Query the currently active channel:  

:SERV:ACH:ACT? 

Query Response: {< number>}<newline><^END> 

Related keys: Channel Prev | Channel Next 

 

 :SERV:ACH:COUN 

Command Type: Query 

Syntax: :SERVice:AChannel:COUNt? 

Description: Query the number of currently displayed channels  

Query Response: {< number>}<newline><^END> 

 

 :SERV:CHAN<Ch>:ATR:ACT 

Command Type: Command/Query 

Syntax: 

:SERVice:CHANnel<Ch>:ATRace:ACTive < Digital>  
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:SERVice:CHANnel<Ch>:ATRace:ACTive? 

Description: Set and query the active trace of the selected channel 

Parameters: 

Parameter Numerical Value 

Description Active trace serial 

number 

Data Type Numeric type 

(Integer) 

Range 1 - 4 

Preset Value 1 

 

Examples: 

Set the channel 1 trace 1 as the active trace:  

:SERV:CHAN1:ATR:ACT 1 

Query the active trace of channel 2:  

:SERV:CHAN2:ATR:ACT? 

Query Response: {< number>}<newline><^END> 

Related keys: Trace Prev | Trace Next 

 

 :SERV:CHAN<Ch>:ATR:COUN  

Command Type: Query 

Syntax:  

:SERVice:CHANnel<Ch>:ATRace:COUNt? 

Description: Query the number of traces of the currently selected channel 

Query Response: {< number>}<newline><^END> 

 

 :SERV:CHAN<Ch>:SEGM:DATA 

Command Type: Query 

Syntax:  

:SERVice:CHANnel<Ch>:SEGMent:DATA? 

Description: Query the number of data to be set for the trace segments of the currently selected 

channel 

Query Response: {< number>}<newline><^END> 
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 :SERV:CHAN<Ch>:SWE:POIN 

Command Type: Query 

Syntax:  

:SERVice:CHANnel<Ch>:SWEep:POINt? 

Description: Query the number of measurement points in the current sweep span 

 

 :SERV:CHAN<Ch>:TRAC<Tr>:AMRK:ACT 

Command Type: Command/Query 

Syntax: 

:SERVice:CHANnel<Ch>:TRACe<Tr>:AMRKer:ACTive < Digital>  

:SERVice:CHANnel<Ch>:TRACe<Tr>:AMRKer:ACTive? 

Description: Set and query the active marker of the selected trace of the selected channel 

Parameters: 

Parameters Numerical Value 

Description Active marker serial 

number 

Data Type Numeric type 

(Integer) 

Range 0 - 10 

0: Marker not selected 

10: Reference marker 

Preset Value 0 

 

Examples: 

Set the active marker of channel 1 trace 1 to 1:  

:SERV:CHAN1:TRAC1:AMRK:ACT 1 

Query the active marker of channel 2 trace 2:  

:SERV:CHAN2:TRAC2:AMRK:ACT? 

Query Response: {< number>}<newline><^END> 

Related keys: Marker > Marker 1 - Marker 9, Reference Marker 

 

 :SERV:SWE:FREQ:MAX 
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Command Type: Query 

Syntax:  

:SERVice:SWEep:FREQuency:MAXimum?  

Description: Query the maximum frequency of this machine 

 :SERV:SWE:FREQ:MIN 

Command Type: Query 

Syntax:  

:SERVice:SWEep:FREQuency:MINimum?  

Description: Query the minimum frequency of this machine 

 

 :SERV:SWE:POIN 

Command Type: Query 

Syntax:  

:SERVice:SWEep:POINts?  

Description: Query the maximum number of measurement points of this machine 

9.2.5.8 SOURCE 

 :SOUR<Ch>:ALC 

Command Type: Command/Query 

Syntax: 

:SOURce<Ch>:ALC[:STATe] {ON|OFF|1|0}  

:SOURce<Ch>:ALC[:STATe]? 

Description: Set or query the on-off state of automatic level control (ALC) of the specified 

channel 

Parameters: 

Parameters Selection Option 

Description ALC state 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value ON 
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Examples: 

Turn on the ALC of channel 1: :SOUR1:ALC 1 

Query the on-off state of the ALC of channel 2: :SOUR2:ALC? 

Query Response: {1|0}< newline><^END> 

Related keys: Sweep Setup > OSC Level > ALC > ALC Control 

 

 :SOUR<Ch>:ALC:COUN 

Command Type: Command/Query 

Syntax: 

:SOURce<Ch>:ALC:COUNt < number>  

:SOURce<Ch>:ALC:COUNt? 

Description: Set or query the maximum number of attempts of automatic level control of the 

specified channel 

Parameters: 

Parameter Numerical Value 

Description Maximum number of 

ALC attempts 

Data Type Numeric type 

(Integer) 

Range 2 - 10 

Preset Value 10 

 

Examples: 

Set the maximum number of ALC attempts of channel 1 to 10:  

:SOUR1:ALC:COUN 10 

Query the maximum number of ALC attempts of channel 2:  

:SOUR2:ALC:COUN? 

Query Response: {< number>}<newline><^END> 

Related keys: Sweep Setup > OSC Level > ALC > Max Iteration 

 

 :SOUR<Ch>:ALC:TOL 

Command Type: Command/Query 

Syntax: 
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:SOURce<Ch>:ALC:TOLerance <Value>  

:SOURce<Ch>:ALC:TOLerance? 

Description: Set or query the target accuracy of automatic level control of the specified channel 

Parameters: 

Parameters Numerical Value 

Description ALC target accuracy 

Data Type Double precision type 

(double) 

Range 0.05 - 10 

Unit % 

Preset Value 5 

 

Examples: 

Set the ALC target accuracy of channel 1 to 1%:  

:SOUR1:ALC:TOL 1 

Query the ALC target accuracy of channel 2:  

:SOUR2:ALC:TOL? 

Query Response: <number><newline><^END> 

Related keys: Sweep Setup > OSC Level > ALC > Target % 

 

 :SOUR<Ch>:BIAS:CURR:AMPL 

Command Type: Command/Query 

Syntax: 

:SOURce<Ch>:BIAS:CURRent[:LEVel][:IMMediate]:AMPLitude < number>  

:SOURce<Ch>:BIAS:CURRent[:LEVel][:IMMediate]:AMPLitude? 

Description: Set or query the DC bias current output of the specified channel 

Parameters: 

Parameter Numerical Value 

Description DC bias current 

Data Type Double precision type 

(double) 

Range -0.1 - 0.1 

Unit A 

Preset Value 0 
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Examples: 

Set the bias current of channel 1 to 0.1A:  

:SOUR1:BIAS:CURR:AMPL 0.1 

Query the bias current of channel 2:  

:SOUR2:BIAS:CURR:AMPL? 

Query Response: {< number>}<newline><^END> 

Related keys: Sweep Setup > DC Bias > Current Level 

 :SOUR<Ch>:BIAS:CURR:CENT 

Command Type: Command/Query 

Syntax: 

:SOURce<Ch>:BIAS:CURRent:CENTer <number>  

:SOURce<Ch>:BIAS:CURRent:CENTer? 

Description: Set or query the center value of the bias current of the specified channel when the 

stimulus value is DC bias 

Parameters: 

Parameter Numerical Value 

Description Bias current center 

value 

Data Type Double precision type 

(double) 

Range -0.1 - 0.1 

Unit A 

Preset Value 0 

 

Examples: 

Set the bias current center value of channel 1 to 0.1A:  

:SOUR1:BIAS:CURR:CENT 0.1 

Query the bias current center value of channel 2:  

:SOUR2:BIAS:CURR:CENT? 

Query Response: {< number>}<newline><^END> 

Related keys: Center (Sweep mode is DC bias) 
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 :SOUR<Ch>:BIAS:CURR:SPAN 

Command Type: Command/Query 

Syntax: 

:SOURce<Ch>:BIAS:CURRent:SPAN < number>  

:SOURce<Ch>:BIAS:CURRent:SPAN? 

Description: Set or query the span value of the bias current of the specified channel when the 

stimulus value is DC bias 

Parameters: 

 

Parameter Numerical Value 

Description Bias current span 

value 

Data Type Double precision type 

(double) 

Range 0 - 0.2 

Unit A 

Preset Value 0 

 

Examples: 

Set the bias current span value of channel 1 to 0.1A:  

:SOUR1:BIAS:CURR:SPAN 0.1 

Query the bias current span value of channel 2:  

:SOUR2:BIAS:CURR:SPAN? 

Query Response: {< number>}<newline><^END> 

Related key: Span (Sweep mode is DC bias) 

 

 :SOUR<Ch>:BIAS:CURR:STAR 

Command Type: Command/Query 

Syntax: 

:SOURce<Ch>:BIAS:CURRent:STARt <number>  

:SOURce<Ch>:BIAS:CURRent:STARt? 

Description: Set or query the start value of the bias current of the specified channel when the 

stimulus value is DC bias 
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Parameters: 

Parameter Numerical Value 

Description Bias current start 

value 

Data Type Double precision type 

(double) 

Range -0.1 - 0.1 

Unit A 

Preset Value 0 

 

Examples: 

Set the bias current start value of channel 1 to 0.1A:  

:SOUR1:BIAS:CURR:STAR 0.1 

Query the bias current start value of channel 2:  

:SOUR2:BIAS:CURR:STAR? 

Query Response: {< number>}<newline><^END> 

Related keys: Start (Sweep mode is DC bias) 

 

 :SOUR<Ch>:BIAS:CURR:STOP 

Command Type: Command/Query 

Syntax: 

:SOURce<Ch>:BIAS:CURRent:STOP < number>  

:SOURce<Ch>:BIAS:CURRent:STOP? 

Description: Set or query the termination value of the bias current of the specified channel 

when the stimulus value is DC bias  

Parameters: 

Parameter Numerical Value 

Description Bias current 

termination value 

Data Type Double precision type 

(double) 

Range -0.1 - 0.1 

Unit A 

Preset Value 0 

 

Examples: 
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Set the bias current termination value of channel 1 to -0.1A:  

:SOUR1:BIAS:CURR:STOP -0.1 

Query the bias current termination value of channel 2:  

:SOUR2:BIAS:CURR:STOP? 

Query Response: {< number>}<newline><^END> 

Related key: Stop (Sweep mode is DC bias) 

 

 :SOUR<Ch>:BIAS:DEL 

Command Type: Command/Query 

Syntax: 

:SOURce<Ch>:BIAS:DELay <Value>  

:SOURce<Ch>:BIAS:DELay? 

Description: Set or query the bias delay of the specified channel 

Parameters: 

Parameter Numerical Value 

Description Bias delay 

Data Type Double precision type 

(double) 

Range 0s - 30s 

Preset Value 0s 

 

Examples: 

Set the bias delay of channel 1 to 100ms:  

:SOUR1:BIAS:DEL 0.1 

Query the bias delay of channel 2:  

:SOUR2:BIAS:DEL? 

Query Response: {< number>}<newline><^END> 

Related keys: Sweep Setup > DC Bias > Bias Delay 

 

 :SOUR<Ch>:BIAS:MODE 

Command Type: Command/Query 

Syntax: 
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:SOURce<Ch>:BIAS:MODE {VOLTage|CURRent}  

:SOURce<Ch>:BIAS:MODE? 

Description: Set or query the DC bias mode of the specified channel 

Parameters: 

Parameter Selection Option 

Description DC bias mode 

Data Type Character string type 

(String) 

Range VOLT: Voltage mode 

CURR: Current mode 

Preset Value VOLT 

 

Examples: 

Set the DC bias mode of channel 1 to voltage mode:  

:SOUR1:BIAS:MODE VOLT 

Query the DC bias mode of channel 2:  

:SOUR2:BIAS:MODE? 

Query Response: {VOLT|CURR}< newline><^END> 

Related keys: Sweep Setup > DC Bias > DC Bias Mode 

 

 :SOUR<Ch>:BIAS:RANG 

Command Type: Command/Query 

Syntax: 

:SOURce<Ch>:BIAS:RANGe {M1|M10|M100} 

:SOURce<Ch>:BIAS:RANGe? 

Description: Set or query the DC bias range of the specified channel. 

Parameters: 

Parameter Selection Option 

Description DC bias range 

Data Type Character string type 

(String) 

Range M1: 1mA 

M10: 10mA 

M100: 100mA 
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Preset Value M1 

 

Examples. 

Set the DC bias range of channel 1 to 1mA:  

:SOUR1:BIAS:RANG M1 

Query the DC bias range of channel 2:  

:SOUR2:BIAS:RANG? 

Query Response: {M1|M10|M100}< newline><^END> 

Related keys: Sweep Setup > DC Bias > Meas Range 

 :SOUR<Ch> :BIAS:STAT 

Command Type: Command/Query 

Syntax: 

:SOURce<Ch>:BIAS:STATe {ON|OFF|1|0}  

:SOURce<Ch>:BIAS:STATe? 

Description: Set or query the on-off state of the DC bias of the specified channel 

Parameters: 

Parameter Selection Option 

Description DC bias state 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value OFF 

 

Examples: 

Turn on the DC bias of channel 1:  

:SOURce1:BIAS:STAT ON 

Query the on-off state of the DC bias of channel 2:  

:SOURce2:BIAS:STAT? 

Query Response: {1|0}< newline><^END> 

Related keys: Sweep Setup > DC Bias > DC Bias State 

 

 :SOUR<Ch>:BIAS:VOLT:AMPL 

Command Type: Command/Query 
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Syntax: 

:SOURce<Ch>:BIAS:VOLTage[:LEVel][:IMMediate]:AMPLitude < number>  

:SOURce<Ch>:BIAS:VOLTage [:LEVel][:IMMediate]:AMPLitude? 

Description: Set or query the DC bias voltage output of the specified channel 

Parameters: 

Parameter Numerical Value 

Description DC bias voltage 

Data Type Double precision type 

(double) 

Range -40 - 40 

Unit V 

Preset Value 0 

 

Examples: 

Set the bias voltage of channel 1 to 1V:  

:SOUR1:BIAS:VOLT:AMPL 1 

Query the bias voltage of channel 2:  

:SOUR2:BIAS:VOLT:AMPL? 

Query Response: {< number>}<newline><^END> 

Related keys: Sweep Setup > DC Bias > Voltage Level 

 

 :SOUR<Ch>:BIAS:VOLT:CENT 

Command Type: Command/Query 

Syntax: 

:SOURce<Ch>:BIAS:VOLTage:CENTer <number>  

:SOURce<Ch>:BIAS:VOLTage:CENTer? 

Description: Set or query the center value of the bias voltage of the specified channel when the 

stimulus value is DC bias 

Parameters: 

Parameter Numerical Value 

Description Bias voltage center 

value 

Data Type Double precision type 

(double) 
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Range -40 - 40 

Unit V 

Preset Value 0 

 

Examples: 

Set the bias voltage center value of channel 1 to 1V:  

:SOUR1:BIAS:VOLT:CENT 1 

Query the bias voltage center value of channel 2:  

:SOUR2:BIAS:VOLT:CENT? 

Query Response: {< number>}<newline><^END> 

Related keys: Center (Sweep mode is DC bias) 

 

 :SOUR<Ch>:BIAS:VOLT:SPAN 

Command Type: Command/Query 

Syntax: 

:SOURce<Ch>:BIAS:VOLTage:SPAN <number>  

:SOURce<Ch>:BIAS:VOLTage:SPAN? 

Description: Set or query the span value of the bias voltage of the specified channel when the 

stimulus value is DC bias 

Parameters: 

Parameter Numerical Value 

Description Bias voltage span 

value 

Data Type Double precision type 

(double) 

Range 0 - 80 

Unit V 

Preset Value 0 

 

Examples: 

Set the bias voltage span value of channel 1 to 10V:  

:SOUR1:BIAS:VOLT:SPAN 10 

Query the bias voltage span value of channel 2:  

:SOUR2:BIAS:VOLT:SPAN? 
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Query Response: {< number>}<newline><^END> 

Related key: Span (Sweep mode is DC bias) 

 

 :SOUR<Ch>:BIAS:VOLT:STAR 

Command Type: Command/Query 

Syntax: 

:SOURce<Ch>:BIAS:VOLTage:STARt <number>  

:SOURce<Ch>:BIAS:VOLTage:STARt? 

Description: Set or query the start value of the bias voltage of the specified channel when the 

stimulus value is DC bias 

Parameters: 

Parameter Numerical Value 

Description Bias voltage start 

value 

Data Type Double precision type 

(double) 

Range -40 - 40 

Unit V 

Preset Value 0 

 

Examples: 

Set the bias voltage start value of channel 1 to -1V: 

:SOUR1:BIAS:VOLT:STAR -1 

Query the bias voltage start value of channel 2: 

:SOUR2:BIAS:VOLT:STAR? 

Query Response: {< number>}<newline><^END> 

Related keys: Start (Sweep mode is DC bias) 

 

 :SOUR<Ch>:BIAS:VOLT:STOP 

Command Type: Command/Query 

Syntax: 

:SOURce<Ch>:BIAS:VOLTage:STOP < number>  

:SOURce<Ch>:BIAS:VOLTage:STOP? 
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Description: Set or query the termination value of the bias voltage of the specified channel 

when the stimulus value is DC bias  

Parameters: 

Parameter Numerical Value 

Description Bias voltage 

termination value 

Data Type Double precision type 

(double) 

Range -40 - 40 

Unit V 

Preset Value 0 

 

Examples: 

Set the bias voltage termination value of channel 1 to 1V:  

:SOUR1:BIAS:VOLTage:STOP 1 

Query the bias voltage termination value of channel 2:  

:SOUR2:BIAS:VOLTage:STOP? 

Query Response: {< number>}<newline><^END> 

Related key: Stop (Sweep mode is DC bias) 

 

 :SOUR<Ch>:CURR 

Command Type: Command/Query 

Syntax: 

:SOURce<Ch>:CURRent[:LEVel][:IMMediate][:AMPLitude] < number>  

:SOURce<Ch>:CURRent[:LEVel][:IMMediate][:AMPLitude]? 

Description: Set or query the signal source current output of the specified channel 

Parameters: 

Parameter Numerical Value 

Description Signal source current 

Data Type Double precision type 

(double) 

Range 0.0002 - 0.02 

Unit A 

Preset Value 0.02 
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Examples: 

Set the signal source current of channel 1 to 10mA:  

:SOUR1:CURR 0.01 

Query the signal source current of channel 2:  

:SOUR2:CURR? 

Query Response: {< number>}<newline><^END> 

Related keys: Sweep Setup > OSC Level > Current Level 

 

 :SOUR<Ch>:CURR:CENT 

Command Type: Command/Query 

Syntax: 

:SOURce<Ch>:CURRent:CENTer <number>  

:SOURce<Ch>:CURRent:CENTer? 

Description: Set or query the center value of the signal source current of the specified channel 

when the stimulus value is signal source level  

Parameters: 

Parameters numerical value 

Description Signal source current 

center value 

Data Type Double precision type 

(double) 

Range 0.0002 - 0.02 

Unit A 

Preset Value 0.0101 

 

Examples: 

Set the center value of the signal source current of channel 1 to 1mA:  

:SOUR1:CURR:CENT 1E-3 

Query the center value of the signal source current of channel 2:  

:SOUR2:CURR:CENT? 

Query Response: {< number>}<newline><^END> 

Related keys: Center (Sweep mode is signal source level) 
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 :SOUR<Ch>:CURR:SPAN 

Command Type: Command/Query 

Syntax: 

:SOURce<Ch>:CURRent:SPAN < number>  

:SOURce<Ch>:CURRent:SPAN? 

Description: Set or query the span value of the signal source current of the specified channel 

when the stimulus value is signal source level  

Parameters: 

Parameter Numerical Value 

Description Signal source current 

span value 

Data Type Double precision type 

(double) 

Range 0 - 0.0198 

Unit A 

Preset Value 0.0198 

 

Examples: 

Set the span value of the signal source current of channel 1 to 10mA:  

:SOUR1:CURR:SPAN 0.01 

Query the span value of the signal source current of channel 2:  

:SOUR2:CURR:SPAN? 

Query Response: {< number>}<newline><^END> 

Related keys: Span (Sweep mode is signal source level) 

 

 :SOUR<Ch>:CURR:STAR 

Command Type: Command/Query 

Syntax: 

:SOURce<Ch>:CURRent:STARt < number>  

:SOURce<Ch>:CURRent:STARt? 

Description: Set or query the start value of the signal source current of the specified channel 

when the stimulus value is signal source level  

Parameters: 
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Parameter Numerical Value 

Description Signal source current 

start value 

Data Type Double precision type 

(double) 

Range 0.0002 - 0.02 

Unit A 

Preset Value 0.0002 

 

Examples: 

Set the start value of signal source current of channel 1 to 1mA:  

:SOUR1:CURR:STAR 1E-3 

Query the start value of signal source current of channel 2:  

:SOUR2:CURR:STAR? 

Query Response: {< number>}<newline><^END> 

Related keys: Start (Sweep mode is signal source level) 

 

 :SOUR<Ch>:CURR:STOP 

Command Type: Command/Query 

Syntax: 

:SOURce<Ch>:CURRent:STOP < number>  

:SOURce<Ch>:CURRent:STOP? 

Description: Set or query the termination value of the signal source current of the specified 

channel when the stimulus value is signal source level  

Parameters: 

Parameter Numerical Value 

Description Signal source current 

termination value 

Data Type Double precision type 

(double) 

Range 0.0002 - 0.02 

Unit A 

Preset Value 0.02 

 

Examples: 

Set the termination value of the signal source current of channel 1 to 10mA:  
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:SOUR1:CURR:STOP 0.01 

Query the termination value of the signal source current of channel 2:  

:SOUR2:CURR:STOP? 

Query Response: {< number>}<newline><^END> 

Related keys: Stop (Sweep mode is DC bias) 

 

 :SOUR<Ch>:MODE 

Command Type: Command/Query 

Syntax: 

:SOURce<Ch>:MODE {VOLTage|CURRent}  

:SOURce<Ch>:MODE? 

Description: Set or query the signal source mode of the specified channel 

Parameters: 

Parameter Selection Option 

Description Signal source mode 

Data Type Character string type 

(String) 

Range VOLT: Voltage mode 

CURR: Current mode 

Preset Value VOLT 

 

Examples: 

Set the signal source mode of channel 1 to voltage mode:  

:SOUR1:MODE VOLT 

Query the signal source mode of channel 2:  

:SOUR2:MODE? 

Query Response: {VOLT|CURR}< newline><^END>  

Related keys: Sweep Setup > OSC Level > OSC Unit 

 

 :SOUR<Ch>:VOLT 

Command Type: Command/Query 

Syntax: 
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:SOURce<Ch>:VOLTage[:LEVel][:IMMediate][:AMPLitude] < number>  

:SOURce<Ch>:VOLTage[:LEVel][:IMMediate][:AMPLitude]? 

Description: Set or query the signal source voltage output of the specified channel 

Parameters: 

Parameter Numerical Value 

Description Signal source voltage 

Data Type Double precision type 

(double) 

Range 0.005 - 1 

Unit V 

Preset Value 0.5 

 

Examples: 

Set the signal source voltage of channel 1 to 100mV:  

:SOUR1:VOLT 0.1 

Query the signal source voltage of channel 2:  

:SOUR2:VOLT? 

Query Response: {< number>}<newline><^END> 

Related keys: Sweep Setup > OSC Level > Voltage Level 

 

 :SOUR<Ch>:VOLT:CENT 

Command Type: Command/Query 

Syntax: 

:SOURce<Ch>:VOLTage:CENTer <number>  

:SOURce<Ch>:VOLTage:CENTer? 

Description: Set or query the center value of the signal source voltage of the specified channel 

when the stimulus value is signal source level 

Parameters: 

Parameter Numerical Value 

Description Signal source voltage 

center value 

Data Type Double precision type 

(double) 

Range 0.005 - 1 
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Unit V 

Preset Value 0.5025 

 

Examples: 

Set the center value of the signal source voltage of channel 1 to 100mV:  

:SOUR1:VOLT:CENT 0.1 

Query the center value of the signal source voltage of channel 2:  

:SOUR2:CURR:CENT? 

Query Response: {< number>}<newline><^END> 

Related keys: Center (Sweep mode is signal source level) 

 :SOUR<Ch>:VOLT:SPAN 

Command Type: Command/Query 

Syntax: 

:SOURce<Ch>:VOLTage:SPAN < number>  

:SOURce<Ch>:VOLTage:SPAN? 

Description: Set or query the span value of the signal source voltage of the specified channel 

when the stimulus value is signal source level 

Parameters: 

Parameter Numerical Value 

Description Signal source voltage 

span value 

Data Type Double precision type 

(double) 

Range 0 - 0.995 

Unit V 

Preset Value 0.995 

 

Examples: 

Set the span value of the signal source voltage of channel 1 to 500mV:  

:SOUR1:VOLT:SPAN 0.5 

Query the span value of the signal source voltage of channel 2:  

:SOUR2:VOLT:SPAN? 

Query Response: {< number>}<newline><^END> 

Related keys: Span (Sweep mode is signal source level) 
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 :SOUR<Ch>:VOLT:STAR 

Command Type: Command/Query 

Syntax: 

:SOURce<Ch>:VOLTage:STARt < number>  

:SOURce<Ch>:VOLTage:STARt? 

Description: Set or query the start value of the signal source voltage of the specified channel 

when the stimulus value is signal source level  

Parameters: 

Parameter Numerical Value 

Description Signal source current 

start value 

Data Type Double precision type 

(double) 

Range 0.005 - 1 

Unit V 

Preset Value 0.005 

 

Examples: 

Set the start value of the signal source voltage of channel 1 to 10mV:  

:SOUR1:VOLT:STAR 0.01 

Query the start value of the signal source voltage of channel 2: 

:SOUR2:VOLT:STAR? 

Query Response: {< number>}<newline><^END> 

Related keys: Start (Sweep mode is signal source level) 

 

 :SOUR<Ch>:VOLT:STOP 

Command Type: Command/Query 

Syntax: 

:SOURce<Ch>:VOLTage:STOP < number>  

:SOURce<Ch>:VOLTage:STOP? 

Description: Set or query the termination value of the signal source voltage of the specified 

channel when the stimulus value is signal source level  
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Parameters: 

Parameter Numerical Value 

Description Signal source voltage 

termination value 

Data Type Double precision type 

(double) 

Range 0.005 - 1 

Unit V 

Preset Value 1 

 

Examples: 

Set the termination value of the signal source voltage of channel 1 to 100mV:  

:SOUR1:VOLT:STOP 0.1 

Query the termination value of the signal source voltage of channel 2:  

:SOUR2:VOLT:STOP? 

Query Response: {< number>}<newline><^END> 

Related keys: Stop (Sweep mode is DC bias) 

9.2.5.9 TRIGGER 

 :TRIG 

Command Type: Command 

Syntax:  

:TRIGger 

Description: When the trigger source is manual trigger and the trigger mode is not hold mode, a 

trigger is performed 

 

 :TRIG:AVER 

Command Type: Command/Query 

Syntax: 

:TRIGger[:SEQuence]:AVERage {ON|OFF|1|0}  

:TRIGger[:SEQuence]:AVERage? 

Description: Set or query the open state of the average trigger of the current channel 

Parameters: 
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Parameter Selection Option 

Description Average trigger state 

Data Type Boolean (Boolean) 

Range ON|OFF|1|0 

Preset Value OFF 

 

Examples: 

Turn on the average trigger:  

TRIG:AVER ON 

Query the open state of the average trigger:  

TRIG:AVER? 

Query Response: {1|0}< newline><^END> 

Related keys: Avg > Avg Trigger 

 

 :TRIG:POIN 

Command Type: Command/Query 

Syntax: 

:TRIGger[:SEQuence]:POINt {ON|OFF|1|0}  

:TRIGger[:SEQuence]:POINt? 

Description: Set whether the point-by-point mode of the trigger is turned on 

Parameters: 

Parameter Selection Option 

Description Point-by-point trigger 

state 

Data Type Boolean type 

(Boolean) 

Range ON|OFF|1|0 

Preset Value OFF 

 

Examples: 

Turn on the point-by-point trigger:  

:TRIG:POIN ON 

Query the on-off state of the point-by-point trigger:  

:TRIG:POIN? 
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Query Response: {1|0}< newline><^END> 

Related keys: Trigger Mode > Trigger Event 

 

 :TRIG:EXT:DEL 

Command Type: Command/Query 

Syntax: 

:TRIGger[:SEQuence]:EXTernal:DELay < number>  

:TRIGger[:SEQuence]:EXTernal:DELay? 

Description: Set or query the trigger delay of the external trigger 

Parameters: 

Parameter Numerical Value 

Description Trigger delay 

Data Type Double precision type 

(double) 

Range 0 - 10 

Unit s 

Preset Value 0 

 

Examples: 

Set the trigger delay to 1ms:  

:TRIG:EXT:DEL 1E-3 

Query the trigger delay:  

:TRIG:EXT:DEL? 

Query Response: {< number>}<newline><^END> 

Related keys: Trigger Mode > Trigger Delay 

 

 :TRIG:SOUR 

Command Type: Command/Query 

Syntax: 

:TRIGger[:SEQuence]:SOURce {INTernal|EXTernal|MANual|BUS}  

:TRIGger[:SEQuence]:SOURce? 

Description: Set or query the trigger source of the sweep mode 
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Parameters: 

Parameter Selection Option 

Description Trigger source 

Data Type Character string type 

(String) 

Range INTernal: Internal 

trigger 

MANual: Manual 

trigger 

EXTernal: External 

trigger 

BUS: Bus trigger 

Preset Value INTernal 

Examples: 

Set the trigger source to manual mode:  

:TRIG:SOUR INT 

Query the trigger source:  

:TRIG:SOUR? 

Query Response: {INT|MAN|EXT|BUS}< newline><^END> 

Related keys: Trigger Mode > Trigger Source 

 

 :TRIG:SCOP 

Command Type: Command/Query 

Syntax: 

:TRIGger[:SEQuence]:SCOPe {ALL|ACTive}  

:TRIGger[:SEQuence]:SCOPe? 

Description: Set or query the trigger scope for all channels in turn or only the active channels 

Parameters: 

Parameters Selection Option 

Description Trigger scope 

Data Type Character string type (String) 

Range ALL: Trigger all channels  

ACTive: Trigger the active 

channel only 

Preset Value ALL 
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Examples: 

Set the trigger scope to all channels:  

:TRIG:SCOP ALL 

Query the trigger scope:  

:TRIG:SCOP? 

Query Response: {ALL|ACTive}< newline><^END> 

Related keys: Trigger Mode > Trigger Scope 

 

 :TRIG:SING 

Command Type: Command 

Syntax::TRIGger[:SEQuence]:SINGle 

Description: When the trigger source is bus trigger and the trigger mode is not hold mode, 

immediately perform a trigger 
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Chapter 10 Handler Instructions for Use 

TH2851 provides users with Handler interface, which is mainly used for the output of instrument 

sorting results. When the instrument is used in the automatic component sorting test system, this 

interface provides the communication signal with the system and the sorting result output signal. 

The sorting result output varies depending on the measurement mode. The Handler interface design 

is flexible. After using different operating procedures, all output signal states are defined according 

to the usage requirements. 

10.1 Definition description 

The information provided in this chapter includes the necessary description of the signal lines and 

electrical characteristics for using the Handler interface. 

10.1.1 Signal line definition 

The Handler interface uses three signals: sorting output, control input, and control output. The signal 

lines of the sorting function in different measurement modes are respectively defined as different 

sorting output signals and control input signals. The following are the signal definitions of the 

Handler interface when the sorting function is used. 

pin number signal name describe 

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

/BIN1 

/BIN2 

/BIN3 

/BIN4 

/BIN5 

/BIN6 

/BIN7 

/BIN8 

/BIN9 

/OUT 

Sorting result output 

 

1 1 / AUX _ List scan sorting result output 

1 2 

13 
/EXT.TRIG _ 

External trigger: 

When the trigger mode is set to EXT.TRIG 

(external trigger), the instrument is triggered by 

the rising edge pulse signal applied to this pin. 

1 4 

15 
EXT.DCV2 

External DC Voltage 2: 

The DC power supply pin for the photoelectrically 

coupled signals (/EXT_TRIG, /ALARM, /INDEX, 

/EOM, / KEY LOCK ) in the instrument. 

16 + 5V Instrument internal power supply +5V: 
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17 

18 

Generally, users are not recommended to use the 

power supply inside the instrument. If it must be 

used, please ensure that the current used is less 

than 0.3A, and the signal line should be kept away 

from the interference source. 

1 9 

2 0 

2 1 

2 2 

twenty 

three 

/P HI 

/ PLO 

/ SREJ 

/ SHI 

/ SIN 

List scan sorting result output 

2 4 / SLO 
The sorting measurement result is invalid 

(Invalid) output 

2 5 / KEYLOCK Spare input pin. 

26 NC no connection 

2 7 

28 
EXT.DCV1 

External DC Voltage 1: 

Pull-up DC power supply pin for photoelectrically 

coupled signals (/BIN-/BIN9, /AUX, /OUT, /PHI, 

/PLO, /SREJ) in the instrument. 

2 9 / ALARM When a power-down occurs, /ALARM is active. 

3 0 / INDEX 

The /INDEX signal is valid when the analog 

measurement is completed and the instrument can 

connect the next device under test (DUT) at the 

UNKNOWN test terminal. However, the 

comparison result signal is not active until /EOM 

is active. 

3 1 / EOM 

End Of Measurement : 

This signal is valid when the measurement data 

and comparison result are valid. 

3 2 

33 
C OM2 

Ground reference used by external power supply 

EXTV2 

3 4 

35 

36 

C OM1 reference used by external power supply EXTV 1 
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10.1.1.1 Signal Definition for Single Point Measurement 

Sorting signal output: / BIN1-/BIN9, / OUT, / SLO (abnormal measurement result); 

Control output signal: /INDEX (analog measurement completion signal), /EOM (measurement end 

and comparison data valid signal), /ALARM (instrument power-down signal). 

Control input signals: /EXT.TRIG (external trigger signal) and / Keylock (keylock). 

The timing diagram is shown below: 
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time minimum 

value 

maximum value 

T1 trigger pulse width 

T2 measurement start delay time 

Trigger wait time after T3 /EOM 

output 

1 us 

200 us 

0 us 

--- 

Display time + 200us 

--- 

1. Refer to the operation manual of this instrument for measurement time; 

2. The typical comparison time is about 1 ms; 

3. The typical display time of each display page is as follows: 

Component measurement display page: about 8 ms; 

Sorting display page: about 5 ms; 

Sorting count display page: about 0.5 ms 

10.1.1.2 Signal Definition for List Scan 

The function signal definition of list scan is different from the definition in point test function. Its 

definition is as follows: 

Sorting signal output: 

/ BIN1-/BIN9 , /AUX(BIN10), / OUT , /PHI( BIN11 ) , /PLO( BIN12 ), / SREJ ( BIN13 ), / SHI 

( BIN14 ), / SIN (BIN15 ) , / SLO (measurement result abnormal/out of tolerance), the sorting result 
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will be output after the entire list scan measurement is completed; 

Control output signal: 

/INDEX (analog measurement completion signal), /EOM (measurement end and comparison 

data valid signal), /ALARM (instrument power-down signal). Among them, the /INDEX signal is 

asserted when the analog measurement of the last sweep point is completed. The /EOM signal is 

asserted when all sorting results are valid after the entire list scan measurement is complete. 

Control input signal: 

/EXT .TRIG (external trigger signal) and / Keylock (keylock). 

The timing diagram is shown in the following figure: 

 
T1, T2, T3, please refer to the definition of spot measurement. 

10.1.1.3 Signal Definition for Curve Sweep 

The signal definition of curve sweep function is different from that of point measurement and list 

function. Its definition is as follows: 

Sorting signal output: 

/ BIN1-/BIN4 are the output of the current scan channel's curve 1-curve 4 sorting pass, / 

BIN5-/BIN8 are the current scan channel's curve 1-curve 4 sorting fail output. 

Control output signal: 

/INDEX (analog measurement completion signal), /EOM (measurement end and comparison 

data valid signal), /ALARM (instrument power-down signal). Among them, the /INDEX signal is 

asserted when the analog measurement of the last sweep point is completed. The /EOM signal is 

asserted when all sorting results are valid after the entire list scan measurement is complete. 

Control input signal: 

/EXT .TRIG (external trigger signal) and / Keylock (keylock). 
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The timing diagram is shown in the following figure: 

 

T1, T2, T3, please refer to the definition of spot measurement. 

10.1.2 Electrical Characteristic 

As mentioned earlier, the definition of a signal differs in different measurement modes, but the 

electrical characteristics of the signal are consistent. The following description therefore applies to 

all measurement modes. 

DC Isolated Outputs Each DC output (pins 1 to 16) is isolated via an open collector optocoupler 

output. The output voltage of each line is set by a pull-up resistor on the Handler interface board. 

Pull-up resistor and internally supplied voltage (+5 V) connection, or connect with external supply 

voltage (EXTV: +5V) via jumper. 

The electrical characteristics of the DC isolated output are divided into two types, as shown in the 

table below: 

output signal 
Output rated voltage 

Maximum current circuit reference ground 
LOW HIGH 

sorting signal 

/BIN1 - /BIN9 

/AUX 

/OUT 

/PHI 

/PLO 

≤0.5 V +5 V--+24 V 6 mA 

Internal pull-up voltage: 

measuring instrument 

 

External voltage (EXTV1): 

COM1 

control signal 

/INDEX 

/EOM 

/ALARM 

≤0.5 V +5 V--+24 V 5 mA 

Internal pull-up voltage: 

measuring instrument 

 

External Voltage (EXTV2): 

COM2 
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10.2 Handler interface board circuit 

Sorting result signal output circuit: 



 307 

 

 

 

PULL-UP 
RESISTOR 

JP2 JP1 

+5V 

JP3 

TH2851Common 

EXT.DCV1 

/OUT 

/BIN1 

/BIN8 

/AUX 

/PHI 

/PLO 

/SREJ 

/BIN9 

COM1 
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Control signal output circuit: 

 

Control signal input circuit: 

PULL-UP

RESISTOR

/EXT.TRG

/KEYLOCK

8 2 0

JP5 JP4

+5V

EXT.DCV2

 

 

 

 

 

PULL-UP 
RESISTOR 

JP5 JP4 

+5V 

EXT.DCV2 

/ALARM 

/INDEX 

/EOM 

COM2 

JP6 

TH2851 Common 
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Chapter 11 Technical indicators 

11.1 Definition 

Technical indicators: 

Guaranteed performance. All specifications are at 23°C (±5°C) unless otherwise noted and it is valid 

within the temperature range and the instrument has been warmed up for 90 minutes. 

Specifications include guard bands, which take into account expected statistical performance 

distributions, measurement uncertainty, and performance variations due to environmental 

conditions. 

Typical value: 

Expected performance of typical devices, excluding guard bands. Typical values are not covered by 

the product warranty. 

General Features: 

A generic descriptive term that does not indicate a level of performance. 

11.2 Basic Measurement Feature 

Measurement parameters: 

Impedance 

parameter 

|Z| , θz , |Y| , θy , Cp , Cs , Lp , Ls , Rp , Rs , D , Q , 

R , X , G , B , DCR 

Level 

monitoring 

Vac , Iac , Vdc , Idc 

 

Measurement terminal: 

Configure Four-terminal pair configuration 

Connector type Four BNC (female) connectors 

11.3 Signal source characteristics 

Frequency: 

scope 10 Hz to 130 MHz ( Model TH2851-130 ) 

10 Hz to 80 MHz ( Model TH2851-80 ) 

10 Hz to 50 MHz ( Model TH2851-50 ) 

10 Hz to 30 MHz ( Model TH2851-30 ) 

10 Hz to 15 MHz ( Model TH2851-15 ) 

Resolution 1 mHz 
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Relative error ±0.0007 % (at 5 to 40°C temperature range, typical) 

 

Voltage signal level: 

scope 5 mVrms to 1 Vrms ( output resistance 25Ω) 

5 mVrms to 2 Vrms ( output internal resistance 100Ω and test 

frequency≤1MHz ) 

Resolution 1 mV 

precision At the test port of TH2851 

± [(10 + 0.05 × f)% + 1 mV] (typ., output resistance 25Ω) 

± [(10 + 0.5 × f)% + 1 mV] (typ., output resistance 100 Ω) 

 

Note: 

1. f: frequency [MHz]. The above characteristics apply when all ports are open. 

2. When the DUT impedance is ≤ 50 Ω , the test signal level should be ≤ 0.5 Vrms 

3. When the temperature exceeds 23 ± 5 °C, the test signal level setting accuracy is one-half 

of the described value. 

 

Current signal level: 

scope 50 μArms to 20 mArms 

Resolution 10 μA 

precision ±[(10 + 0.3 × f)% + 50 μA ] (typ., output resistance 25Ω) 

±[(10 + 0.5 × f)% + 50 μA ] (typ., output resistance 100 Ω) 

 

Note: 

1. f: frequency [MHz]. The above characteristics apply when all ports are open. 

2. When the impedance of the DUT is less than or equal to 50 Ω , the test signal level should 

be less than or equal to 0.5 Vrms . 

3. When the temperature exceeds 23 ± 5 °C, the test signal current setting accuracy is 

one-half of the described value. 

 

Signal level detection: 

voltage range 5 mVrms to 2 Vrms 

Level detection 

accuracy 

±(10 + 0.05 × f + 100/ Zx )[%] (typ.) 

Current range 200 μArms to 20 mArms 

Current 

detection 

accuracy 

±(10 + 0.05 × f + 100/ Zx )[%] (typ.) 
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Note: 

1． f: Frequency [MHz], Zx : Impedance test value [ Ω ] 

2． When the temperature exceeds 23 ± 5 °C, the test signal current setting accuracy is 

one-half of the described value. 

 

Output Impedance: 

output 

impedance 

25 Ω/100 Ω (typ.) 

 

DC bias function: 

DC Voltage Bias Range 

scope 0 to ±40 V (see Figure 1) 

Resolution 1 mV 

precision ± [0.1% + (5 + 30 × | Imon |) mV] 

± [0.2% + (10 + 30 × | Imon |) mV] ( temperature over 23 ± 5°C) 

DC current bias 

DC Current Bias Range 0 to ±100 mA (see Figure 1) 

DC Current Bias 

Resolution 

40 μA 

DC Current Bias 

Accuracy 

± [2% + (0.2 + | Vmon |/20) mA] 

± [4% + (0.4 + | Vmon |/20) mA] ( temperature over 23 ± 5°C) 

DC voltage bias 

Detection accuracy 

± [0.2% + (5 + 0.3 × | Imon |)mV] 

± [0.4% + (10 + 0.3 × | Imon |)mV] ( temperature over 23 ± 5°C) 

DC current bias 

Detection accuracy 

± [1% + (0.5 + | Vmon |/10000)mA] 

± [2% + (1.0 + | Vmon |/5000)mA] ( temperature over 23 ± 5°C) 

output impedance 25 Ω/100 Ω (nominal) 

 

Note: 

Vmon: DC voltage offset monitor reading value [mV] 

Imon: DC current offset monitor reading value [m A ] 

DC Bias Voltage/Current Range: 
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11.4 Scan feature 

Scannable 

parameters 

Frequency, Signal Voltage, Signal Current, DC Bias Voltage, DC 

Bias Current 

scan type Linear frequency, logarithmic frequency, OSC level (voltage, 

current), DC offset (voltage, current), logarithmic DC bias (voltage, 

current) 

Scan direction Up-value scan, down-value scan 

Measurement 

points 

2 to 1601 points 

segmented scan 

Used to measure 

waveform points 

per segment, 

Available setup 

parameters for 

the signal 

Sweep frequency range, level level (voltage, current), DC offset 

(voltage, current), measurement time, point average coefficient, 

Segment time, segment delay 

number of 

segments 

1 to 201 

Sweep Type Sequential scan or frequency scan 

delay time 

type Spot delay, sweep delay, segment delay or DC offset delay 

scope 0 to 30 seconds 

Resolution 1 ms 

11.5 Trigger function 

trigger type Continuous trigger, single trigger, average trigger 

trigger source Internal (Auto Trigger, External (Handler Connector 

Input), GPIB/USB/LAN , Manual (Front Panel Keys) 

trigger event 

type 

Point trigger, sweep trigger 

11.6 Measurement time/average 

Measurement 

time range 

0 (fast) to 5 (precise) , 6 steps 

average type point average, sweep moving average 

Average 

coefficient 

1 to 999 (integer value) 

Measure time: 
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Note: 

1. Additional time is required for each test when switching test ranges or when paranoid 

voltage/current is turned on: 7 × test frequency period + 5 ms 

2. When automatic level control is turned on, additional test time needs to be added, and the 

added time varies according to the set conditions. 

Test speed 0 can shorten the test time of test speed 1 by about 2ms, and the fastest test time is less 

than 2.5ms each time. The specific shortened test time varies according to the frequency and range 

settings. 

11.7 Measurement accuracy 

|Z| , |Y| precision ± E [%] 

theta accuracy ± E/100 [rad] 

L , C , X , B precision 

When Dx ≤ 0.1 ± E [%] 

When Dx > 0.1 
   2

X
E 1 D [%]

 

R precision 

When Dx ≤ 0.1 ( Qx ≥ 10) 


m

X
D E /10

E
Rp :

0
[%]

 


X

Rs : E /D [%]
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When 0.1 < Dx < 10 

(0.1 < Qx < 10) 









m
X

2

X

2

X

Rp : E [%]
E

D
10

1 D
0

1 D

 


 

X

2

X
1 D

Rs : E [%]
D

 

When Dx ≥ 10 ( Qx ≤ 0.1) ± E [%] 

D precision 

When Dx ≤ 0.1 ±E/100 

When 0.1 < Dx ≤ 1 
 XE 1 D /100  

 

Q precision (when Qx × Da < 1) 

When Qx ≤ 10 (Dx ≥ 0.1)  
 

2

X X

X X

Q E 1 D /100

1 Q E 1 D /100

 


 m
 

When Qx > 10 (Dx < 0.1) 



m

2

X

X

Q E /100

1 Q E /100
 

G precision  

When Dx > 0.1 


 

2

X

X

1 D
E [%]

D
 

When Dx ≤ 0.1 ± E/Dx [%] 

Note 

Dx: Measured value of D. 

Qx : Measured value of Q. 

Da : Measurement accuracy of D. 

In an AC magnetic field, the following equations can be used to calculate the measurement 

accuracy. 

E × (1 + B × (5 + 500/ V mv )) [%] (typ.)  

B : Magnetic induction [ Gauss ] 

 

Impedance measurement accuracy of four-terminal-to-port 

Impedance measurement accuracy of four-terminal pair port [%] (typ.) : 

 
     

 
 

'

' 's

p 0 x

x

Z
E E Y Z 100

Z
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in: 

E p 
' 
= E pl + E pbw + E posc + E p [%] 

Y o 
' 
= Y ol + K bw × Ky osc × ( Y odc + Y o ) [S] 

Z s 
' 
= Z sl + K bw × Kz osc × Z s [Ω] 

E pl [%] Cable length correction factor: 

0 m: 0 

1 meter: 0.02 + 2 × f m /100 

2 meters: 0.02 + 3 × f m /100 

E pbw [%] Measurement time 5:0 

Measurement time 4: 0.06 (when frequency < 50 kHz), 0.03 (when 

frequency ≥ 50 kHz) 

Measurement time 3: 0.2 (when frequency < 50 kHz), 0.1 (when 

frequency ≥ 50 kHz) 

Measurement time 2: 0.4 (when frequency < 50 kHz), 0.2 (when 

frequency ≥ 50 kHz) 

Measurement time 1: 0.8 (when frequency < 50 kHz), 0.4 (when 

frequency ≥ 50 kHz) 

E posc [%] V osc > 500 mV: 0.018 × (1000/ V mv - 1) + f m /100 

200 mV < V osc ≤ 500 mV: 0.018 × (500/ V mv - 1) 

100 mV < V osc ≤ 200 mV: 0.018 × (200/ V mv - 1) 

V osc ≤ 100 mV: (100/ V mv - 1) × (0.018 + E pbw ) 

E p [%] 20 Hz ≤ f m < 100 Hz: 0.5 

100 Hz ≤ f m ≤ 800 Hz: 0.3 

800 Hz < f m ≤ 1 MHz: 0.075 

1 MHz < f m ≤ 15 MHz: 0.1 × f m 

15 MHz < f m ≤ 120 MHz: 1.5 

Y ol [S] 0 meters : 0 

1 meter : 500n × f m /100 

2 meters : 1μ × f m /100 

K bw Measurement time 5:1 

Measurement time 4:1 

Measurement time 3: 3 (when frequency ≤ 1 MHz), 4 (when frequency > 1 

MHz) 

Measurement time 2: 4 (when frequency ≤ 1 MHz), 5 (when frequency > 1 

MHz) 

Measurement time 1: 6 (when frequency ≤ 1 MHz), 10 (when frequency > 

1 MHz) 

Ky osc V osc > 500 mV: 1000/ V mv  

V osc ≤ 500 mV: 500/ V mv 

Y odc [S] 0 mA ≤ DC current < 1 mA: 0 

1 mA ≤ DC current < 10 mA: 1 μ 

10 mA ≤ DC current Hour: 10 μ 
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Y o [S] 20 Hz ≤ f m < 100 Hz: 10 n 

100 Hz ≤ f m ≤ 200 kHz: 2.5 n 

200 kHz < f m ≤ 500 k Hz: 5 n 

500 kHz < f m ≤ 1 M Hz: 10 n 

1 MHz < f m ≤ 15 MHz: 100 n 

15 MHz < f m ≤ 120 MHz: 500 n 

Z sl [Ω] 0 meters: 0 

1m, 2m: 

20 Hz ≤ f m < 500 Hz: 5 m  

500 Hz ≤ f m ≤ 120 MHz: 2 m 

Kz osc V osc > 500 mV: 2 

200 mV < V osc ≤ 500 mV: 1 

100 mV < V osc ≤ 200 mV: 200/ V mv  

V osc ≤ 100 mV: 100/ V mv 

Z s [Ω] 20 Hz ≤ f m < 100 Hz: 10 m 

100 Hz ≤ f m ≤ 120 MHz: 2.5 m 

Note 

f m : measurement frequency [MHz] 

V osc : test level 

V mv : V osc [mV] 

 



 317 

 

Note: 

Typical value of impedance measurement accuracy of four ports on the front panel of TH2851 

(test signal level 0.5 Vrms, measurement time is 5) 

Other areas that do not indicate the test accuracy are not used as accuracy indicators. 

 

 

 


